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Introduction

1.1 Overview

This report presents the findings of an evaluation of the impacts of San Diego Gas & Electric
Company’s 1995 Nonresidential New Construction Program. The evaluation was conducted
by ateam consisting of three firms. Regional Economic Research, Inc. (RER), VIEWtech,
Inc. (VIEWtech), and CIC Research, Inc. (CIC). The study was designed to comply closely
with the provisions of the California Public Utilities Commission’s Protocols and Procedures
for the Verification of Costs, Benefits, and Shareholder Earnings from Demand-Sde
Management Programs (the CPUC M&E Protocols).

San Diego Gas & Electric Company (SDG&E) initially filed for first year earnings based on
estimated gross program savings of roughly 39.7 GWh. The CPUC Division of Ratepayer
Advocates (DRA) took issue with SDG& E’'s means of estimating savings, and recommended
that this level of savings should be reduced for the purposes of the ex ante payment. SDG&E
ultimately agreed with DRA (now ORA) that estimated ex ante savings would be reduced by
20.8% as a means of accommodating the perceived overestimation of savings. Thus, the
gross savings estimate was reduced to 31.4 GWh for this purpose. The results of the study
suggest that the program generated net savings fairly close to the estimate actually used of
thisfirst year earnings claim.

The remainder of this section provides a brief description of the 1995 Nonresidential New
Construction Program, identifies evaluation objectives, presents an overview of the
evaluation methodology, and previews the rest of the report.

1.2 Description of Program
Overview

Since 1995, the Nonresidential New Construction Program has been marketed as the Savings
Through Design Program. The program offers incentives to builders to promote the
enhancement of energy efficiency in new construction. In 1995, the program offered both
prescriptive and performance options. Under the performance option, incentives were
provided to builders who exceeded Title 24 standards by at least 10% in at least one end use,
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while satisfying Title 24 for other end uses. With the prescriptive option, incentives were
paid for the adoption of specific measures, but the requirement of 10% improvement over
Title 24 was nonetheless maintained. These options are discussed below.

Savings Through Design Performance Option

The 1995 performance option offered cash incentives to builders willing to revise their
building plans to exceed Title 24 standards and achieve energy savings of 10% or greater in
one or more of the following categories: cooling, heating, lighting, fans/motors, pumps, and
hot water. Only one project was actually funded under this option in 1995. It involved a
project built in 1995, although the Title 24 design review had been completed for the project
in 1993. Because it was used mostly when buildings were energy deficient, the performance
option was phased out in 1995.

Savings Through Design Prescriptive Option

The Savings Through Design Program’ s Prescriptive Option is designed to encourage the
incorporation of energy-efficient technologies into the design of commercial buildings by
providing assistance with the review of building plans, offering cash incentives for standard
and custom measures, and educating target audiences through a variety of communications
tactics. The Savings Through Design Program’ s Prescriptive Option encourages the
installation of new construction projects which exceed building energy-efficiency standards,
including California’s Title 24 Standards.

SDG& E continued to improve its communication with the architectural, engineering, and
development communities through Title 24 seminars, the “ Progress Through Design”
newsletter, case studies, testimonials, and personal contacts. The new construction field
office continued to serve the design and construction community. SDG& E also sponsored
two seminars for the architectural and engineering communities. Program presentations were
also made to such organizations as the American Society of Heating, Refrigeration, and Air
Conditioning Engineers (ASHRAE), the American Institute of Architects (AlA), the
[llumination Engineering Society (IES), and the Building Owners Management Association
(BOMA).

The prescriptive lighting efficiency option and the options for mechanical, glazing, and
custom measures (reported separately in previous years) were combined in 1995. A total of
332 contracts were completed under the prescriptive option of the Savings Through Design
Program in 1995.
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1.3 Evaluation Objectives

The fundamental purpose of the project was to estimate the impacts of the 1995 Savings
Through Design Program. The evaluation had three specific objectives, including:

m  Assembly of acomprehensive database relating to the behavior of participants and
nonparticipants.

m  Development of first year gross realized energy and demand impacts of the
measures installed under the program.

m  Estimation of first year net energy and demand impacts. These impacts were
designed primarily to take into account free ridership and participant free
drivership, athough an attempt was also made to assess nonparticipant free
drivership.

1.4 Overview of Methodology

The overall methodology will be designed to comply with both the principles of good
evaluation and the dictates of the CPUC M& E Protocols. The methodology consisted of four
primary elements.

s On-Site Survey. Anon-site survey was conducted in order to collect
information on participants and nonparticipants. The survey was used to collect
detailed information on equipment stocks, building characteristics, operating
schedules, occupancy rates, Title 24 compliance, and stocks of demand-side
management (DSM) measures. The survey design involved an attempted census of
all participating sites and a roughly matching sample of nonparticipant sites. The
total completed sample included 253 participants and 159 nonparticipants.

m Decision-Maker Survey. A decision-maker survey was conducted to support
the analysis of the net influence of the program on DSM behavior. The survey was
completed for alarge subsample of participant and nonparticipant sites.

m  Estimation of Gross Impacts. Grossimpacts can be interpreted as the effects
of DSM measures on participants’ energy usage, without regard to the attribution
of these impacts to participation in the program. The gross impacts of the program
were estimated using a hybrid statistical/engineering approach. This approach
entails the use of DOE-2 building simulations to develop preliminary estimates of
measure impacts, and the use of aload impact regression model to statistically
reconcile these simulation estimates with billing information.

m  Estimation of Net Impacts. Net program impacts are those that are
attributable to the program. They are typically derived through the adjustment of
gross savings to account for free ridership, free drivership, and (in some studies)
market transformation. The ratio of net impacts to gross impacts is sometimes
characterized as a net-to-gross ratio. Net-to-gross ratios were estimated for each
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end use through three approaches: (1) the use of self-reported estimates gleaned
from the decision-maker survey; (2) the use of the difference of differences
approach; and (3) the development and application of an efficiency model designed
to discern the net influence of the program on adoptions of energy-efficiency
measures. The net-to-gross ratios ultimately chosen for the determination of net
savings were those based on the simple difference of differences approach. It
should be noted that it yields lower net savings than the model-based approach.

1.5 Summary of Results

The results of the study are summarized in Table 1-1 and illustrated in Figure 1-1. As
indicated, SDG& E’ s tracking system recorded an estimated 39.7 GWh and 7.4 MW of gross
program savings. These savings were the basisfor SDG& E’ s initial first year earnings claim,
as explained above, but were not ultimately used for the purposes of earnings payment. The
engineering estimates developed as part of this study amounted to 46.6 GWh and 8.3 MW. It
should be recognized, however, that these estimates covered both incentivized and non-
incentivized measures, and are not directly comparable to SDG& E’ s program estimates. The
realization rate analysis conducted as part of the study reconciled the engineering calculations
against actual billing records. As depicted in Figure 1-1, this analysis had little impact on the
estimates, suggesting that the overall realization rate on gross savings was very close to 1.0.
The net-to-gross analysis indicated the presence of a substantial free-rider effect. After being
adjusted for this effect, net savings from the program amounted to 28.2 GWh and just under
5.0 MW.

Table 1-1: Summary of Program Savings Estimates

Realized | Net-to-
Engineering | Realization | Gross Gross Net

Impact M easure Estimate Rate Savings | Ratio | Savings
Total Program Savings

Energy (GWh) 46.570 1.024 47.686 0.591 | 28.200

Demand (MW) 8.315 1.019 8.469 0.588 4.977
Savings per Square Foot

Energy (kWh) 3.761 1.024 3.851 0.591 2.277

Demand (W) 0.672 1.019 0.684 0.588 0.402
Savings per Building

Energy (kWh) 163,405 1.024 167,321 | 0.591 | 98,948

Demand (kW) 29.177 1.019 29.716 0.588 | 17.459
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Figure 1-1. Overview of Estimate Program Savings

Net-To-Gross
Ratios

Engineering
Analysis

Redlization
_‘ Rates

SDG&E T Realized Gross Net Redlized
Tracking System Engineering Estimate Savings Savings
Savings of Gross Savings 47.7 GWh 28.2GWh
39.7GWh 46.6 GWh 85 MW 5.0 MW
7.4 MW 8.3 MW

1.6 Preview of Remainder of Report
The remainder of thisreport is organized as follows:
= Section 2 discusses the development of the sample design underlying the collection
of data on participants and nonparticipants,
m  Section 3 describes the design and administration of the on-site survey,

= Section 4 discusses the use of building simulations and other engineering
algorithms to develop engineering estimates of savings for program and non-
program measures installed by participants and nonparticipants,

=  Section 5 explains the use of arealization rate approach to estimate the gross
realized savings associated with program and non-program measures,

m  Section 6 discusses the estimation of net program impacts, and

m A seriesof appendices contain technical details on several aspects of the analysis.
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2

Sample Design and Selection

2.1 Overview of Sample Design

The sampling strategy used for this evaluation was straightforward. It entailed the following
elements:

m First, SDG&E chose to sponsor an attempted census of all 1995 program
participants. The CPUC M&E Protocols require such a census when a program
has fewer than 350 participants in the program year in question. Aswill be
explained below, there were 285 distinct participating sites in the 1995 program.

= Second, aroughly matching sample of nonparticipants was chosen to act asa
control group in the analysis of gross and net program impacts.

Additionally, an attempt to conduct a decision-maker survey was to be made for each of the
sites agreeing to participate in the on-site survey. The implementation of this design was
complicated somewhat by practical difficultiesin defining participant and nonparticipant
sites and matching nonparticipant samples with participant sasmples. The means of resolving
these difficulties are discussed below.

2.2 On-Site Survey Design
Participant Sample Design

Definition of Participant Sites. Information on participants was provided by SDG&E at
the beginning of the project. The following types of identifying data were made available:

m Program Contracts. A listing of program contracts was provided by SDG&E.
Individual contracts were a'so made available in hard-copy form with supporting
documentation.

» Premise Numbers. Each contract specified one or more premise numbers. In
some cases, a single contract covered a single customer premise; in other cases, a
contract may have encompassed several distinct premises; in yet other instances,
multiple contracts applied to a single premise.
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s Account Information. SDG&E aso provided apreliminary list of accounts and
meter numbers associated with each premise. Billing records for these accounts
were also merged into the participant database.

Based on thisinformation, RER proceeded to define a set of unique sites for the purposes of
the analysis. These sites were defined as the units at which the building simulation and
statistical analyses were to be applied. These sites varied considerably in their general
description, being various portions of buildings, entire buildings, or sets of buildings,
depending on the specific circumstances. The following general rules of thumb were used to
develop their definitions:

» If asingle building was treated through the program (which would typically be the
caseif the participating site was truly new construction), and if the building was
separately metered, then the building was defined as the relevant site. The entire
building was surveyed and all of the electricity accounts associated with the
building were used in the billing analysis.

= If asingle building was treated, but was on a meter covering more than one
building, the full multiple-building area covered by the relevant meter was defined
astherelevant site aslong as it was not more than five times as large as the treated
building. If the metered area was more than five times as large as the treated
building (which happened in only afew cases), only the treated building was
surveyed. In thislatter event, the site was covered by the building simulation
analysis, but was left out of the billing analysis because of the lack of appropriate
billing data.

= If only aportion of the building was covered by the program (which could be the
case for an addition, amajor remodel, or tenant improvements), that portion of the
building was used as the relevant siteif it was separately metered or submetered.
Thiswas generally the case, insofar as tenant improvements and remodel s tended
to cover separately metered suites within buildings. If the relevant meter covered
more than the space covered by the program, the larger metered area was defined
asthe appropriate site as long as it was not too much larger than the covered area.
In the case of single-tenant buildings, the metered area was used if it was less than
five times the size of the covered area. In the case of multi-tenant buildings, the
metered areawas used as long as it was less than twice the size of the covered area.
Note, of course, that multi-tenant buildings are ailmost always metered separately
for individual tenants, so this criterion was almost always met for such buildings.

= If multiple buildings were covered by the program at a single premise, each
building was considered a distinct site unless it was served by a central HVAC
facility that also served other buildings at the premise. When central multi-
building HVAC systems were encountered, all buildings served by the HVAC
facility wereincluded in the site unless their total square footage exceeded five
times the area of the covered building. Inthislatter case, the treated building was
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defined as the relevant site and the building was surveyed and covered by the
building simulations but excluded from the billing analysis.

Participant Sample Frame. After applying these rules of thumb, alist of 285 distinct
participant sites was defined. The distribution of these sites across building categoriesis
presented in Table 2-1. Some sites were intentionally deleted from thislist for the purposes
of the survey. Military sites were excluded from the frame because of the difficulty of
obtaining the appropriate clearances to survey these sites. A few other sites were disqualified
because of the known unwillingness of site owners to permit additional on-site inspections.
Thisleft aninitial sample of 279 distinct sites that were candidates for the census.

Table 2-1: Development of Participant Sample (number of sites)

Participant Participant Completed
Building Category | Population | % Dist Frame | % Dist| Sample | % Dist
Assembly Plant 32 11.2 31 11.1 20 7.9
Churches/Meeting 7 24 7 25 7 2.8
College/University 17 6.0 17 6.1 17 6.7
Convenience Store 3 11 3 11 3 12
Grocery 18 6.3 18 6.5 18 7.1
Hospital 5 1.8 5 1.8 5 2.0
Lodging 4 14 4 14 3 1.2
Offices 59 20.7 58 20.8 51 20.1
Restaurant 26 9.1 26 9.3 26 10.3
Retail 37 13.0 37 13.3 37 14.6
School 38 13.3 38 13.6 38 15.0
Warehouse 6 2.1 6 2.1 4 16
Misc./Other Comm. 29 10.2 26 9.3 21 8.3
Other Process 4 14 3 11 3 1.2
All Bldg Categories 285 100.0 279 100.0 253 100.0

Survey Response. Participants were recruited for both the on-site survey and the
decision-maker survey by CIC Research, Inc. Asshown, the recruiting process was
extremely successful. Moreover, the participant response rate was uniformly high across
building categories. Of the 279 participant sitesin the frame, 253 were ultimately subjected
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to an on-site survey. Contacts at the remaining 26 sites declined the opportunity to allow
surveyorsto enter their sites. The response rate for participants was just under 91%.

Nonparticipant Sample Design

Nonparticipant Frame. A population frame of nonparticipant sites was developed using
building permit records for 1994 and 1995 for construction completed in 1995. These
records contained information on site name and address, an estimate of square footage, and a
four-digit SIC number. SDG& E reviewed the frame data and allocated individual permitsto
specific premises using addresses. SDG& E then used these premise identifiers to merge
billing records into the nonparticipant frame database. For lack of more information on the
circumstances surrounding the permitted construction activities, the resultant premises were
defined as sites for the nonparticipant sample design—485 sites were so identified.

Nonparticipant Sample Design. The next step was to develop a nonparticipant sample
design and alisting of sampled sites. The general principle underlying this element of the
sample design was that the initial nonparticipant sample should match the initial participant
sample (which, given the participant census, was also the entire participant population)
reasonably closely. Early in this phase of the analysis, it was decided that this matching
should be on the basis of building category. While an attempt to match consumption could
also have been made, this possibility was dismissed because of the systematic difference
expected to be found between participant and nonparticipant populations. Moreover,
matching square footage as well as building type would have been difficult to implement,
given the small nonparticipant population.

Table 2-2 summarizes the distributions of participants and nonparticipants across building
categories. Asshown, these distributions are fairly different. Thisisnot surprising, given
that some types of building categories (e.g., hospitals and universities) are generaly more
likely to participate in energy-efficiency programs than other categories. Nonetheless, it
forces one to make some compromises in the course of attempting to develop matching
samples of participants and nonparticipants. Table 2-2 also indicates the total number of
completions for the nonparticipant on-site survey. The overall nonparticipant response rate
for the on-site was just over 63%, and the response rates for individual building categories
ranged from zero to 100%. The overall completion rate was considerably lower than for
participants, but the reasons for this are considered below.
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Table 2-2: Development of Nonparticipant Sample (number of sites)

Non- Nonpart. | Completed
Participant participant| Target Nonpart.
Building Category| Frame | % Dist | Population| Sample Sample | % Dist
Assembly Plant 31 111 36 30 7 4.4
Churches/Meeting 7 2.5 17 9 12 7.6
College/University 17 6.1 5 5 1 0.6
Convenience Store 3 11 12 4 8 51
Grocery 18 6.5 3 3 1.9
Hospital 5 18 3 1 0.6
Lodging 4 14 9 5 3.2
Offices 58 20.8 130 65 24 15.2
Restaurant 26 9.3 53 33 32 20.3
Retail 37 13.3 57 46 20 12.6
School 38 13.6 8 7 2 13
Warehouse 6 2.1 26 8 10 6.3
Misc./Other Comm. 26 9.3 96 28 23 14.6
Other Process 3 11 13 0 1 0.6
Unclassified 0 0.0 59 0 9 5.7
All Categories 279 100.0 527 250 158 100.0

Nonparticipant Survey Response. The response rate for nonparticipants was partly due
to the large number of sites that were disqualified for one reason or another from the survey.
Table 2-3 provides a summary of the disposition of these sites. As shown, preliminary
screening revealed that many sites were duplicates (more than one building permit had been
pulled for the site). Another 203 were not qualified, in the sense that they had not done a
major remodel, tenant improvement, or new construction at the site. Thisleft only 209
qualified distinct sites, 158 of which agreed to the survey. The response rate for qualified
sites was 76%.

Sample Design and Selection 2-5



DG& E 1995 Nonresidential New Construction Program

Table 2-3: Nonparticipant On-Site Survey Disposition Summary

Disposition Number of Sites

Nonparticipant Sample Frame 527
Duplicate Site 115
Not Qualified for Survey 203

Total Qualified Sites 209
Refused to Participate in Survey 51

Total On-Site Survey Completions 158

2.3 Decision-Maker Survey

Participants and nonparticipants were recruited for the decision-maker survey only if they
agreed to the on-site survey. In some cases, a single decision-maker represented more than
one distinct site. Asshown in Table 2-4, 232 decision-maker surveys were completed,
representing 328 sites. In terms of sites, decision-maker surveys were completed for over
84% of the participants and 73% of the nonparticipants receiving an on-site survey.

Table 2-4: Summary of Decision-Maker Survey Coverage

Decision-
Decision-Maker Survey On-Site Survey MCaker ﬁ;_rvey
Completions Completions ompletion
Rate

Category (Individuals) (Sites) (Sites) (Sites)
Participants 122 213 253 .84
Nonparticipants 110 115 158 73
All Sites 232 328 411 .80
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Data Collection

3.1 Overview

Three types of data were collected to support the analysis: on-site data on a sample of
participants and nonparticipants; decision-maker datafor the key decision makers associated
with these sites; and auxiliary data like billing histories, weather data, and information on
participation in other SDG& E programs. The next three subsections discuss the collection of
these elements of the overall project database.

3.2 On-Site Survey

Introduction

On-site visits were made in order to verify installation of program measures, identify other
measures installed at the sites, and collect information on site features and operating
schedules to be used in the building simulation and econometric analyses. The quality and
comprehensiveness of the on-site survey was considered critical to the success of this
evaluation.

Development of On-Site Survey Instrument

The survey instrument used in the on-site survey had to accommodate the rather stringent
regquirements of DOE-2. The survey instrument used for the on-site survey isincluded in
Appendix A. An earlier version of thisinstrument had been developed by RER in the course
of other nonresidential on-site data collection efforts, many of which were designed to
support Doe-2 simulations. However, the form was modified to make it more useful in this
specific application.

Recruitment of Customers for the Survey

Asafirst step in recruitment, aletter from an SDG& E representative was sent to customers
in the primary sample. These |etters were staged to precede telephone contact by one to two
weeks. The second step involved atelephone call to the customer location. Thiswas
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performed by CIC Research. CIC used a centralized approach for recruiting customers. The
centralized approach offered the following advantages:

m Careful and Consistent Treatment of Customers. The centralized
approach was carried out by two or three people. Theseindividuals are trained in
recruitment techniques and have previous experience performing thistask. The
use of asmall number of centralized recruiters ensured that customers were
contacted in a consistent manner.

m  Weekly Scheduling Updates. With acentralized approach, al the scheduling
information was maintained in one place. At the end of each week, al information
was compiled and transmitted to the SDG& E project manager. The SDG&E
project manager, in turn, disseminated scheduling information for the assigned
accounts to the account executives and to other appropriate individuals at SDG&E.

CIC personnel executed the following recruitment procedure:

m  Make contact with the customer and verify or identify the appropriate person for
discussing participation in the study. Explain the purpose of the project.

m  Solicit participation in the on-site survey. Indicate the amount of time needed
during the visit from the contact person or from other individuals knowledgeable
about the facility and business operations.

m  Arrange amutually acceptable time for data collection. In arranging the visit, care
wa taken not to schedule the visit during important activities at the facility.

m  Request that selected information be made available for the surveyor to review.
This information included copies of bills and blueprints and facility listings, if

appropriate.

As the scheduling team established appointments, the master schedule and recruitment
database were updated and reviewed by the VIEWtech project manager. The updated
schedule and database were also provided to the RER field work manager, the SDG& E
project manager, and the surveyors. In cases where it was not possible to schedule the
survey, the reasons for refusal were included in the recruitment database. Once an
appointment was made, a postcard was sent to the site contact confirming the date for the
visit.

Training of On-Site Surveyors

A two-day training workshop was conducted for all engineers assigned to the project prior to
the commencement of the field work. The training workshop was conducted using training
manuals and materials developed specificaly for this project. Theinstructors were the
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VIEWtech field supervisor and the RER field work manager. The training session addressed
the following issues:

Overal project purpose and scope.
Roles and relationships of project parties (SDG& E, RER, and VIEWtech).

The details that are to be recorded to describe mechanical systems and equipment
for HYAC and non-HVAC end uses.

The physical characteristics of the site, including construction materials, building
geometry, and other characteristics relevant to estimating HVAC loads.

The appropriate techniques for recording the technical information.

Key elements in business operations including operating hours, system control
settings, and estimated equipment usage levels and usage profiles.

The appropriate interview techniques for eliciting information about business
characteristics and operations.

An explanation of the codes used on the survey form.

The definition of the survey site as the entire customer premise at the service
address and examples of how to configure forms for specific situations.

Quality control procedures that must be exercised by the surveyors before the
survey is considered “complete.”

In addition, the RER field work manager explained how the data el ements are used in the
anaysis. Thisunderstanding was critical to ensure that all data fields on the survey form are
treated with equal care. Following the two-day workshop, the surveyors as a group went to
severa sitesto review the data collection procedure using live cases. The sites were chosen
to cover the full spectrum of equipment.

Preparation of Customer Information Sheets

All surveyors were provided with background information for each sample site prior to the
on-site visit. The information was provided in the form of a Site Information Sheet that
presented the following:

Site descriptions, including site names, addresses, and square footage,
Contact person information,

Monthly billing data for electric and gas accounts at the site,

A list of specific measures rebated for the site, and

Comments relating to the site.

Data Collection 3-3



DG&E 1995 Nonresidential New Construction Program

This information was provided to the surveyors for their review prior to the on-site visit. In
addition, other information (e.g., site maps) was included for complex sites. Figure 3-1 depicts
asample Site Information Sheet.

Conduct of On-Site Visits

The procedure used in on-site visits was as follows:

Upon arrival, the surveyor interviewed the site contact about general site
operations and characteristics. The interview portion roughly corresponds to the
first section of the survey form presented in Appendix A. The interview usually
took between 20 and 30 minutes.

Upon completion of the interview, the surveyor walked through the facility and
recorded equipment, building, and operating information. Depending on the
wishes of the site contact, the surveyors proceeded by themselves, or the site
contact or other representative accompanied the surveyor through the facility.

In addition to the interview and the walk through, data were obtained from other sources,
including the following:

Site Documents and Records. Structural and architectural drawings can
provide data on building dimensions and construction materials. Mechanical,
electrical, and plumbing plans can provide data about end-use equipment. Title 24
compliance documents can also offer considerable information about site design.

Energy Usage Information. When necessary, energy bills were obtained from
site contacts in order to facilitate the process of matching sites and usage.

Measurements. The surveyor used measuring devices as necessary to record
floor stock, lighting levels, and the presence of electronic ballasts.

Photographs. Finaly, surveyorstook photographs of the exterior of the survey
area and the HVAC equipment. Thisvisual information was often useful input for
the design of the building the simulations.

Data Collection
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Figure 3-1: Site Information Sheet
Not available electronically.

Data Collection
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All on-site survey data went through a two-stage quality control procedure. First, the survey
data passed through the VIEWtech process, from surveyor to field supervisor, as discussed
below. Then, these data were passed on to the RER team for further review. Quality control
ran concurrently with the data collection effort, as described below.

All incoming surveys were monitored by VIEWtech and RER staff to ensure the quality of
the responses. Inthefirst stage of quality control, VIEWtech executed the following
procedure for each site:

m  Surveyorswere required to perform avariety of “sanity checks’ before they leave
the survey site. These include the following:
- Compute overall eectric intensity, using billing information and square
footage estimates.
- Compute equipment densities, including square feet per ton of cooling
equipment and Watts per square foot of lighting equipment. Compare the sum
of the equipment densities with the maximum recorded monthly demand.

- Estimate annual energy use as the sum of the end-use components and
compare it with the utility bill information.

If the data did not pass these initial checks, the surveyor continued at the site to
clear up any obvious discrepancies.

m  The completed survey form was delivered to the VIEWtech field work supervisor.
The supervisor reviewed the form and the sanity checks performed by the surveyor.
Any missing data or apparent inconsistencies were resolved by the supervisor
manager and the surveyor.

m  During the data collection process, the VIEWtech field work supervisor
periodically rode along with field surveyors to ensure ongoing compliance with
survey procedures and to ensure survey continuity.

It was occasionally necessary to take follow-up steps to collect data that were missing or that
appeared to be inaccurate from the initial data collection effort. The follow-up (by telephone
or, when necessary, a second visit to the site) was conducted by the surveyor who did the
initial survey work, or by the VIEWtech field work supervisor, depending on the specific
circumstances of the case.

Communication. The following steps were taken to ensure that all members of the project
team (RER, VIEWtech, CIC and SDG& E) were well informed:

m All field personnel carried pagers to facilitate communication between field staff
and project management. Whenever possible, questions were handled at the time
of the on-site survey to eliminate the need for repeat visits.

3-6 Data Collection



DG& E 1995 Nonresidential New Construction Program

m  Weekly project staff briefings were held to communicate pertinent information to
field staff, and to obtain feedback and provide clarification on any issues which
may have arisen during the on-site visits.

m  During the field work, the VIEWtech field work supervisor was in daily contact
with RER’ s project manager to provide a detailed progress update and to discuss
any problemsthat may have arisen. In turn, the VIEWtech field supervisor and
RER project manager kept close contact with the SDG& E project manager, to
ensure that any questions or concerns are addressed in atimely manner.

Survey Data Entry and Database Preparation

As the incoming surveys were reviewed by the VIEWtech field work supervisor, they were
also be precoded for dataentry. All data, including comments in the margins and notes
sections of the questionnaire, were reviewed. The survey data were entered into a database
using SAs. All data, including comments in the margins and notes sections of the
guestionnaire, were entered into the database. The data entry system included data
verification procedures that identify inappropriate or incorrect responses. The raw survey
forms, the data entry system, and the resulting Sas databases were al provided to SDG&E.

A code book covering all datasets to be delivered by RER was also be prepared by CIC. The
code book contained one section per dataset and listed the variable name, variable
description, variable type, variable length, response range, and the corresponding value
labels, describing each of the valid responses for each field. Other deliverables associated
with the code book included: (a) a copy of the survey form with annotations that provide all
field names, and (b) a Sas program to create a Sas-format library including the value labels
mentioned above.

Survey Data Validation

After the survey data were entered into the database, they were transferred to RER where they
went through two stages of error checking:

m  Thefirst stage detects errors and inconsistencies in the datafor a given facility.
RER performed exhaustive premise level analysis of the data as each survey was
received from thefield. This activity included data validation checks, like flagging
motor sizes or lamp wattages that are not available in the market, identification of
space-utilization definitions that were not consistent with the site activity
description, and similar checks on literally hundreds of other items that are
potential sources of data pollution.

m  The second stage was designed to detect internal inconsistencies within the
database. Sites were grouped by type, and the datafor sites of each type were
processed through a set of statistical analysis routines.
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Preparation of Inventory Reports

As part of the error-checking and review process, a series of inventory reports was produced.
The purpose of these listings was to allow visual inspection of the raw data. These reports
provided a comprehensive summary for each case in the database and summarized the types
of equipment at each site and the corresponding connected loads. These listings are designed
to allow project analyststo “zoom in” on the data for a specific topic or the datafor a specific
case. An example of an inventory report is contained in Appendix C.

Multiple Accounts Reconciliation

The linkage of billing data with surveyed sites was an absolutely critical step in the overall
analysis of program impacts. No amount of elegant simulation and econometric analysis can
overcome poorly matched billing data. Special emphasis was placed on the accurate
identification of meters at the surveyed sites. Multiple-accounts reconciliation took place at
five points during the project.

m  First, accounts were aggregated to customer |locations in the sample-design phase.

m  Second, surveyors verified the account matching during the on-site visit. Changes
in account numbers were recorded on the survey form.

m  Third, for the sites for which the surveyors had complete billing information, they
computed energy intensities while at the site. Intensities that were out of the
“reasonable’ range were investigated with the customer contact. Potential problem
sites, or ones for which intensities could not be computed, were flagged for follow-
up by the RER analysis team.

m  Fourth, the billing information was reviewed by RER staff. Again, the intensities
were reviewed and problems were flagged for follow-up with the SDG& E project
manager.

m  Finally, when the simulations were performed, the results were compared with the
billing data. If the simulation and billing data differed substantially, and there
appeared to be no problems with the survey data, these cases were reviewed
further.

3.3 Decision-Maker Survey

The decision-maker survey was designed to collect information relating to the factors
influencing the installation of DSM measures at the subject sites. Several types of questions
were asked in the survey, which was administered by phone. For both participants and
nonparticipants, the survey solicited information relating to the following issues:
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Total recent construction activity,

Reason for constructing the site in question (owner occupancy, speculation, etc.),
Importance of energy efficiency in making construction decisions,

Methods used to evaluate energy efficiency improvements,

Approaches to complying with Title 24 (performance v. prescriptive), and
Sources of information on SDG& E’ s Savings Through Design Program.

For participants only, questions were also asked relating to the impact of the Program on
efficiency choices. These questions were structured to allow the development of self-

reported estimates of free ridership. Finally, for nonparticipants, questions were included to

ascertain possible participation at sites other than the subject site. Copies of the Decision-
Maker survey instruments are included in Appendix B. Appendix D contains a set of
frequencies for the survey.

3.4 Other Data Collection

The following other kinds of data were also collected to support the analysis:

m Billing Data. Billing datawere obtained from SDG& E for all participating and
nonparticipating sites in the sample frames. These data were screened, inspected,
and converted from billing cycle values to normalized (30.4 day) calendar month
values. Asnoted earlier, considerable effort was expended to ensure that billing
data matched the surveyed site. In cases where no such match was possible
(primarily cases where the surveyed site was covered by a single large campus-
style meter), billing data were set equal to missing.

m  Weather Data. Weather datawere collected for the period covered by the
statistical analysis (1995 and 1996), aswell asfor a Typical Meteorological Y ear
(TMY). The TMY datawere later used in the DOE-2 analysis, while both TMY
and actual 1995-6 weather data were ultimately used in the statistical analysis.

s Other Program Information. Participant lists from SDG&E’s other
nonresidential programs were collected in order to assess the possible impacts of
these programs on efficiency levels at surveyed sites. Participant lists were
provided by SDG&E for al nonresidential Energy Efficiency Incentive programs.
These lists were cross-referenced against the list of surveyed sites to identify any
potential cross-program effects, and a variable representing participation in other
programs was incorporated into the net-to-gross analysis.

Data Collection
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Building Simulation and Engineering Analysis

4.1 Introduction

This section describes the building simulation and engineering analysis used to develop
initial estimates of DSM measure savings. Building simulation analyses were conducted
using the SITEPRO software system for al members of the on-site sample, both participants
and nonparticipants. SITEPRO utilizes DOE-2 to model building HVAC loads and energy use,
and well tested engineering algorithms for estimating non-HVAC energy use. For this
project, simulations were developed under two basic scenarios:

m  Scenario A: As-Built and Operated Case. Under this scenario, al DSM
measures (both those incented through the program and those installed outside of
the program) were assumed to be in place.

m Scenario B: Reference Case. Thisscenario assumes strict compliance with
Titles 20 and 24 where applicable, and other reference conditions where an end use
isnot covered by Code. For cases where the site participated in aremodel or
tenant improvements, only those aspects of the site covered by codes were set to
these reference conditions; others were kept at their as-built values.

The difference between Scenario A and Scenario B was interpreted as an engineering
estimate of total DSM savings.

The remainder of this section provides additional detail on SITEPRO, weather data used in the
simulations, the assumptions used in the analysis of specific end uses and measures, and
simulation results.

4.2 Overview of SITEPRO

The SITEPRO software is the best energy analysis system for utility survey datathat is
available in the industry today. It utilizes the industry’s leading building simulation model
(DoE-2) to estimate HVAC loads and energy use, and it utilizes well tested algorithms for
estimating non-HVAC energy use. SITEPRO provides aframework for trand ating data about
an individual site into reliable estimates of end-use loads for that site. Thisframework is
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illustrated in Figure 4-1, which is extracted from the STEPRO User’s Guide, a copy of which
isprovided in Appendix E.

Figure 4-1: SITEPRO Analysis Framework
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Data used in SITEPRO include information on:

Customer operations, including operating schedules and number of employees, and
occupancy schedules,

End-use equipment, including equipment counts, connected |oad estimates,
equipment schedules, and hours of use, and

Building geometry and thermal shell characteristics.

SITEPRO was executed in two steps as described below.

In the first step, information about equipment inventories is combined with
operating schedule data to develop hourly load profiles by day type for the non-
HVAC end uses. Separate algorithms are applied for inside lighting, outside
lighting, water heating, cooking, refrigeration, motors, air Compressors, process
equipment, office equipment, and miscellaneous equipment loads. These
algorithms have been refined over the last five years with the help of industry
experts and with reference to end-use metered data, where available.
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m Inthe second step, HVAC loads are developed using the following information:
- Thermal shell data,
- HVAC system data,
- Heating and cooling plant data,
- Occupancy profiles, and
- Usage profilesfor lighting and other equipment.

Based on these inputs and hourly weather, SITEPRO executes DOE-2 to estimate
heat flows and energy usage on an hourly basis. The development of DOE-2 inputs
from the survey data has been reviewed by developers of DOE-2 and by severdl
experts in the area of building simulation using DOE-2.

SITEPRO performs afull hourly ssimulation (8,760 hours) for each end use. These results are
summarized in 48-day format, defined by four daytypesin each month. The simulation
results were compiled in a SAs database for use in the subsequent analysis.

It should be noted that SITEPRO has an additional feature which allows estimated loads to be
calibrated to billing data on a site-by-site basis. This feature was not used in this study.
However, avariety of reasonableness checks on the simulations were conducted. When large
discrepancies between billed consumption and simulated usage occurred, or when simulated
end use consumption seemed anomal ous, assumptions were reviewed and further error
checking was conducted. In some cases, survey information was refined through additional
sitevisits. The reason for not calibrating as-built ssmulations against billsisthat the
realization rate analysis must be conducted with uncalibrated simulation results if the
adjustment coefficients are to reflect engineering biases in estimating base usage and DSM
savings. Indeed, the realization rate analysis can be considered afinal calibration step. Itis
superior to site-by-site mechanical calibration because it can be used to differentiate between
types of engineering biases aswell asto yield insights on the sources of these biases (as
represented by the arguments of the adjustment functions).

4.3 Weather Data

Typical meteorological year (TMY') weather datafiles were used for the DOE-2 simulation
modeling. TMY data contain hourly data on various weather related variables including dry
bulb temperature, humidity, wind speed, and actual measured solar insolation. In particular,
al simulations used 1988 weather datato represent TMY as per SDG& E staff. Because
DoE-2 can not handle leap years, this data was further manipulated by deleting the data for
February 29" and using a calendar year of 1983 for the DOE-2 runs. Two weather stations,
the only ones for which the complete set of data required to run DoE-2 were available, were
used and mapped to SDG& E climate zones as follows:
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m  San Diego (Lindbergh Field). Thisweather station was used for al Maritime
climate zones.

m  NAS Miramar. Thisweather station was used for Coastal and Transition climate
Zones.

Individual sites were assigned to these stations on the basis of a ZIP code mapping provided
by SDG&E.

4.4 Specific Simulation Assumptions
Interior Lighting

As-Built Simulations. As-built ssmulations of interior lighting loads were conducted
using information on connected loads, operating hours, and lighting controls. Assumptions
on these features were determined as follows:

m  Connected Loads. Connected loads for each lighting system were devel oped
by utilizing a SITEPRO technical datatable, which is alookup table that keys off
lamp type, lamp watts, tube diameter, tube length, ballast type, and number of
lamps per fixture. Thistechnical datatable was derived from the Lighting
Handbook! developed by the CEC, previous survey datainformation, and IES
lighting handbooks. All lighting systems collected in the survey data were mapped
to thistechnical data table to determine system watts. For those systems that did
not match up to an existing system in the technical datatable, one of two actions
was taken: either the survey data were changed to map the typically errant lighting
system to onein the table; or, in rare cases, a new entry was added to the technical
data table

m  Operating Hours. Operating hours were set on the basis of lighting and
operating schedules reported in the on-site survey.

m Lighting Controls. Dimmers, occupancy sensors, and daylighting controls were
simulated by applying a usage-factor to the average weekly hours. These usage
factors were derived from numbers obtained from Lawrence Berkeley Laboratory
results/recommendations.2 The algorithm used was as follows:

- For dimmer-controlled lighting systems a 0.8 factor was applied to the average
weekly hours.

- For daylighting-controlled lighting systems a 0.65 factor was applied to the
average weekly hours.

1 Advanced Lighting Guidelines, Second Edition, California Energy Commission, March 1993

2 Technology Data Characterizing Lighting in Commercial Buildings: Application to End-Use Forecasting with
CoMMEND 4.0 (Draft), Lawrence Berkeley Laboratory Energy Analysis Program, Energy and Environment
Division, June 1993
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- For occupancy sensor-controlled lighting systems the usage factor varied by
building type asfollows. Retail/Grocery/Restaurant/Lodging = 0.6, School =
0.8, Warehouse = 0.5, all other = 0.7.

Baseline Simulations. Baselines were defined to reflect strict adherenceto Title 24
lighting densities in applicable areas and for applicable lighting systems. The process
through which this was accomplished is described below:

m Usecodeswere verified, with special attention to the designation of lighting
fixtures to display or advertising uses, which are exempt from Title 24 density
[imits.

m Densitiesfor display, advertising, and exit lighting were maintained at their as-built
levels.

m Dengitiesin non-exempt lighting systems (area and task lighting) were set equal to
their Title 24 maximum values and entered into a“Title 20 Allowed W/ft*" table.
Thistable, located in the survey database, contains default W/ft* values by Area |D
based on the Title 24 Area Category Method (ACM).3 These default values were
generated from amap of RER space usage areasto Title 24 ACM Primary Function
areas, but were redefined by the reviewer if necessary based on the description of
the site and/or space activity area.

m In some cases, the survey covered areas other than those directly affected by the
new construction, remodel, or tenant improvement in question. Lighting in these
“untreated” areas was considered exempt from the Title 20 standards, and was | eft
at itsas-built density. As-built densities were aso retained for some areas where
the “treated” status of the lighting systems was indeterminate, as indicated by a
WI/ft? value that exceeded the Title 24 prescriptive val ues.

General HVAC System Strategy

As-Built and Baseline Simulations. Several simulation issues apply to al HVAC
systems, as detailed below:

s  Predominant HVAC System Type. Inthe SITEPRO/ON-Site survey system,
HVAC systems were assigned to the “ space usage areas’ (i.e., Office, Warehouse,
Retall, etc.) they serve, rather than to the exact thermal zones they serve. Thiswas
done to make the survey more manageable. However, the result of this
simplification is that a*“predominant” HVAC system type had to be selected from
all those serving each space usage area. This was driven by the DOE-2 requirement
that only one system type can serve azone. SITEPRO logic determined the
predominant system and created a composite HVAC system to represent all

3 Energy Efficiency Standards for Residential and Nonresidential Buildings, California Energy Commission,
July, 1995.
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systems serving each space usage area. This method has been shown to yield
satisfactory HVAC simulation results in previous survey/simul ation projects.

Asaresult of this process, the As-Built/Baseline simulations for some high-
efficient equipment may not have predicted all the savings expected, especially
where the incented systems were mixed in with existing, older, less-efficient
systems. The high-efficiency values may have been diluted or lost completely
because package systems were not modeled individually. However, if the incented
systems were negligible enough to not be selected as the predominant system, then
these results are probably valid.

m  Focus on Newer Systems. Specia attention was paid to systemsinstalled in
or after 1994. That is, attention was paid to checking and obtaining proper
capacities, efficiencies, and economizer status. Systems older than this were
allowed to default to DoE-2 default values. For these newer systems, efficiency
data were checked to ensure that each new system had only one as-built and one
baseline value for efficiency.

Package HVAC Systems

Simulations of package HVAC systems utilized information on system type, cooling and
heating equipment sizes and efficiencies, outside air percentages, thermostat settings and
controls, economizers, and Title 24 minimum requirements, as described below:

m System Type. Survey dataidentifying the type of distribution system, cooling
source, and heating source for each package unit were used in the simulations.
SITEPRO is capable of modeling all major system types recognized by DoOE-2.

m  Make-Up Air Units. These units were identified in the data as Package Unit
Ventilators (PUV) with no heating source, no cooling source, and 100% outside
air.

m  Cooling and Heating Equipment Sizes. Cooling and heating capacities
taken directly from the survey data were used in the simulations. Missing
capacities were autosized by DOE-2 via SITEPRO.

m  Thermostat Settings. Thermostat settings were obtained from cooling and
heating schedules specified in the on-site survey.

As-Built Simulations. For package systems, typically only the cooling efficiency, the
heating efficiency, and the economizer status were changed from the as-built to the baseline
run. Assumptions on these features were as follows:

m  Cooling Efficiencies. The efficiencies reported on the survey were used unless
they were below code or obvioudly errant data. For systems with a cooling
capacity less than 65 kBtuh, if both an EER and a SEER were reported the one that
was the most consistent with Title 24 was used and the other one deleted from the
data. For those systems of 1994 or later vintage, if the efficiency was missing or
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less than the Title 24 minimum, correct values were obtained from one of the
following:

- SDG&E contract materials (if HVAC equipment was incented)
- CEC Appliance database
- Title 24 minimums, especially if equipment was not incented

Circa 1993 and older systems with missing efficiencies were left blank, which
SITEPRO defaults to DOE-2 default efficiencies.

Heat Pump Heating Efficiencies. Only heat pump heating efficiencies were
of concern, since their efficiencies are covered by Title 24. The COP rating at
47°F> was used for DOE-2 simulations (there are two ratings in the standard, the
other isat 17°F). Efficiencies reported on the survey were used unless they were
below code or inconsistent with the Title 24 COP at 47°F. For systemswith a
cooling capacity less than 65 kBtuh, if both an HSPF and a COP were reported the
one that was the most consistent with Title 24 was used and the other one deleted
from the data. For those systems of 1994 or later vintage, if the efficiency was
missing or less than the Title 24 minimum, correct values were obtained from one
of the following:

- SDG&E contract materials (if HVAC equipment was incented)
- CEC Appliance database
- Title 24 minimums, especially if equipment was not incented

Circa 1993 and older systems with missing efficiencies were left blank, which
SITEPRO defaults to DOE-2 default efficiencies.

Economizer Status. If the cooling capacity was greater than 75 kBtuh, an
economizer was automatically imposed to satisfy the Title 24 requirement.

Baseline Simulations. Baselines were defined to reflect strict adherenceto Title 24
minimum efficiencies by system type and economizer requirements. General baseline
assumptions were as follows:

Cooling Efficiencies. For systemsof 1994 vintage or later, the Title 24
minimum efficiencies for a given equipment type, cooling capacity, and electrical
phase were used. For systems with a cooling capacity less than 65 kBtuh, an
efficiency value corresponding to the one used for the As-Built run was used, i.e.,
if an EER (instead of a SEER) was used for the As-Built run then an EER was
used for the Baseline run aswell. Baseline efficiencies were substituted directly
into the original data table containing the package information. Circa 1993 and
older systems with missing efficiencies were left blank, and SITEPRO defaulted
them to DOE-2 default efficiencies.

4 California Energy Commission Appliance Bulletin Board Service Survey.
5 Per conversations with Steve Taylor, P.E. of Taylor Engineering, January 1997.
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s Heat Pump Heating Efficiencies. For systemsof 1994 vintage or later, the
Title 24 minimum efficiencies (COP rating at 47°F not 17°F) for agiven
equipment type, cooling capacity, and electrical phase were used. For systems
with a cooling capacity less than 65 kBtuh, an efficiency value corresponding to
the one used for the As-Built run was used, i.e., if a COP (instead of an HSPF) was
used for the As-Built run then a COP was used for the Baseline run as well.
Baseline efficiencies were substituted directly into the original datatable
containing the package information. Circa 1993 and older systems with missing
efficiencies were left blank, which SITEPRO defaults to DoOE-2 default efficiencies.

m  Economizer Status. For units with economizers and a cooling capacity less
than 75 kBtuh, the economizers were switched off, since economizers are not
required on this size unit by Title 24.

Built-up HVAC Systems

Simulations of built-up cooling systems utilized information on system type, cooling and
heating equipment sizes and efficiencies, and thermostat settings and controls, as described
below:

m  System Type. SITEPROis capable of modeling all major system types
recognized by Dog-2. Survey data identifying the type of distribution system,
cooling source, and heating source for each package unit were used in the
simulations.

m  Cooling and Heating Equipment Sizes. Cooling and heating capacities
direct from the survey data were used in the ssimulations. Missing capacities were
autosized by DoOE-2 via SITEPRO.

m  Thermostat Settings and Controls. Thermostat settings were obtained from
cooling and heating schedules specified in the on-site survey.

As-Built Simulations. For built-up systems, typically only the chiller efficiency, VAV
system measures, and ASD/V SD pump controls were changed for the As-Built to Baseline
run. Assumptions on these features were as follows:

m  Chiller Efficiencies. The efficiencies reported on the survey were used unless
they were below code or obvioudly errant data. For systems where both a kW/ton
and a COP efficiency were reported the one that was the most consistent with Title
24 was used and the other one deleted from the data. For those systems of 1994 or
later vintage, if the efficiency was missing or less than the Title 24 minimum,
correct values were obtained from one of the following:

- SDG&E contract materials (if HV AC equipment was incented)
- Title 24 minimums, especially if equipment was not incented

Circa 1993 and older systems with missing efficiencies were left blank, which
SITEPRO defaults to DOE-2 default efficiencies.
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m VAV Distribution System Measures. For participants, avariable air volume
(VAV) system consistent with SDG& E contractual materials was simulated,
including any and all fan controls noted therein. In some instances, survey data
was updated to be consistent with these materials. For the one nonparticipant that
reportedly converted from Constant Volume (CV) to VAV, we simulated aVAV
system consistent with the configuration and controls as noted on the survey form.

m  ASD/VSD Circulation Pumps. These effects were smulated in DOE-2 by
specifying the control of the circulation pumps as VSD in the survey data

Baseline Simulations. Baselines were defined to reflect strict adherenceto Title 24
minimum efficiencies. System type changes and ASD/V SD fan and pump changes were
made consistent with SDG& E contract materials. General baseline assumptions were as
follows:

m  Chiller Efficiencies. For those chillers of 1994 or |ater vintage, the Title 24
minimum efficiencies based on chiller size and type were used. Circa1993 and
older systems with missing efficiencies were left blank, which SITEPRO defaults to
DoE-2 default efficiencies.

m VAV Distribution System Measures. For participants, the baseline run was
made consistent with the SDG& E contractual materials; if aCV system was
assumed as the baseline system by SDG&E, aCV system was assumed as the
baseline here. If only VAV system controls were assumed (i.e., typically VSD fan
control), only the fan control type was changed for the baseline run. For
nonparticipants a Constant Volume (CV) system was simulated per survey data.

m  ASD/VSD Circulation Pumps. These pumps were baselined by switching the
control of the circulation pumps from VSD to single speed viathe survey datafor
the baseline run.

Building Shell

As-Built Simulations. The only building shell measures addressed were external walls
and roofsinsulated to exceed Title 24 prescriptive requirements and window tinting. The
information from the survey form used for this simulation included a noted observation of

above-code external wall or roof insulation and the associated R-values, and an observation
of window tinting and the associated tint type on the glazing. Assumptions on these features

were as follows:

m External Wall Insulation. Effects of external wall insulation were smulated
only if it was reported as a measure and R-values were indicated on the survey
form. The R-value reported in the survey form was used for the as-built run. If an
R-value was not reported then the effects of this measure were not simulated.
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m  Roof Insulation. Effectsof roof insulation were simulated only if it was
reported as a self-reported measure and R-values were indicated on the survey
form. The R-value reported in the survey form was used for the as-built run. If an
R-value was not reported then this measure was not simulated.

m  Window Tint. Effectsof window tint were ssimulated only if reported as a self-
reported measure, the building was older than 1994, and the tint wasinstalled in
1994/1995 or the window tint was incented. The assumption here was that if it
was a hew building then tint was probably required by code or at least part of the
original Title 24 calculations and hence not areal measure. A glass type of tinted
(=T) was used for the As-Built runs. If window tint was reported as a measure but
the glass type was not recorded astinted, it was changed to tinted.

The best way to determine whether or not window tint was required was to look at
the Relative Solar Heat Gain (RSHG) values allowed by the standard, then
determine from these values what the minimum allowable glazing configuration
might be.6 Since the values of this parameter for Climate Zones 6-10 and 11-13
(San Diego areas) of 0.71 and 0.57, respectively, are consistent with
tinted/reflective windows, one might assume that tinted windows were the base.
However, the RSHG can be lowered via overhangs/fins such that a clear glass
window could actually meet the standard (and there are in fact many such sitesin
the survey). Inlieu of thisfact, the approach taken seemed the most reasonable
one.

Baseline Simulations. Baselines were defined to reflect strict adherence to Title 24
prescriptive requirements for external wall and roof insulation. Assumptions on these
features were as follows:

m  External Wall Insulation. The baseline value used was either R-11 (for Zones
6-10 which covered most San Diego areas) or R-13 (for Zones 11-13, the
transition-desert regions).

m  Roof Insulation. The baseline value used was either R-11 (for Zones 6-10
which covered most San Diego areas) or R-19 (for Zones 11-13, the transition-
desert regions).

s Window Tint. For the baseline run glass type was changed to clear (=C) in the
survey data.

Remote Refrigeration

As-Built and Baseline Simulations. Remote refrigeration is not simulated by DoOE-2.
Instead, remote refrigeration load shapes’ and on-site data were used to estimate energy use.
In particular, the daily profile (hourly fraction for atypical day in each month) and daily
energy use (kWh/day/kBtuh of case load) were combined with case loads (kBtuh) based on

6 Per conversation with Steve Taylor, P.E. of Taylor Engineering, January 1997.
7 These load shapes were devel oped by Doug Scott of VaCom Technologies and based on TMY weather for
San Diego.
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the refrigerated case and walk-in inventories (lineal ft, ft%, or number of glass doors) at a site,
to yield energy use. Assumptions on these features were as follows:

Compressor, Condenser, and Associated Measures. For participant sites
where the refrigeration measures were typically well documented, as-built and
baseline runs were made consistent with the “ Refrigeration Energy Savings
Alternatives’8 reports obtained from the SDG& E contract materials. Thisisa
detailed report that analyzed the different options available to aremote
refrigeration user, as well as defining a“baseline system” to which the various
options were compared. This baseline system was typically (although not always)
an air-cooled, multiplex system without any subcooling or floating head pressure
(FHP) control. For nonparticipants, whenever remote refrigeration system
measures were identified, an air-cooled, multiplex system without any subcooling
or FHP control was assumed.

Defrost Measures. Gas defrost systems, wherever noted as a measure, were
switched to electric defrost for the baseline run.

Case Measures. The only measure included here were high-efficiency case fans
which were not simulated in SITEPRO.

Motors

As-Built and Baseline Simulations. Simulations of motors utilized information on
motor size, efficiency type, and control type. Assumptions on these features were as follows:

High-Efficiency Motors. SITEPRO utilized a motor technical datatable to
obtain efficiency as afunction of a motor’s horsepower (hp), and its efficiency type
(standard or high-€fficiency) asidentified in the survey data, and its load factor
(which was a default keyed off of the motor service type). However, these data
only applied to motors entered in the Motor s/Engines table of the survey form. For
the as-built run, the “High-Efficiency” datafield isset to “Y”, and changed to “N”
for the baseline run. For sites utilizing high-efficiency motors not entered on the
Motors/Enginestable (i.e., site RP216) the technical datatable was simply utilized
to “adjust” the effective motor hp to reflect these higher efficiencies (the only way
to do thisin SITEPRO).

ASD/VSD Motors. ASD/VSD control is simulated viathe PartLoadElasticity
field in another SITEPRO technical datatable. Thisisan exponential value (a) to
which the load factor is raised which describes the shape of the load-factor versus
kW-draw curve and it is used to determine energy use. A motor control type of
Electronic VSD (E) used for the As-Built run was switched to a control type of
On/Off Switch (S).

8 These reports were prepared by VaCom Technologies for SDG&. E to eval uate refrigeration alternatives for
specific sites.
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m  CO Sensors. Therewasonly one sitein the surveyed sample that had these
controlsinstalled and no real good way to simulate the savings from them, so no
attempt was made to determine savings.

45 Results
Simulated End-Use Intensities

Table 4-1 summarizes the results of the engineering analysis. It depicts smulated end-use
intensities, as well as estimated savings, for both participants and nonparticipants. As shown,
baseline usage is very similar for participants and nonparticipants. Savings are higher for
participants than for nonparticipants for every end use other than space heating. The reason
for thislatter result is that space heating savings include the adverse heating impacts
(penalties) of lighting savings. Insofar aslighting savings are considerably higher for
participants than for nonparticipants, these heating penalties are also higher. Virtually no
program measures were found with direct favorable effects on space heating.

Table 4-1: Simulated End-Use Intensities (kWh/ft2)

Surveyed Participants Surveyed Nonparticipants
Title Title
End Use 20/24 | As-Built | Savings 20/24 | As-Built | Savings
Interior Lighting 7.790 5.597 2.193 6.405 5.237 1.168
Space Cooling 4.686 4.095 0.591 3.275 2.996 0.279
Space Heating 0.249 0.309 -0.060 0.126 0.129 -0.003
Ventilation 2.363 2.274 0.089 2.029 2.017 0.012
Refrigeration 3.466 3.129 0.337 4.332 4.330 0.002
Process 1.532 1.375 0.157 2.102 2.083 0.019
Other 3.617 3.617 0.000 5.059 5.059 0.000
All End Uses 23.731 20.424 3.307 23.334 21.856 1.478

Simulated Monthly Baseline and As-Built Usage

Figure 4-2 and Figure 4-3 illustrate the monthly patterns of baseline and as-built consumption
for participants and nonparticipants. As shown, the gap between these estimates—monthly
savings—appears to be relatively constant across months. This reflects the dominance of
lighting measures within the program.
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Figure 4-2: Simulated Baseline and As-Built Usage - Participants
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Figure 4-3: Simulated Baseline and As-Built Usage - Nonparticipants
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Figure 4-4 depicts the relationship between actual whole-building intensities and the as-built
simulated intensities for the overall sample. Of course, discrepancies between as-built and
actual intensities are obvioudly found at the individual site level. On the whole, however, the
as-built ssimulations track actual usage reasonably well, although they tend to overstate usage
in the summer months to some extent. Thisisacommon result for simulation analysis, and
traces to the fact that survey information on cooling practices can lead to overstatements of
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simulated loads. The correspondence between as-built and actual intensities suggest that the
realization rate analysis should not cause mgjor changes in the estimates of gross savings.

Figure 4-4: Actual Intensity Vs. As-Built Engineering Estimate - All Sites
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Simulation Estimates of Total Program Savings

Table 4-2 summarizes the simulation estimates of total program savings. Two sets of
estimates are provided. Thefirst relates to the sample of 252 participating sites used for this
analysis.® The second is expanded to represent the full program, which had 285 participants.
For the 252 sites subjected to simulation analysis, total savings amounted to over 31.4 GWh.
This estimates was expanded to the population using SDG& E’ s program estimates of savings
for ssimulated and non-simulated sites. This approach is appropriate because the composition
of the non-simulated sites was very different from that of the smulated sites. Thiswas not a
flaw in the sample design, given that a census was attempted. It resulted primarily from the
refusal of several sites with extremely large estimated savings per square foot to allow the on-
site survey. According to SDG& E program estimates, savings per square foot of the non-
simulated sites was 4.48 kWh per square foot and 391,383 kWh per site, while the program
estimate of savings for smulated sites was 2.82 kWh per square foot and 106,393 kWh per
site. Clearly, expanding the simulation results by square foot or number of sites would be
inappropriate. The expansion factor for energy savings was computed as:

9 Note that one site had to be dropped from the engineering analysis because RER had no way of simulating its
savings without conducting an additional survey of several hundred thousand square feet. By the time thiswas
realized, it was considered too late to revisit the site.
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Expansion Factor for Savings =

SDG& E Estimate of Total Program Savings

SDG& E Estimate of Savings for Surveyed Sites

= 1.483

The application of thisfactor to ssimulated savings resulted in an estimate of 46.570 GWh in
savings for the overall program. A similar factor was used to expand total square footage of
the surveyed sites to the population of participants. This factor, which was the ratio of
SDG&E’s estimate of square footage for all participants, divided by SDG& E’ s estimate of
square footage for the surveyed sites, was determined to be 1.304.

Table 4-2: Summary of Simulation Estimates of Program Savings

End Use

Engineering Estimates
for Surveyed Sites

Engineering Estimates
for All Participants

Total Savings (GWh)

Interior Lighting 20.840 30.885
Cooling 5.612 8.317
Heating -0.569 -0.843
Ventilation 0.845 1.252
Refrigeration 3.206 4.751
Process and Other 1.490 2.208
Total Whole Building 31.424 46.570
Squar e Feet 9,500,668 12,388,871
Savings per Square Foot (kWh)
Lighting 2.194 2.494
Cooling 0.591 0.672
Heating -0.060 -0.068
Ventilation 0.089 0.101
Refrigeration 0.338 0.384
Other 0.157 0.178
Total Whole Building 3.308 3.761
Savings per Participant (kWh)
Lighting 82,698 108,368
Cooling 23,270 29,182
Heating -2,258 -2,959
Ventilation 3,353 4,394
Refrigeration 12,722 16,671
Other 5,913 7,748
Total Whole Building 125,190 163,405

Building Smulation and Engineering Analysis

4-15



DG& E 1995 Nonresidential New Construction Program

Two central points should be made with respect to this simulation estimate of gross program
savings.

m  First, the engineering estimates contained in Table 4-2 are not directly comparable
to SDG& E’'s estimate filed with itsfirst year earnings claim, because it covers all
savings estimated for participants, not just savings from incented measures. As
such, it is much more broadly defined than SDG& E’ s ex ante savings estimate.
However, this broadening of the savings estimate will be adjusted in the net-to-
gross analysis, where participant savings are compared against savings experienced
by nonparticipants using the same standards. The reason for this approach isthat it
isvirtually impossible to disaggregate lighting savings from program and non-
program measures if the correct baseline for savingsisused. Title 24 lighting
standards are written in terms of lighting densities, rather than the prescription of
specific lighting types (although some lighting types are no longer permitted to be
manufactured). Title 24 baselines were simulated by using the allowed densities
for the space typesin question. If asite has adensity of, say, 20% below its Title
24 allowance, there is no good way to attribute this density reduction to incented
and non-incentivized measures. Of course, it could ssmply be assumed that the
incented measures were not in place. However, this requires the specification of a
specific baseline lighting technology, and this approach can yield implausible
results. For instance, using incandescent lighting as a baseline for compact
fluorescents can grossly overstate savings because the lumen-equivalent
incandescents could not be delivered without violating code densities.

m  Second, because they are defined differently, RER’ s engineering estimates of
savings should not be considered verification of SDG& E’ s approach to estimating
program savings. On the contrary, RER’ s review of the program files revealed
some magjor differences in the savings estimated for lighting and our estimates of
total lighting savings relative to code. Thiswas especially true when compact
fluorescents were incented. For sites with predominantly compact fluorescent
lighting and densities just qualifying for the program (10% below code), SDG&E’'s
estimates were often an order of magnitude greater than cal culations based on
code. Of course, thiswas partly offset by cases where sites installed considerably
less lighting than permitted by code without using a preponderance of incented
high-efficiency lighting. In these cases, RER's estimates were sometimes
considerably above SDG&E’s. It isnot clear what SDG& E should do in this area.
One option isto check that the baseline technology used to compute savings would
also satisfy Title 24, and to scale back estimates if this requirement is not satisfied.
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Estimation of Gross Realized Savings

5.1 Introduction

While the simulation results were cross checked against billing datain order to identify data
errors and/or mismatches between the surveyed site and the site covered by the billing data,
even the final engineering estimates can be biased due to errors in reported schedules or other
operating conditions. Moreover, engineering estimates ignore the possibility of rebound, or
snap-back, effects as well as the possibility that engineering biases may differ across levels of
efficiency. Although engineering estimates provide important information on gross program
impacts, these estimates were further refined with a statistical adjustment process termed the
realization rate approach.1° The general readlization rate framework is essentialy a
statistically adjusted engineering (SAE) approach designed to develop a set of calibration
factors, or realization rates, on the engineering estimates of savings from both incentivized
and non-incentivized measures. Two aspects of the analysis should be noted carefully. First,
it should be recognized that the base for the realization rates developed in this chapter is the
project team’ s engineering estimates of savings, not SDG& E’s ex ante estimates. Second, it
should be understood that the analysis yields estimates of gross realized (ex post) savings
without regard to the reasons why these measures were installed.

In the rest of this section, the application of the realization rate approach to estimate gross
realized program savingsis described. Subsection 5.2 provides an overview of the
realization rate approach. Subsection 5.3 discusses the specific realization rate model
developed in this evaluation. Subsection 5.4 presents the estimates of gross realized program
savings devel oped through the use of the model.

5.2 Overview of the Realization Rate Model
General Logic

The general logic of the realization rate approach (as applied to new construction programs)
isillustrated in Figure 5-1. Thefirst step of the analysis entails the devel opment of
engineering estimates of end-use consumption levels. Aswas discussed in Section 4, these

10 For other applications of this approach, see Sebold and Fox, 1985; and Sebold, Wang and Mayer, 1995.
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estimates are based on information about building features, equipment stocks, operating
schedules, and occupancy data. As shown in Figure 5-1, the realization rate model relies on
estimates of end-use consumption under two scenarios. the as-built scenario and the
reference scenario, which entails minimal compliance with building standards. The model
also makes use of information on site characteristics (e.g., square footage), as well as weather
conditions and occupancy characteristics that might affect the realization of the engineering
estimates of baseline usage and DSM-related savings. The model produces a set of
adjustment coefficients (or adjustment functions) that transl ate these engineering estimates
into estimates consistent with observed energy usage. These coefficients are called
realization rates. Asexplained below, the realization rates on savings reflect the proportion
of engineering-based savings estimates actually realized in the form of reduced site usage.
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Figure 5-1: Overview of the Realization Rate Model
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Model Specification

To derive the redlization rate model, we begin with the standard statistically adjusted
engineering (SAE) specification:

(1) Ept =& acEEACTUALg +€pyt
e

where Ey; is whole-building energy consumption at site b in timet, and EEACTUAL, IS an
engineering estimate of consumption through end use e at the site based on assumptions
reflecting the actual design and operation of the building. The presence of the adjustment
coefficient (ag) reflects the possibility of general engineering bias. The model can be
expanded by decomposing the engineering estimates into two elements:

(2) EEACTUAL,, = EEBASE - EESAVg

where EEBASE,, represents an engineering estimate of usage under a baseline assumption
with respect to the presence of energy conservation measures and EESAV« represents an
engineering estimate of savings from energy efficiency beyond the baseline. There are
several ways of defining the baseline for savings. One option in this regard would be to let
this estimate reflect minimal compliance with standards.’! The specification shown in (2)
simply splits the engineering estimate into a baseline estimate and an estimate of the savings
associated with the energy conservation beyond baseline levels. Substituting (2) into (1), we
obtain:

(3 Ept =& ag[EEBASE,, - EESAVpy ] +epy
e

Once the model is put into this form, possible modifications are apparent. First, the basic
adjustment coefficient on the estimated energy savings should be alowed to be different from
the adjustment coefficient of the baseline engineering estimate. Second, these adjustment
coefficients should be permitted to vary across sites as conditions vary. One possible version
of the revised model is asfollows:

(4) Ept =8 ae( Xyt )[EEBASE, - b EESAV« ] + €y
e

where b, is an adjustment coefficient reflecting the bias in engineering savings estimates
relative to the bias in the baseline energy usage estimates. Note also that the overall

11 Asexplained above, this reference scenario is only areference point for the realized savings analysis. The
true baseline for the overall program evaluation is the participant’ s usage in the absence of the program, and
this may differ from the level associated with standards compliance.
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adjustment coefficient (a<(Xp)) is assumed to be a function of relevant factors. These factors
could include site characteristics, like occupancy rates, as well as weather, building category
dummies, or other variables thought to affect the overall accuracy of baseline engineering
calculations.

Estimation of the Realization Rate Model

The redlization rate model can be estimated by applying regression analysisto dataon a
sample of sites for which billing data, comprehensive engineering estimates, and site data are
available. For this study, the model was estimated using all sites for which DOE-2 analyses
are conducted and for which comparable billing records were available. It isfairly common
to encounter several statistical problemsin the course of estimating this type of model, and it
isimportant to deal with these effectively. Typical problems are discussed later in this
section.

Use of the Model to Infer Realization Rates

Given this simple yet flexible framework, the end-use specific realized savings associated
with differences between baseline efficiency levels and the levels of efficiency found in the
buildings covered by the analysis would be:

(5) REALIZED SAVINGS,g = de(Xpt) De EESAVhg

wherg a ¢ isthe estimated overall adjustment function for the site and end use in question
and b.isthe estimated value of b.. The associated realization rate can be defined as:

(6) REALIZATION RATEpy = d¢(Xpt) De

There are several points to note about this approach:

m It directly integrates the results of building ssmulations. To the extent that it takes
advantage of the detailed information used as inputs into these simulations, it
should increase the efficiency of the gross savings estimation process. This, of
course, depends on the quality of the smulations, an issue that was addressed in
Section 4.

m Itisrelatively efficient in preserving degrees of freedom (compared, for instance,
to complex conditional demand models).

m |t can be used to estimate realized savings for individual conservation measures or
groups of measures, unlike approaches that focus on differences in energy usage
between participants and nonparticipants.
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m Itismore amenable to the analysis of a heterogeneous set of program participants
receiving a broad range of DSM measures than most other statistical approaches
like conditional demand analysis.

m It can be used directly to weather-normalize realized savings. The approach used
for this purpose is straightforward. Engineering estimates of base usage
(EEBASELy) and DSM savings (EESAV,,«) are developed through DOE-2
simulations using normal weather conditions. Then, the general redlization rate
function (a.(X.)) is specified to contain terms representing the deviation of actual
weather from normal weather in the billing period in question. This step
accommodates the fact that billing data reflect actual weather conditions, whereas
simulated usage estimates reflect normal weather. Once the redlization rate
function was estimated, the weather deviation is set to zero and the model is solved
for the realization rate and the associated weather-normalized value of realized
savings.

= Redlization rates derived for arepresentative sample of participants are applicable
to other participants for whom engineering estimates are similarly derived. Thus,
these rates can be used to transform engineering estimates of overall gross program
savings (adjusted for differences between evaluation engineering estimates and
program estimates) into calibrated estimates of realized savings.

5.3 Savings Through Design Program Realization Rate Model
Model Specification

The specific model used in thisrealization rate analysisis afairly smple form of the general
model presented above. The model is given by:

(7) Ept = bg + by EET24L Ty + byEEELTSAVy, + b3EET24HTy,
+ b4 EET24HTy,, HDDRAT 1, + bs EET24HT,, HDDRAT 2, + bg EEHTSAV,,
+ by EEHTSAV}, HDDRAT 1y + bg, EEHTSAV}, HDDRAT 2, + bg EET24CLy
+ b1 EET24CLy,; CDDRAT; + by EET24CL, CDDRAT 2, + b1, EECLSAV),
+ b3 EECLSAV,,; CDDRAT 1 + by4EECLSAV 2., CDDRAT;; + bys EET24VT,,
+b1g EEVTSAV,, + by7 EEBRER; + byg EEREFSAV}, +b1g EEPRAB,
+ b0 EEEXLTABy; + by EECKABy, + byy EECOOKAB, + byg EEWHAB,

+ by, EEEQUABY;: + by EEMISCABY;: + My
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where the following are engineering estimates based on the SITEPRO analysis:

EET24LTLy = lighting usage per square foot under the Title 24 scenario

EELTSAVy = lighting savingsrelative to Title 24

EET24HT,t = heating usage per square foot under the Title 24 scenario

EEHTSAVLt = heating savings relative to Title 24

EET24CLp,t = cooling usage per square foot under the Title 24 scenario

EECLSAV: = cooling savingsrelativeto Title 24

EET24VTt = ventilation usage per square foot under the Title 24 scenario

EEVTSAV: = ventilation savingsrelative to Title 24

EEBREFpt = basdline refrigeration usage per square foot

EEREFSAV: = refrigeration savings relative to the baseline

EEPRABpt = process usage (process, water heating, compressors) under the
as-built scenario

EEEXLTABpt = exterior lighting usage under the as-built scenario

EECKABRt = cooking usage under the as-built scenario

EEWHABL; = water heating usage under the as-built scenario

EEEQUABy: = office equipment usage under the as-built scenario

EEMISCABp: = miscellaneous usage under the as-built scenario

and where the weather terms are:

HDDRAT 1t deviation of actual heating degree-days from monthly normal
degree-days, as a proportion of average annual normal heating
degree days

deviation of actual cooling degree-days from monthly normal
values, as a proportion of average annual normal cooling degree
days

deviation of actual heating degree-days from average monthly
normal degree-days, as a proportion of average monthly normal
heating degree days

deviation of actual cooling degree-days from average monthly
normal values, as a proportion of average monthly normal cooling

degree days

CDDRAT1p

HDDRATZ2pt

CDDRAT2p

Note that the interaction of HDDRAT1,,; and CDDRAT1,,; with baseline usage and savings
accounts for the fact that the engineering estimates were based on normal (TMY') weather,
whereas actual space conditioning usage reflects actual weather. The expected sign of both
of these termsis negative. Theinteraction of HDDRAT2,: and CDDRAT2y,: with baseline
usage allows the realization rate to vary across weather conditions. A positive sign indicates
that actual cooling/heating loads are more sensitive to degree-days than the engineering
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estimates, while a negative sign indicates that actual loads are |ess sensitive than simulated
loads.

In the course of modd estimation, a number of additional variables were defined to account
for shortcomings in the engineering estimates. These variables are as follows:

m  Severd site specific dummy variables were defined for sites with loads that had
been identified but unquantified in the course of the survey. These loads included
unsurveyed parking garage lighting (RP002, RP242), large pumping loads
(RP602), pool pumping loads (RN159), campsite loads (RN164), unidentified
cooking loads (RN444), open architecture (RP188), and unidentified cooking and
miscellaneous loads (RP227 and RP248).

m Binary site variables were also defined to account for specific conditions at some
biological or pharmaceutical labs: the presence of large humidifiers at some sites,
and the presence of loads in areas that could not be surveyed. Three sites were
affected: RP196, RP201, and RP216.

Estimation Database

The redlization rate model was estimated by applying regression analysis to data on both
participants and nonparticipants. A total of 411 surveys were completed, so these sites were
candidates for the analysis. Some attrition in the sample was encountered, however. Four
nonparticipant sites were excluded altogether from the engineering and statistical analysis
because they did not really qualify as new construction, remodels, or tenant improvements.
Moreover, billing data for the surveyed site were unavailable in 62 cases. This problem
occurred when the surveyed site was a small part of the area covered by an account, and was
fairly common in campus settings and some large high-rise office buildings. In another four
cases, billing data were set equal to missing because they were incomplete (i.e., meters were
judged to be missing). Thisleft 349 sites with billing data to be used in the regression
anaysis.

The model was estimated with four types of data:

m Billing Data. Billing datafor the most recent 13 months were used. However,
one observation was lost for each site in the course of correcting for
autocorrelation.

m  Weather Data. Both actual and normal weather data were used for the same
period of time. Weather was characterized in terms of heating- and cooling
degree-days.

m Engineering Estimates. Engineering estimates of end use consumption under
the as-built and the baseline scenarios were incorporated as regressors.
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Other Site Characteristics. Other site characteristics, most prominently
sguare footage and building type, were also incorporated into the model.

Model Estimation

Several statistical problems can be encountered when estimating billing models like this one.
These problems and their resolutions are discussed briefly below.

Self-Selection Bias. Self-selection bias can be a problem in some load impact
regression models containing a participation variable, but should not affect a
realization rate model like the one to be used here. When the model contains one
or more participation variables, the coefficients of these variables are meant to
indicate the net impact of participation on energy usage, and their coefficients can
be biased by the presence of self-selection bias. However, in the redlization rate
model, ex ante savings estimates from the adoptions of specific measures (by
participants and nonparticipants) are included, rather than participation variables,
and there is no reason for self selection to affect these coefficients. Self-selection
bias will be addressed in Section 6, where the net impact of program participation
on efficiency choicesis assessed.

Multicollinearity. Multicollinearity isan econometric problem arising from the
correlation of explanatory variables with each other. In the presence of severe
multicollinearity, it is difficult to statistically disentangle the separate effects of the
offending (correlated) variables. In the context of this realized savings model, it
was sometimes necessary to restrict some of the coefficients to mitigate
collinearity.

Autocorrelation. Autocorrelation (the correlation of site-specific residuals over
time) can be avexing problem in that it biases the standard errors downward and
causes t-values to be overstated. A test for autocorrelation indicated its presence,
and generalized least squares was used to mitigate the problem.

Heteroskedasticity. Heteroskedasticity can aso be troublesome in the analysis
of nonresidential usage, partly because the scale of usage varies so sharply across
sites. This problem was mitigated through the application of generalized least
squares. The error variance was found to be positively correlated with site square
footage, and the data were transformed by the appropriate power of this variable to
mitigate the heteroskedasticity.

Outliers. Residualswere reviewed extensively. Given the strong fit of the
model, there were very few outliers. In general, these few extreme residuals arose
from partial occupancy at the site, and occurred at the beginning of the
consumption series for the sites in question. These specific monthly observations
were set equal to missing for the realization rate analysis, although the rest of the
monthly observations for the affected sites were used in estimation.

Estimation of Gross Realized Savings
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Model Results

Table 5-1 presents the estimated coefficients and standard errors for the realization rate
model. Two versions of the model are presented, differing only in the use of parameter
restrictions. These versions are discussed below.

Version 1. InVersion 1, we simplify the model by assuming that there is no differential
engineering bias between estimates of baseline usage and savings. This essentially means
that we are assuming that be in equation (4) isequal to 1.0 for all end uses. These
assumptions are imposed through a set of restrictions on the individual coefficients of the
parameters of the model. Note that the parameter estimates for baseline and savings are
equal (with asignreversal) for all end usesin thisversion as aresult of theserestrictions. In
this model, the coefficients on the free-standing savings terms can be interpreted as
realization rates. The coefficients of the heating and cooling degree-day interaction terms can
be ignored because these terms would be equal under normal weather conditions. As shown,
the interior lighting savings coefficient is equal to 1.13, which indicates that engineering
estimates of savings are fully realized in the form of reductions in energy usage. The sameis
true of process savings, which includes savings associated with air compressors, motors, and
process heat, and which takes on arealization rate of 0.97. The relatively low realization
rates on heating (0.887), cooling (0.825), and ventilation (0.655)are not completely
unexpected. Similar results have been found in other studies. HVAC usage is often lower
than engineering simulations would suggest, perhaps because of erroneous information on
thermostat schedules. The refrigeration realization rate (0.788) may result from a general
overestimate of refrigeration usage, and this may reflect the use of too high a diversity factor
in the engineering calculations.

Version 2. InVersion 2, we remove the parameter restriction on interior lighting, which
accounts for 90% of SDG& E’ s claimed savings, and refrigerationOther end uses were left in
the as-built form, for two reasons. First, cooling and heating savings are highly collinear with
lighting savings, insofar as they are strongly affected by lighting HVAC interactions, and this
leads to instability in their coefficients. Second, other end uses (e.g., process) have relatively
low expected savings, and the associated realization rates on savings tend to lack robustness.
Asshown in Table 5-2, the realization rate on lighting is very stable, falling only slightly to
1.045. Theredlization rate on refrigeration, on the other hand, increases fairly substantially
t0 0.942. While both versions of the realization rate model yield very similar savings overall,
Version 1 was chosen as the final version. This choice was made because of substantial
difference in the coefficients on refrigeration base usage and refrigeration savings did not
appear plausible. However, the results shown for Version 2 reinforce the general conclusions
that lighting savings are slightly more than fully realized and that other savings have
reasonably high rates of realization.
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Table 5-1: Estimated Realization Rate Model (t-values in parenthesis)

Variable Version 1 Version 2
EET24L Tt 1.12895 1.11612
(56.18) (47.28)

EELTSAVpt -1.12895 -1.04479
(56.18) (16.06)

EET24HTpt 0.88651 0.87675
(5.20) (5.26)

EET24HTp: HDDRAT1pt 2.50296 2.52188
(1.37) (1.41)

EET24HTp: HDDRAT2pt -0.26080 -0.25827
(3.13) (3.18)

EEHTSAVpt -0.88651 -0.87675
(5.20) (5.26)

EEHTSAVy HDDRAT 1yt -2.50296 -2.52188
(1.37) (1.41)

EET24HTp: HDDRAT2pt 0.26080 0.25827
(3.13) (3.18)

EET24CLpyt 0.82509 0.81677
(3L.22) (31.01)

EET24CLp; CDDRAT1pt 1.37184 1.35720
(8.24) (8.26)

EET24CLp; CDDRAT2pt -0.00514 -0.00574
(0.61) (0.69)

EECLSAVpt -0.82509 -0.81677
(3L.22) (31.01)

EECLSAVp: CDDRAT 1t -1.37184 -1.35720
(8.24) (8.26)

EET24HTp: HDDRAT2pt 0.00514 0.00574
(0.61) (0.69)

EET24V Tt 0.65505 0.65463
(34.29) (33.90)

EET24VTpt CDDRAT 2t 0.03201 0.03199
(5.06) (5.04)

EEVTSAV|t -0.65505 -0.65463
(34.29) (33.90)

EEVTSAV|,: CDDRAT 1t -0.03201 -0.03199
(5.06) (5.04)

EEBREFt 0.78818 0.79839
(60.01) (53.38)

EEREFSAVt -0.78818 -0.94181
(60.01) (8.02)

Estimation of Gross Realized Savings
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Table 5-1 (cont’d.): Estimated Realization Rate Model (t-values in parenthesis)

Variable Version 1 Version 2
EEPRT24pt 0.97345 0.97262
(72.75) (71.75)
EEPRSAVpt -0.97345 -0.97262
(72.75) (71.75)
EEEXLTABY 1.03322 1.02659
(29.00) (27.51)
EECKABp 1.02425 1.02311
(81.41) (78.69)
EEWHABt 2.32939 2.33976
(9.85) (9.78)
EEEQUAB; 1.07807 1.07284
(19.10) (19.10)
EEMISCABt 1.45613 1.46059
(33.60) (33.74)
RPO02p¢ 1.06048 1.04480
(6.46) (6.36)
RP242p 1.07755 1.08406
(8.89) (9.16)
RP602pt 1.54660 1.54084
(12.35) (12.49)
RN159 0.49974 0.49070
(3.83) (3.81)
RN164 1.43486 1.41901
(10.94) (10.96)
RN444 1.36915 1.42283
(3.91) (3.93)
RP188 0.86191 0.86810
(5.97) (6.07)
RP227 1.18674 1.24967
(10.33) (10.38)
RP248 0.93430 0.91473
(3.48) (3.54)
RP201 2.46401 2.45642
(10.66) (10.46)
RP196 1.53464 1.52169
(11.87) (11.93)
RP216 0.88825 0.86591
(8.02) (7.96)
Adjusted RZ 0.937 0.936
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5.4 Estimated Gross Realized Program Savings

The results of the realization rate model (Version 1) can be used to generate estimates of
realized savings for participants. For HVAC end uses, these estimates are designed to be
weather normalized. Thisisaccomplished by making the incremental weather terms
(HDDRAT1t, HDDRAT2)y;, CDDRAT1}y; and CDDRAT2}y) equal to zero (indicating that
under normal weather conditions, deviations from the TMY weather are assumed to be zero).
The results of these calculations are shown below in Table 5-2. Realized savings estimates
are presented in three forms. astotal energy saved, energy savings per square foot of
surveyed space, and energy savings per building. Gross realized savings are also presented
for the full population of participants. These estimates were developed by using the ratio of
total participant square footage to total surveyed square footage as an expansion factor.

Asshown in Table 5-2, our engineering estimate of total energy savings for the participant
sample amount to 46.78 GWh. Applying the end-use realization rates to the respective end-
use engineering estimates, we obtain atotal realized savings of 47.69. Thisimpliesan
overall realization rate of 1.0195.
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Table 5-2: Estimated Gross Realized Program Energy Savings

Engineering
Estimate of Estimated Gross

Program Realization Realized
End-Use Savings Rate Savings
Total Savings (GWh)
Interior Lighting 30.885 1.129 34.869
Cooling 8.317 0.825 6.862
Heating -0.843 0.887 -0.748
Ventilation 1.252 0.648 0.811
Refrigeration 4.751 0.788 3.744
Process 2.208 0.973 2.148
Total Whole Building 46.570 1.024 47.686
Savings per Squar e Foot
(kWh)
Interior Lighting 2.494 1.129 2.816
Cooling 0.672 0.825 0.5%4
Heating -0.068 0.887 -0.060
Ventilation 0.101 0.648 0.065
Refrigeration 0.384 0.788 0.303
Other 0.178 0.973 0.173
Total Whole Building 3.761 1.024 3.851
Savings per Participant (kWh)
Interior Lighting 108,368 1.129 122,347
Cooling 29,182 0.825 24,075
Heating -2,959 0.887 -2,625
Ventilation 4,394 0.648 2,847
Refrigeration 16,671 0.788 13,137
Process 7,748 0.973 7,539
Total Whole Building 163,405 1.024 167,321
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Table 5-3 depicts estimated demand savings. The peak fractions used to develop these
estimates were derived from SitePro results. These peak fractions are:

m Interior Lighting: 0.00017
s Cooling: 0.00023

= Ventilation: 0.00015

= Heating: 0.00000

m  Refrigeration: 0.00011

s Process: 0.00020

It was assumed that the energy realization rates also apply to demand savings. Asindicated
in Table 5-3, total realized demand impacts amount to over 8.4 MW, or just over 29.7 KW per
building (per participant).
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Table 5-3: Estimated Gross Realized Program Demand Savings

Engineering
Estimate of Estimated Gross

Program Realization Realized
End-Use Savings Rate Savings
Total Savings (MW)
Lighting 5.250 1.129 5.928
Cooling 1.913 0.825 1.578
Heating 0.000 0.887 0.000
Ventilation 0.188 0.648 0.122
Refrigeration 0.523 0.788 0.412
Other 0.442 0.973 0.430
Total of All End-Uses 8.315 1.019 8.469
Savings per Square Foot (W)
Lighting 0.424 1.129 0.479
Cooling 0.155 0.825 0.127
Heating 0 0.887 0.000
Ventilation 0.015 0.648 0.010
Refrigeration 0.042 0.788 0.033
Process 0.036 0.973 0.035
Total of All End-Uses 0.672 1.019 0.684
Savings per Participant (kW)
Lighting 18.423 1.129 20.799
Cooling 6.712 0.825 5.537
Heating 0.000 0.887 0.000
Ventilation 0.659 0.648 0.427
Refrigeration 1.834 0.788 1.445
Other 1.550 0.973 1.508
Total of All End-Uses 29.177 1.019 29.716
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The CPUC M&E Protocols require the specification of confidence intervals for both gross
and net savings estimates. Thisis not a straightforward exercise when arealization rate
model is specified with separate realization rates on individual end uses, insofar as the
standard error of total realized savings depends on the variances and covariances of all of the
estimated realization rates. Confidence intervals were developed for gross realized savings

using the following approach:

m  First, theredlization rate model (Version 1) was re-estimated using a composite of
all of the savings variables, each multiplied timesits own coefficient from
Table5-1. That is, the composite (SAVpt) was defined as:

AV, = é dAk AV,
k

where cfk is the estimated coefficient from Table 5-1 and SAV,,, isthe savings term

for end use k. Of course, the expected coefficient of this composite variableis 1.0,
since this form of the model is equivalent to Version 1.

m  Second, the standard error of the composite variable, which is arelative standard
error in the sense that the coefficient is normalized to 1.0, is used to develop a
confidence interval for gross realized savings.

The results of this exercise are shown in Table 5-4.

Table 5-4: Confidence Intervals for Estimated Gross Realized Savings

90% Confidence

80% Confidence

Measure of Savings Point Estimate Interval Interval
Gross Energy Savings
Total Program (GWh) 47.686 43.943 - 51.429 44,772 - 50.600
per Square Foot (KWh/ft?) 3.851 3.549 - 4.153 3.616 - 4.086
per Building (kWh) 167,321 154,186 - 180,456 | 157,098 - 177,544
Gross Demand Savings
Total Program (MW) 8.469 7.804 - 9.134 7.952 - 8.986
per Square Foot (W/ft?) 0.684 0.630-0.738 0.642 - 0.726
per Building (kW) 29.716 27.383 - 32.049 27.900 - 31.532

Estimation of Gross Realized Savings
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Estimation of Net Realized Impacts

6.1 Introduction

The net impacts of the program are the savings that can be attributed to the program.
Estimating net impacts of new construction programs is a complex process. New
construction programs are multi-dimensional, covering multiple end uses and a variety of
DSM equipment options and measures. Choices may also be interdependent in the sense that
the choices of some measures may affect the evaluation of others. Thisinterdependence can
be linked to budgetary or design issues, however, it can also stem from performance-based
paths of code compliance which permit substitution of efficiency within and across end uses.

Program net impacts may differ from the gross impacts discussed above for several reasons:

Free Ridership. Decision makers at participating sites might have installed
measures at a participating site in the absence of the program. If so, they would
be considered freeriders.

Participant Free Drivership. Decision makers may instal non-incentivized
measures at participating sites as aresult of the program’sinfluence. If so, they
would be considered participant free drivers.

Nonparticipant Free Drivership. Decision makers who install non-
incentivized measures at nonparticipating sites as aresult of the program’s
influence would be considered nonparticipant free drivers.

Market Transformation. The existence of a program may cause long-term
changes in the marketplace for DSM technologies. This may occur because of
program-induced changes in awareness, changes in vendor stocking patterns, or
reductions in technology costs. While thisimpact may be important for some
programs (especially those dealing with new technologies), it is extremely difficult
to quantify.

Evaluation literature reveals a wide range of approaches for estimating net program impacts.
Three approaches were implemented for this evaluation:

The use of self-reported free ridership,

Estimation of Net Realized |mpacts 6-1



DG& E 1995 Nonresidential New Construction Program

m  Comparisons of participant and nonparticipant efficiency levels, and
m  Statistical modeling of efficiency choices.

These approaches are summarized below.

6.2 Self-Reported Estimates of Free Ridership

The most direct means of estimating free ridership and free drivership isto poll decision
makers on the influence of the program on adoptions. This approach was taken as one option
for addressing free ridership in the present study. A total of 122 decision makers representing
213 participating sites responded to the survey. Four surveys were not used due to
incomplete data, leaving 209 surveys used in the analysis. They were polled on the
likelihood that they would have installed measures at a participating site in the absence of
the program. The specific question asked for each incented end use was:

If SDG&E’ s incentive had not been available for the (measure) you installed, how
likely isit that you would have installed lighting equipment more efficient than
required to satisfy Title 24?

Responses were used to obtain free rider probabilities using the following assignments:

Definitely would have installed 1.00
Probably would have installed 0.67
Probably would not haveinstalled  0.33
Definitely would not have installed  0.00
Don't know missing

The probabilities were then weighted by total savings for the affected end use (as represented
by the engineering estimates developed in the course of the project) and averaged. The
results of this exercise are shown in Table 6-1. Asindicated, the self-reported free rider
ratios for lighting, cooling and motors/drives are very high and the implied net-to-gross ratios
are correspondingly low. The free rider ratio for other end usesis equal to zero, but it covers
relatively little savings. These results should be viewed skeptically. Self-reported estimates
of free ridership and free drivership are subject to a variety of biases, including hypothetical
bias and strategic bias (gamesmanship). The next two approaches focus on actual differences
in efficiency at participating and nonparticipating sites.
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Table 6-1: Self-Reported Free-Rider Ratios

Self-Reported Implied Net-to-
Affected End Use Free-Rider Ratio Gross Ratio
Lighting 68.5% 31.5%
Cooling 63.6% 36.4%
Motors and Drives 67.0% 33.0%
Other End Uses 0.0% 100.0%

6.3 Comparisons of Efficiency Levels

An alternative means of estimating free ridership isto focus more directly on the relative
efficiency levels chosen by participants and nonparticipants. This approach isrecognized in
the CPUC M& E Protocols as an option under the “ Differences of Differences Approach.” In
the context of a new construction program like this one, the net-to-grossratio is defined as:

Participant Savings - Nonparticipant Savings
Participant Savings

Net-to-Gross Ratio =

where participant and non-participant savings are defined in turn as differences between
baseline (Title 20/24) consumption and as-built consumption.

For the purposes of this section, realized savings per square foot are used for this purpose.
Realized savings for participants are drawn from the last column of Table 5-2. Realized
savings for nonparticipants are derived from the engineering estimates in Table 4-1, coupled
with the realization ratesin Table 5-2. Note that this approach takes account of free ridership
and participant free drivership, but assumes that nonparticipant free drivership is zero. Table
6-2 presents a comparison of end-use savings per square foot for participants and
nonparticipants, and indicates the implied net-to-gross ratios. The analysisis conducted on
an end use basis. Note the following:

m Lighting savings are high for both participants and nonparticipants, leading to
an implied net-to-gross ratio of only 53%. Thisisafunction of the density-based
Title 24 standard and is not surprising in new construction. For instance,
participant lighting efficiencies tend to beat code even when no lighting incentives
are paid to them. (Keep in mind that a participant is defined as a site that was
incented for any end use. This approach is necessary because of the tradeoffs
across end uses in code compliance. Also keep in mind that the efficiencies listed
in Table 6-2 reflect al savings relative to code, not just savings for which
incentives were paid.
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Space heating savings are negative. Thisis not because builders are installing
substandard equipment, but rather because the installation of high-efficiency
lighting increases heating requirements. Indeed, most of the negative heating
savings simply represent the heating penalty on lighting efficiency. It should be
kept in mind, of course, that the Title 24 base heating usage is very low relative to
lighting, so these efficiencies are not directly comparable. Heating savings per
sguare foot are only -0.060, whereas lighting savings per square foot are 2.81.
Thus, the heating penalty is small relative to the lighting savings.

Cooling savings are aso reasonably high for both participants and
nonparticipants, implying a net-to-gross ratio of only 58%. Since these values
were based on actual and Title 20 equipment efficiencies, this suggests that
nonparticipants are installing somewhat more efficient equipment than required by
code. Again, though, it should be remembered that participant efficiency comes
from not only incentivized but also non-incentivized equipment. Hence thereis, in
asense, acommon element of naturally occurring efficiency in both. Moreover, it
should be recalled that a substantial share of cooling savings take the form of
cooling bonuses from lighting savings.

Ventilation savings isconsiderably higher for participants than for
nonparticipants, indicating a net-to-gross ratio of 88%. Thisistraceable primarily
to VAV systemsand VSDson VAV systems, measures that were relatively rarein
nonparticipating buildings.

Refrigeration savings isalso far higher in participating sites than in
nonparticipating buildings. Program data suggest that SDG& E may have been
particularly active in promoting refrigeration measures. The refrigeration net-to-
gross estimate based on this simple comparison is virtually equal to 100%.

Process savings ismuch higher for participants than for nonparticipants. This
islargely attributable to a few large process measures installed through the
program. The associated net-to-gross ratio is over 89%.

Combined savings for al end usesis more than twice as high for participants
asfor nonparticipants. This suggests an overall average net-to-gross ratio just over
59%.

6-4
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Table 6-2: Comparisons of Realized End-Use Savings per Square Foot

Participant Nonpar ticipant Implied Net-to-
End Use Savings Savings Gross Ratio
Interior Lighting 2.816 1.319 0.532
Space Cooling 0.554 0.230 0.584
Space Heating -0.060 -0.003 0.956
Ventilation 0.065 0.008 0.880
Refrigeration 0.303 0.002 0.995
Process 0.173 0.018 0.893
Whole Building 3.851 1574 0.591

The values presented in Table 6-2 will be used for the purposes of this evaluation. Aswill be
shown below, these estimated ratios yield very conservative estimates of net program
savings.

6.4 Efficiency Decision Modeling

While basing net-to-gross ratios on comparisons of savings satisfies the CPUC M&E
Protocols, such comparisons of participants and nonparticipants may be affected by two kinds
of bias. First, they ignore differencesin site features that could influence efficiency levels.
Second, they may suffer from self-selection bias. As explained in this section, it may be
possible to mitigate these problems with a modeling approach. A statistical model can be
used to characterize efficiency choicesin terms of various levels of program participation and
other determinants. The model can be designed to estimate the net impacts of participation
on end-use specific efficiency levels, then used to develop a set of net-to-gross ratios
reflecting both free-ridership and participant free-drivership effects. This efficiency model
discussed below.

General Logic

The general logic of the model isillustrated in Figure 6-1. As shown, the model is designed
to explain both participation decisions and efficiency decisions in terms of several drivers,
including program participation, site characteristics, and decision factors. Once estimated,
the model can be used to generate predictions of end-use efficiency levelsfor participantsin
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the absence of the program. This prediction can be used to devel op net-to-gross ratios and
estimates of net program savings.

Figure 6-1: Efficiency Choice Model

Efficiency
Estimates

Y 4 )

*Predicted Efficiency

Participant Status |

Efficiency Model

Site Characteristics | w/wo Participation

*Free-Ridership Ratio

Participation Model
( ) ) ’ *Net-To-Gross Ratio
Decision Factors |

Measures of Efficiency Choices

Much of the literature in program evaluation concentrates on the effects of utility programs
on the adoption of discrete DSM measures. This approach is sensible for the analysis of
programs with purely prescriptive offerings, like high-efficiency air conditioning or compact
fluorescent programs. However, new construction programs cover multiple end uses and a
variety of DSM equipment and measures that affect each use. Compliance with code and (in
many cases) adherence to program requirements may be accomplished on a performance,
rather than a prescriptive, basis. A builder can adopt awide variety of measures and qualify
for participation. To provide a reasonable assessment of program impacts on energy-
efficiency decisions, comprehensive indicators of energy efficiency are needed. Asin past
studies, thisissue was resolved by constructing an index of overall efficiency for each end
use. Each efficiency index (EFFye) is an estimate of proportional realized savings relative to
the adjusted reference (baseline) consumption for an end use e and building b:

(1) EFRye =ag( xb)Be[ EEBASE, - EEACTUALe] / [de(Xp) EEBASE, ]
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The numerator of thisindex represents realized savings, while the denominator reflects
adjusted reference consumption.12 1n essence, the index for end use e and building b simply
reflects the proportion by which the building’s end-use |oad exceeds the applicable code.
This means of quantifying savings acts to control for factors that affect both baseline usage
and savings.

General Model Specification

The efficiency model takes on the following algebraic form:

(2) PART, = fo(EFFp,DECISON,,SITE, €p)
(3) EFFy = ge(PART,, S TE,, DECISIONp,,p)

where PART,, is a binary indicator of participation in the program, EFFy. is athe efficiency
index for building b and end use e, DECISSONyis a set of decision variables, and STEy isa
set of site characteristics. Note that this specific modeling approach, like simple comparisons
of participants and nonparticipants, ignores nonparticipant free drivership.

Savings Through Design Efficiency Model

The specific model specified and estimated for this evaluation is designed to cover the
following end uses: interior lighting, cooling, heating, ventilation, refrigeration and process.
Together, these end uses comprise nearly all of the estimated realized savings from the
program. The efficiency choice model is described below. First, the participation equation is
given by:

egxbi

(4) PARTb = m

where:

oX, =9, +9,O0WNOCC, +9g,QFT, +9,FCOSI, +9,0QFT,
(5) +95 NEV\{) +gGEDUCb +g7OFFb +98 RESD +gQGROb +glORETb +911WAR0
+ glz MEDb + 913 LODb + gl4 PUBb + ngS:\’Vb + glG |\/”:Gb + hb

where the following definitions apply:

12 Thisis ageneral formulation for the efficiency index. Insofar as the realization rate model chosen for this
evaluation contains restrictions on the relative values of the coefficients on baseline usage and savings, the
adjustment coefficients in this specification cancel out.
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abinary variable indicating participation in the 1995 Savings Through
Design Program

abinary variable indicating that the building was built for owner-
occupancy

total surveyed site square footage

the reported importance of first cost as a determinant of construction
design choices

square footage of the site in question

abinary indicator that the site is newly constructed (as opposed to a
remodel or atenant improvement

arandom error term

and where the remainder of the regressors are binary variables representing the following
building categories: offices (OFFp), restaurants (RES,), grocery stores (GROy,), retail

(RET), warehouses (WARy,), medical (MEDp), education (EDU), lodging (LODp,), public
assembly (PUBp), services (SRVp) and manufacturing (MFGp,).

Efficiency models were estimated for three groups of end uses:

m Interior Lighting and Heating. These end uses were combined because
virtually all of the (negative) space heating efficiency is associated with heating
penalties of installed lighting measures.

m  Cooling and Ventilation. These end uses were combined for smplicity and
because it isfairly common for measures affecting both end uses to be installed at
participating sites.

m  Refrigeration and Process. Refrigeration and process end uses (water
heating, air compressors, and motors) were combined to simplify the modeling
task. Moreover, very few measuresfall into the process category, and modeling
these choices would be very difficult.

The lighting efficiency model is specified as follows:

EFFL, =ag +a;0WNOCG, +a,(EET24LT, + EET24HT,) +a3FCOST,

6
( ) +a4NEV\6 +a5EFFF% +a60THPF% +a7PARTb+n]J
where:
EFFLp = thelighting efficiency ratio
EFFRy = theranking of energy efficiency as a determinant of construction
design
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OTHPR, = anindicator of the site’s participation in one of SDG&E’s other
commercia programs

EET24LT, = baselinelighting usage

EET24HT = baseline heating usage

m = arandom error term

Air conditioning and ventilation were combined into a single efficiency ratio for the purposes
of the efficiency modeling. The associated efficiency model is given by:

EFFHVAC, =s, +s,0WNOCG, +s,(EET24CL, + EET24VT, ) +s ,FCOST,

7

(7 +s,EFFR, +s.CDDN, +s,OTHPR +a,PART, +j ,
where:

EFFHVACL = ane€efficiency ratio for air conditioning and ventilation

CDDNp = normal annual cooling degree days at the site

EET24CLp = baseline cooling usage
EET24VT, = baseline ventilation usage
I b = arandom error term

Finally, the refrigeration/process efficiency model is represented as.

EFFR, =W, +W,0WNOCC, +w,(EEBREF, + EEBPR, ) +w,FCOST,

8
®) +w,NEW, +W,EFFR, +W,OTHPR, +w, PART, +z,
where:
EFFR, = therefrigeration/process efficiency ratio
EEBREFp = baseline refrigeration usage
EEBPRy = baseline process usage
Xp = arandom error term.

Estimation of the Efficiency Models

The participation equation and a set of efficiency equations can be estimated using data on
efficiency levels, participation, site features, and decision-maker characteristics. Inthe
context of this specification, it is recognized that efficiency decisions and participation
decision are simultaneously determined. In statistical jargon, both efficiency levels and
participation are endogenous. Because of the endogeneity of program participation and self
selection of the participants and nonparticipants, the estimation technique must be designed
to resolve self-selection bias. There are three optionsin this regard:
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m  Mills Ratio Approach. First, aself-selection correction term (an inverse Mills
Ratio) could be included in the efficiency equation. This method istypically
attributed to Heckman.13 The ssimple application of theinverse Mills Ratio isa
subject of some controversy in the evaluation literature. However, arecent paper
by Goldberg and Train!4 suggests that the ratio should be entered twice in the
energy change equation: once as a free-standing term and once interactively with
the participation term. Thelogic of this specification is that the Mills Ratio affects
the change in usage as well as the impact of the participation variable in the energy
change equation. With this specification, the net impact of participation on the
changein energy consumption is afunction of the Mills Ratio.

s Train Approaches. Train>proposes two aternative means of mitigating this
form of bias. Thefirst approach is actually attributable to Hartman (1988), and
involves an instrumental variables procedure where predicted participation (call
this PART*) is substituted for the participation variable in the efficiency equation.
The second is an aternative (yet very similar) approach in which the adoption
model is estimated simultaneously with a participation model using nonlinear least
squares with instruments.

s Wang Approach. Third, the adoption model and the participation model could
be estimated simultaneously using full information maximum likelihood
estimation. This approach can be attributed to Wang.16 Whileit is more efficient
than the two-stage least squares or instrumental variables approaches, it isalso far
more difficult to implement.

The literature on self selection has not yet yielded a clear consensus on the appropriate means
of dealing with this problem in program evaluation. The controversy surrounding the proper
means of treating self-selection bias will not be resolved in the course of this evaluation.
Therefore, the net impact of program participation was estimated using two approaches: the
Hartman instrumental variables approach and the Goldberg and Train double Mills Ratio
method.

Lighting and Heating Model. The estimated Savings Through Design interior lighting
and heating efficiency model is presented in Table 6-3. Two versions of the model are

13 Heckman, J. (1976). “The Common Structure of Statistical Models of Truncation Sample Selection and
Limited Dependent Variables and a Simple Estimator for Such Models,” Annals of Economic and Social
Measurement, 5/4, 1976.

14 Goldberg and Train (1995). “Net Savings Estimation: An Analysis of Regression and Discrete Choice
Approaches,” Report submitted by XENERGY,, Inc. to CADMAC Subcommittee on Base Efficiency,
August 1995.

15 Train, K (1994b).” Estimation of Net Savings from Energy Conservation Programs,” Energy, vol.19, No.,
1994.

16 Wang, B (1994). “Maximum Likelihood Estimation with Sample Selection”, Ph.D. Dissertation, Washington
State University.
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presented. Version 1 reflects the use of the Hartman instrumental variables approach, while
Version 2 involves the use of the Goldberg and Train double Mills Ratio technique.

Version 1 of the lighting and heating model yields the following findings:

m  The coefficient of the participation variable is 0.185, which indicates that
participation increases combined lighting and heating efficiency by 0.185.

m  Owner-occupancy has a significant positive effect on lighting and heating
efficiency.

m  Theranking of first cost as afactor in making energy efficiency decisions has a
positive effect on efficiency (high ranks indicate less importance).

m |If thesiteis new construction (rather than aremodel or atenant improvement,
efficiency tends to be lower).

m  Thebetter (lower) the ranking of efficiency as afactor in making construction
decisions, the higher the efficiency level.

m  Efficiency levelstend to be lower in buildings with high Title 24 lighting
allowances.

m  Thevariable representing participation in other programs entered the equation with
the wrong sign and was subsequently dropped.

Version 2 of the lighting and heating efficiency equation confirms most of the findings from
Version 1. The participation variable is significant, but both Mills Ratio terms are not. The
combination of the two participation terms yields a net efficiency impact of 0.18258. Thisis
virtually identical to the result derived from Version 1.
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Table 6-3: Estimated Lighting and Heating Efficiency Model (t values in
parentheses)

Explanatory Variable Version 1 Version 2
Intercept 0.15649 0.18191
(3.05) (2.93)
PART - 0.20205
(3.58)
PART* 0.18492 -
(4.18)
MRy - 0.01492
(0.59)
PARTL MRy - 0.04615
(1.37)
OWNOCCy, 0.04693 0.03659
(2.14) (1.70)
FCOSTp 0.02998 0.02812
(3.83) (3.64)
NEW -0.06418 -0.08629
(3.30) (4.38)
EFFRp -0.01927 -0.02354
(2.25) (2.83)
EET24LTp+ EET24HT} -0.00439 -0.00405
(2.13) (2.01)
Adjusted RZ 0.160 0.204

Cooling and Ventilation Model. The estimated cooling and ventilation efficiency model
ispresented in Table 6-4. Again, two versions of the model are presented. Version 1 yields
the following findings:

m  Theestimated coefficient on the predicted participation variable is insignificant.
Its point estimate suggests that participation increases combined cooling and
ventilation efficiency by only 0.033.

= Neither owner-occupancy nor the ranking of first cost as a factor in making energy
efficiency decisions has a significant effect on cooling and ventilation efficiency.

m  Thebetter (lower) the ranking of efficiency as afactor in making construction
decisions, the higher the efficiency level.

m  Efficiency levelstend to be lower in buildings with high baseline cooling loads.

m  Thevariable representing participation in other programs took on the wrong sign,
and was ultimately dropped from the mode!.
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Again, Version 2 confirms the general findings of Version 1. However, the estimated net
impact of participation on cooling and ventilation efficiency is very different from the result
of Version 1. The solution of the equation yields an estimated net impact of 0.08588, which

is more than twice as high as the estimate derived from Version 1..

Table 6-4: Estimated Cooling and Ventilation Efficiency Model

Explanatory Variable Version 1 Version 2
I nter cept 0.09941 0.04314
(1.94) (0.97)
PARTH - 0.07452
(1.81)
PROBp 0.03317 -
(1.30)
MRy - 0.02498
(1.18)
PARTL MRy - -0.02558
(1.04)
OWNOCCy, 0.00508 0.00372
(0.43) (0.32)
FCOSTp 0.00110 0.00167
(0.20) (0.30)
EFFRp -0.01068 -0.01073
(1.84) (1.92)
CDDNp -0.00002 -
(0.38)
EET24CLp+ EET24VT -0.00020 -0.00016
(1.96) (1.56)
Adjusted RZ 0.015 0.022

Refrigeration and Process Model. The estimated refrigeration and process efficiency

model is presented in Table 6-5. Version 1 suggests the following:

Predicted participation has a highly significant impact on net efficiency. The
coefficient suggests that thisimpact is 0.18492. However, the gross efficiency of
participants covered by this analysisis only 0.10556.

Owner-occupancy has a positive effect on efficiency.

Oddly, the rankings of energy efficiency (where low means more important) has a
positive effect on the choice of efficiency. Thisis presumably an anomalous
resullt.

The size of baseline refrigeration and process |oads has a strong positive impact on
efficiency.
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Version 2 yields amost identical results. The solution of the equation reveals a net impact of
0.16012.

Table 6-5: Estimated Refrigeration and Process Efficiency Model

Explanatory Variable Version 1 Version 2
Intercept -0.13521 -0.12655
(6.04) (4.07)
PARTH - 0.14740
(4.97)
PROBy, 0.15773
(7.06)
MRy - 0.02003
(1.45)
PARTL MRy - -0.02385
(1.29)
OWNOCCy, 0.04294 0.00959
(3.34) (0.79)
FCOSTp -0.00577 -0.01200
(1.25) (2.62)
EFFRp 0.01488 0.01790
(2.64) (3.27)
EEBREFp+ EEBPRY, 0.00142 0.00136
(14.51) (13.55)
Adjusted RZ 0.474 0.522

Use of the Model to Infer Net-to-Gross Ratios

Once the efficiency equation is estimated, it can be used to develop a set of estimates of net-
to-gross ratios as:

(10) Net - to- Gross Ratiope = (TEFF, / TPART,) / EFFye

In the language of the CPUC M& E Protocols, the derivative of efficiency with respect to the
participation variable is essentially a difference of differences calculation of net program
impacts. That is, it represents the difference between participant and nonparticipant
efficiency, controlling for other factorsin the equation. Division of this estimated net impact
by the gross efficiency level of participants thus yields a net-to-gross ratio consistent with the
Protocols.

Net-to-gross ratios were developed for all participants and aggregated to the program level
through the devel opment of weighted averages of these ratios across sites. Note that the net
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impact on efficiency (the numerator of the net-to-gross ratio) is computed sightly differently
in thetwo versions. InVersion 1 of the lighting model, for instance, this derivativeis given

by:

(11) EFFL, / JPART, = JEFFL, / JPROB, =4,

wherea, isthe estimated coefficient of the predicted participation variable; whereasin
Version 2, it isderived as:

(12) JEFF, / PART, =&, +d, MR,

whered, isthe estimated coefficient of the participation variable andajis the estimated
coefficient of the interaction term involving the Mills Ratio and the participation variable.

The results of this exercise are shown in Table 6-6. Note that, since the efficiency equations
are estimated with data on sites with completed decision-maker surveys, the net -to-gross
ratios are also estimated with only these sites. Given the excellent coverage of the decision-
maker survey, however, these ratios should represent the total participant population
reasonably well. The findings are mixed, as described below:

s Asshownin Table 6-6, the net-to-gross ratios estimated for lighting and heating
arevirtually identical across equations. They suggest that two-thirds of the gross
savings experienced by participants can be attributed to participation.

m Theresultsfor cooling and ventilation, however, are not robust across
specifications. Thisis due to the substantial variation in cooling and ventilation
efficiencies within the participant and nonparticipant samples. The estimate
derived from the Hartman approach appears too low in light of the simple
comparisons of savings discussed earlier, while the estimate derived from the
Goldberg and Train approach seems implausibly high.

m  The net-to-gross ratios derived for refrigeration and process end uses exceed 1.0,
and are thus not reasonable per se. This may be attributable to the linearity of the
efficiency model. However, the model results do generally fit with other evidence
in suggesting that the net-to-gross ratio for refrigeration and process end usesis
very high.
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Table 6-6: Model-Based Estimated Net-to-Gross Ratios

Hartman Approach

Goldberg/Train Approach

Net-to- Net-to-

Net Gross Gross Net Gross Gross

End Use Impact | Impact | Ratio | Impact | Impact | Ratio
Cooling and Ventilation 0.0332| 0.0888| 0.3739| 0.0859| 0.0888| 0.9673

6.5 Estimated Net Program Savings

Table 6-7 summarizes various estimates of savings yielded by the analysis. The net-to-gross
ratios used for this calculation are based on the simple difference-of -differences approach
discussed in Section 6.3. Asindicated by the efficiency modeling results shown in Section
6.4, the ratios used here probably yield very conservative estimates of net program savings.

Asshown in Table 6-7, estimated net energy savings amount to just over 28 GWh. The net

demand impact is4.98 MW.

6-16
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Table 6-7: Estimated Net Realized Program Energy Savings

GrossRealized | Net-to-Gross | Estimate of Net
End Use Savings Ratio Realized Savings
Total Savings (GWh)
Lighting 34.869 0.532 18.550
Cooling 6.862 0.584 4.007
Heating -0.748 0.956 -0.715
Ventilation 0.811 0.880 0.714
Refrigeration 3.744 0.995 3.725
Process 2.148 0.893 1.918
Total Whole Building 47.686 0.591 28.200
Savings per Squar e Foot
(kWh)
Lighting 2.816 0.532 1.498
Cooling 0.554 0.584 0.324
Heating -0.060 0.956 -0.057
Ventilation 0.065 0.880 0.057
Refrigeration 0.303 0.995 0.301
Other 0.173 0.893 0.154
Total Whole Building 3.851 0.591 2.277
Savings per Participant (kWh)
Lighting 122,347 0.532 65,089
Cooling 24,075 0.584 14,060
Heating -2,625 0.956 -2,510
Ventilation 2,847 0.880 2,505
Refrigeration 13,137 0.995 13,071
Other 7,539 0.893 6,732
Total Whole Building 167,321 0.591 98,948
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Table 6-8: Estimated Net Program Demand Savings

GrossRealized | Net-to-Gross | Estimate of Net
End Use Savings Ratio Realized Savings
Total Savings (MW)
Lighting 5.928 0.532 3154
Cooling 1.578 0.584 0.922
Heating 0.000 0.956 0.000
Ventilation 0.122 0.880 0.107
Refrigeration 0.412 0.995 0.410
Other 0.430 0.893 0.384
Total Whole Building 8.469 0.588 4.977
Savings per Square Foot (kW)
Lighting 0.479 0.532 0.255
Cooling 0.127 0.584 0.074
Heating 0.000 0.956 0.000
Ventilation 0.010 0.880 0.009
Refrigeration 0.033 0.995 0.033
Other 0.035 0.893 0.031
Total Whole Building 0.684 0.588 0.402
Savings per Participant (kW)
Lighting 20.799 0.532 11.065
Cooling 5.537 0.584 3.234
Heating 0.000 0.956 0.000
Ventilation 0.427 0.880 0.376
Refrigeration 1.445 0.995 1.438
Other 1.508 0.893 1.347
Total Whole Building 29.716 0.588 17.459

The CPUC M&E Protocols require confidence intervals for both net and gross savings. Of
course, building confidence intervals for net savings would require standard errors of net
savings. Given the many calculations that enter into the estimation of net savings, however,
true standard errors would be virtually impossible to obtain. Approximate net savings
confidence intervals were derived as follows:
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m Relative confidence intervals (intervals cast in terms of percentages of the point
estimate) were developed for the estimates of net efficiency impacts flowing from
the efficiency models presented in Section 6.4. These intervals are presented in

Table 6-9.

m  Theserelative confidence intervals were then weighted by estimated end use
savings to obtain awhole-building relative interval.

m  Finally, therelative interval was applied to the various measures of net savings. .

The results of this approach are presented in Table 6-10.

Table 6-9: Relative Confidence Intervals by End Use Group

End Use Group 90% ConfidenceInterval | 80% Confidence Interval
Lighting and Space Heating 0.606 to 1.394 0.694 to 1.306

Air Conditioning and -0.265 to 2.265 -0.015t0 1.985
Ventilation

Refrigeration and Process 0.767 t01.233 0.830t01.170
Whole Building 0.492 to 1.508 0.603 to 1.392

Table 6-10: Confidence Intervals for Estimated Net Realized Savings

90% Confidence | 80% Confidence
M easure of Savings Point Estimate Interval Interval
Net Energy Savings
Total Program (GWh) 28.200 13.874 to 42.526 17.005 to 39.254
per Square Foot (KWh/ft?) 2.277 1.120t0 3.434 1.373t03.170
per Building (kWh) 98,948 48,682 t0 149,214 | 59,666 to 137,736
Net Demand Savings
Total Program (MW) 4.977 2.449 to 7.505 3.001 to 6.928
per Square Foot (W/ft?) 0.402 0.198 to 0.606 0.242 to 0.560
per Building (kW) 17.459 8.590 to 26.328 10.528 to 24.303
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Site D Number

1996 Commercial On-Site Survey

for
SDG& E NEwW CONSTRUCTION EVALUATION

7/5/96

Site/Survey | nformation:

Business Name:

Street Address:

City, State:

Zip Code: -

Contact Name:

Contact Title:

Contact Phone #: () . ext.

Survey Tracking I nformation:

Date: Initials

Field Survey: Y S S o
Quality Control Check:
Data Entry:

Survey Received by RER:
Data Received by RER:
SITEPRO Processing:
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Site Connected L oad Check Sheet

End-Use Connected
Description kW

L oads
kBtu/h

Swimming Pool/Spa
Packaged HVAC
Indoor Fans
Cooling Units
Heating Units
Built-up HVAC
Supply Fans
Return Fans
Cooling Units
Heating Units
Heat Rejection
Pumps
Exhaust Fans
Water Heating
Outdoor Lighting
Indoor Lighting
Standard Office Equipment
Non-Standard Office Equip.
Miscellaneous Equipment
Food Service Equipment
Refrigeration
Refrigerators/Freezers
Salf-Contained Commercial
Remote
MotorsEngines
Air Compressor
Process Equipment
Water/Steam Boilers

TOTALS

Billed Demand

Page _ of
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Electric Accounts & Meters

Item # Account Number: Meter Numbers: Part of sample | Add Delete

Yes No to survey
T Y N A D
2 Y N A D
I Y N A D
a Y N A D
5 Y N A D
s Y N A D
7 Y N A D
8 Y N A D
s e Y N A D
10 Y N A D

Do electric account number s match sample account selection for thissite?
If “No” or “Not Verified”, then explain discrepancy in comments section below.

OYes [ONo [ONot Verified

GasAccounts & Meters

Iltem #

Account Number:

Meter Numbers:

Part of sample
No

Add Delete
to survey

5 10 10 I~ e 101 s 1IN e

-<-<-<-<-<-<-<-<-<-<§
z

2 zZ2zZ2zZ2z222z22Z2

A D

>>»>»>>>>>>
O 000000 U0UO0o

Do gas account numbers match sample account selection for thissite?
If “No” or “Not Verified”, then explain discrepancy in comments section below.

OYes [ONo [ONot Verified

Comments

Page _ of
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Site Activity Information

Describe the primary activity of this site:

What are the products/services of this site:

Site Activity Code: _ _ _ (Use activity codes from table below)

Site Activity Codes

Office: Warehouse:

Administration and management 011 Refrigerated Warehouse
Financial / Legal 012 Non-refrigerated Warehouse
Insurance/Real Estate 013 Health Care:

Other Office 014 Hospital

Restaurant: Nursing Home
Fast Food or Self Service 021 Medical Office
Table Service 022 Clinic/Outpatient Care
Bar/Tavern/Nightclub/Other 023 Education:

Food Store: Daycare or Preschool
Supermarket 031 Elementary / Secondary School
Convenience Store 032 College or University
Other Food Store 033 Vocational or Trade School

Retail Store: L odging:

Department / Variety Store 041 Hotel
Shop in Enclosed Mall 042 Motel
Other Retail Store 043 Resort

051
052

061
062
063
064

071
072
073
074

081
082
083

Public Assembly:
Church
Recreational or Other
Services:
Gas Station / Auto Repair
Repair (Non-Auto)
Other Service Shop
Manufacturing:
Assembly / Light Mfg.
Med/Heavy Equip. Mfg.
Food/Beverage Processor
Mining
Misc:
Construction
Agriculture
Apartments
Other: Describe:

091
092

101
102
103

111
112
113
114

121
122
123
130

General Information
How many part-time employees?
How many full-time employees?
I's this space owner-occupied or |eased? 0]
What year was this business established?
What isthe total floor areafor this business?
How many buildings are part of this business?
What year was the magjority of the facility built?

New Construction, Remodel, or Tenant Improvement (T1)

How many sguare feet of floor space were added?

How many sguare feet of floor space were remodeled?

How many sguare feet of floor space were affected by TIs?

Was the space built to suit? Y

Page _ of
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Sketch the floor plan of all the buildings at the Survey Site and identify the Survey Area and the Shared Service Area.
Indicate on the drawing the boundaries of different space usage areas. Include building dimensions and mark the
orientation.

Surveyed areais:
O Single Building
O Multiple Buildings - How many:

O Part of aBuilding - What percent of the total building square footage:
- How many other tenantsin building?

Metering arrangement model number , if no match was found enter N and show meters on above picture.

Describe areaincluded in the survey:

Page _ of
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Shared Utility Services:

O Survey areaisreceiving heating and/or cooling from a central system.
When survey area is receiving heating or cooling from a central system which is not part of survey area complete this
section.  ( “not part of survey area” means - the heating/cooling equipment [ boilers and chillers] are connected to a
different utility service [account & meter] than survey area).

Shared Central Equipment: Unit #1 Unit #2 Unit #3
Equipment Fuel Type: E = Electricity; N =Naturdl Gas, F =Fuel Oil; L =LPG,
Account Item number from page 3
Equipment Type: C = Chiller; B =Boiler, O =Others
Total Capacity

Units for Capacity T =Tons; kB =kBtuh, T kB T kB T kB
Percent of total capacity utilized by survey area

O Survey areaissharing a meter with another business or building.
When survey area is sharing a meter with another building or business complete the table below. This information is
used to calculate energy usage of each shared meter by the survey area.

Shared Meter Information:
Account | Activity [ Floor Area |Percent used by survey Comment
Item# | Code (. Ft.) area

gl [ [W N | |H®
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O Survey areaisalarge campusor Industrial park with multiple buildings.
Perform survey on selected building(s) and compl ete table below for remaining buildings.

Multiple Building Sites - Building I nventory

Item

Activity
Code

Floor Area
Total
Sq. Ft

Heating

Cooling

% of total
Sq. Ft.

Fuel
Type

Equip. Type
Unitary / Central

% of total
Sq. Ft.

Fuel
Type

Equip. Type
Unitary / Central

U

U

© (00 [N | |01 | W (N [k |[HF

=Y
o

[
[

=
N

[inY
w

'—\
a~

[iny
(63}

=
(e}

[
~

=
(o0}

[iny
©

N
o

N
[y

N
N

N
w

N
N

N
(61

N
(e}

N
~

N
oo

N
©

w
o

cicljccfc|c|c|c|c|c|jc|jc|c|jc|jc|c |c |c |c |c |c |c |c |c |c |c|c | c
OO0 010010000010 (00000 (00|00 |0 (00|00 |0 (0|0 |0 (0

clc|jc|c|c|jc|c|c|c|c|jc |c|Cc|c|c|c |c|c |c |c|c |c |c |c |c|c|c |c |c
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RER, Inc.
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Energy Efficiency Improvement Measure

Please identify if the following efficiency improvement measures

have been implemented at the site and the year that the
implementation was performed.

“X" if measure
installed

Year Installed

Lighting:
T-8 or equivaent fluorescent lamps
Electronic ballasts
Hybrid ballasts
Delamping
Optical reflectors
Occupancy Sensors
Timeclocks
Daylighting controls
LED Exit Signs
HVAC:
Economizer
Evaporative pre-cooler
Dehumidifier
Energy management systems
High efficiency HVAC Equipment
VSD/ASD chiller
VSD/ASD pumps
VSD/ASD fans
Conversion to Variable Air Volume system
Conversion to Constant Volume system
Building Envelope:
Window tint or film
Above-code roof insulation
Above-code wall insulation
Miscellaneous:
Improvements to water heating system
Improvements to refrigeration system
High efficiency motors (non-HVAC)
CO sensors

Other/Comments:

Page__

of
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Hot Water Use

Commercial food service: Number of meals served per day: Breakfast
Lunch
Dinner

Number of seatsin the food service area
Disposable Dishes? (circle response)
Number of loads of dishes washed per day?

Number of lavatories with hot water: (exclude Hotels, Hospitals and Restaurants)

Pounds of laundry washed per day? (1b)

Other domestic hot water uses? (Gal/Day)

Lodging:  Number of usable roomsin Hotels/Motels

Average # of rooms occupied

Number of Apartments

Office: Average % of occupied (Non-vacant) space in office buildings

Hospital: ~ Number of beds in hospital

Average % of beds occupied in hospital

School: Average number of enrolled students in schools

Page _ of
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On-Site Power Generation #1 #2
Plant Type: | = Internal Combustion Engine; G = Gas Turbine,
What is the plant capacity? (kW)
Fuel Type: E = Electricity; N = Natural Gas, F =Fuel Qil; O = Other,
Use for generated power: P = Peak Shaving; B = Baseload, O = Other;
What percent of generated electricity is sold back to the utility? % %
Average operating hours per day
Number of operating days per year
Thermal Storage #1 #2
Storagetype C = Chilled Water; | = Ice, O = Others
Thermal storage capacity ( Ton-Hour)
Storage is charged: from...... Use 24 hour (military time) to designate

to......... time period. (eg., 1 pm would be 13)
Storage is discharged: from......

fo.........
Storage provides what % of hottest day peak cooling load

#2 #3

Swimming Pool/Spa #1

Type: S=SwimmingPool; H =Hot Tub, O = Other;

What is the size of the pool (sg. ft.)?

Heater Capacity (kBtu/hr or kW)

Fuel Type: NO = Not Heated, E = Electricity; N = Natura Gas,
L =LPG, S= SOlar5

Pump Size (hp)

Age of the heating equipment?

Location (Outdoors = 99)

Page _ of
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Operation Schedule (define atypical week)

Operation, Occupancy and HVAC

Day Types (up to 3 types) Applicable Days BusinessHours Maximum Occupancy
Sandard Day MTWTFSSH from__ to e
Non-Sandard Day MTWTFSSH from__ to o

Closed MTWTFSSH

Seasonal Operation

Do the operating hours change by season?

Yes No

If yes, list the beginning and ending months (1-12) of the secondary schedule and

complete secondary schedules in Appendix, page 32.

Begin __through End _

*Note: Secondary schedules are used if there is seasonal variation in operation.

Occupancy Schedule

% of Stop/ % of Stop/ % of Stop/ % of Stop/ % of
Day Type Start Max Start Max Start Max Start Max Start Max
Hour Occup Hour Occup Hour Occup Hour Occup Hour Occup
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Cooling Temper ature Schedule
Stop/ Stop/ Stop/ Stop/
Day Type Start Temp Start Temp Start Temp Start Temp Start Temp
Hour °F Hour °F Hour °F Hour °F Hour °F
Std 00
Non-Std 00
Closed 00
Heating Temperature Schedule
Stop/ Stop/ Stop/ Stop/
Day Type Start Temp Start Temp Start Temp Start Temp Start Temp
Hour °F Hour °F Hour °F Hour °F Hour °F
Std 00
Non-Std 00
Closed 00
Page _ of 11
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Equipment Schedules

% of Stop/ % of Stop/ % of Stop/ % of Stop/ % of
Day Start Equip Start Equip Start Equip Start Equip Start Equip
Type Hour On Hour On Hour On Hour On Hour On
Indoor Lighting Schedule
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Outdoor Lighting Schedule
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Office Equipment
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Miscellaneous Equipment Schedule
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Cooking Schedule
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Process Equipment Schedule
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Page _ of 12
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Site Information

Number of Floors Area, ft?

Total Enclosed Floor

Total Roof Area, ft?

Ground Floor Area, ft?

Site Use Assignments  (Identify maximum of six areas )

Item | Area % of Total % % New
# | D# Site Use Type/Description Site Floor Area | Cooled | Heated | Const?
1 Apartments Y N
2 Classroom Y N
3 Clean Room Y N
4 Common Areas Y N
5 Conference Rooms Y N
6 Cooking Y N
7 Dining Y N
8 Health Facility Y N
9 Examination Room Y N
10 Patient Room Y N
11 Laundry Rooms Y N
12 Loading Dock Y N
13 L obby/Reception Area Y N
14 Lodging Y N
15 Manufacturing Y N
16 M echanical/Electrical Room Y N
17 Office Y N
18 Office Common Areas Y N
19 Office Conference Rooms Y N
20 Operating Room, Critical Care Y N
21 Parking Structure (enclosed not open lot) Y N
22 Patio Area Y N
23 Pool/Spa Area Y N
24 Public Assembly Y N
25 Gymnasium Y N
26 Library Y N
27 Retail Y N
28 Stairg/Hallways Y N
29 Vacant Y N
30 Warehouse/Storage (Non-Refrigerated) Y N
31 Warehouse Refrigerated Y N
32 Other #1: (describe) Y N
33 Other #2: (describe) Y N
34 Other #3: (describe) Y N
35 Other #4: (describe) Y N

Total 100% -- -- --

Page__

of

13




SDG& E 1996 Commercial On-Site Survey

Building Specifications

Exterior Wall Types. W1 W2
Wall construction type From Wall Type table
Insulation material type
Insulation R-value
Insulation location C = In cavity; E = Exterior, | = Interiors
Wall Color D =Dark; M =Medium, L =Lights
Interior Wall Types: 1 12
Wall construction type From Wall Type table
Insulation material type
Insulation R-value
Wall Types Wall Types (Cont.) Insulation Types (R/in)
WFF 2 X 4Wood FrameWall, | WC8 8" Solid Concrete Wallg BAT Batt or Blanket; 33
WFM 2 X 4 Metal Frame Wall, WCI10 10" Solid Concrete Wallg LSF Loosefill, 2.7
WSF 2 X 6 Wood FrameWall; | WC12 12" Solid Concrete Wall g XPE Expanded perlite; 2.8
WSM 2 X 6 Metal FrameWall, | WBLO Concrete Block Wally, XPS Expanded polystyrene,  3.8-5.0
WAIR AirWallg WBRI Brick Wally, RDG Rigid boards 2.8-4.0
WC4 4" Solid Concrete Wallg WGLS Glass Curtain Wall 3 OTH1 Otherlg
WC6 6" Solid Concrete Wall, WADB Adiabaticys OTH2  Other2,
Roof/Ceiling Types. R1
Roof construction type RFAT = Framed With Attic;
RMET = Metal Decking,
RFNO = Framed Without Attics
RCON = Concrete Decking,
RADB = Adiabatics
Roof Surface B = Built-up; W =Wood Shingle, M = Metal;
C = Clay/Cement Tile, A = Asphalt Roll/shingles
Roof Finish R = Reflective; F =Flat,
Roof Color D = Dark; M = Medium, L =Lights
Roof Insulation type
Roof Insulation R-value
Suspended Ceiling? Y N
Ceiling Insulation type
Ceiling Insulation R-value
Floor Types. F1
Floor construction type S=9ab; C=Crawl, U = Unheated Basements
O = Open (Garage), A = Adiabatics
Insulation material type
Insulation R-value

Comments

Page _ of
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Building Specifications (Cont’d)
Shading Parameters for Overhangs and Side Fins

Glazina Tvnes:

Gl G2 G3

Layers of glazing

Type of Glazing C=Cleary T =Tinted,
L =LowEs

R = Reflectives

| = Infrared Reflectives

O = Opaques
G = Gas Filledy

Window frame type M = Metal,

w = Wood,

O = Other3

Overhang, ft

Side Fin, ft

Interior Shading F = Fixedinterior; M = Moveableinterior, N = None;

Window Height, ft

Window Width, ft

Wall Assignments and Building Orientation:

Building North ‘

Enter building azimuth:

True North

Building azimuth is the angle
between building north and true
north, measured clockwise from
true north (positive angle).

External Wall Construction

Orientation

Total Wall Area, ft°

Exterior Wall Type W1 %

Exterior Wall Type W2 %

Sum of Exterior Walls

100%

100%

100% 100%

Window G1 %

Window G2 %

Window G3 %

Door D1 - metal insulated

Door D2 - metal, no insulation

Door D3 - wood

Door D4 - glass

Area/Wall Assignments

Area|lD #

% of Total N
Wall Area

% of Total E % of Total S % of Total W
Wall Area Wall Area Wall Area

(Note: ‘%' refersto the percent of Total Wall Area)

Page _ of
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Packaged Units (Useletters A, B, etc.)

Ltr

Ltr

Ltr

Ltr

Distribution System:

Air Distribution system type:
PSzZ = Packaged Single Zone;

PMZ = Packaged Multi Zone,

PUV = Unit Ventilators

PTAC = Packaged Terminal Air Conditioners
PVAV = Packaged Variable Air Volumes

On/Off Control:
M = Manua (On/Off),
N = Night Setbacks W = Weekly Clocks

E=EMS P = Programmable Thermostats

A = Always On,

Thermostat Type: P = Pneumatic;
E = Electric /electronic,
D = Direct digital controlss

Optimum Start (Y/N)

Estimated year of installation

Equipment Manufacturer

M odel Number

Indoor fan (hp/unit)

Supply air rate (CFM)

% Qutside air

Economizer Yesor No?

Return air rate (CFM)

Return fan motor (HP)

Cooling Equipment:

Type: NO =None DX = Direct Expansion;
EC = Evaporative Coolers CH = Chilled Waters

Number of Units

Compressor: Volts
Amps
Phase

kW=(" A" v Phase” 0.85)/1000

Capacity Output ((kBTU/hr)/unit)

Efficiency: EER (or % EC for Evap. Coadl.)

or SEER

VSD Compressor? (Y /N)

Heating Equipment:

Type: FN=Fumnace; EH = Electrical,
HP = Heat Pumps PUH = Unit Heater4  NO = Nones
BB = Built-up Boilers OT = Othery

Fuel: E=Electricityy N=Natura Gas, F = Fud Oils
L =LPG, W = Woods S = Solars

Number of Units

Electrical Input (KW)

Capacity Output (kBTU/hr)

Efficiency: % (Or for HP enter COP)

or HSPF (for HP)

HP only: Supplemental Heating Capacity (kW)

ServesArealD #
Enter ArealD number or A for all areas

Page__
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Built-up HVAC (Use numbers) # #_ # #
Distribution Systems
System Type: OT = Othero

FP = Four-Pipe Fan Coily SZ =Single Zone,

VA = Variable Air Volumes MZ = Multi Zoney

CV = Constant Volume Reheats DD = Dual Ducts

WL = Water Loop Heat Pumpy TP = Two-Pipe Fan Coilg

On/Off Contrals:
M = Manua (On/Off); A = Always On,
N = Night Setbacks W =Weekly Clocksy E=EMSs

Thermostat Type:
P = Pneumatic; E = Electric/electronic, D = Direct digital controlss

Supply Air Temperature Control:
C =Constant; O = Reset OAT, D = Reset Demands

Supply air temperature cooling setpoint (°F)

Supply air temperature heating setpoint (°F)

Supply fan power (hp/unit)

Quantity of supply fans

Supply fan type and control:
IA = inlet guide vanes, air foil fan;
IF = inlet guide vanes, forward curved fan;
DF = discharge damper, FC fanz
VA =vane axia fan w/ variable pitchs
VS = variable speed drives

Supply air rate (CFM/unit)

% Outside Air

Return fan power (hp/unit)

Quantity of return fans

Return fan type and control:
IA = inlet guide vanes, air foil fan;
|IF = inlet guide vanes, forward curved fan;
DF = discharge damper, FC fanz
VA =vane axia fan w/ variable pitchs
VS = variable speed drives

Return air rate (CFM/unit)

Economizer W =Water; A =Air

ServesArealD #

Enter area |D number or A for all areas

Note: For all multi-zone control systems (package and built-up), complete the “HVAC Multi-Zone
Control” table on the following page. Thisappliesto :

Package Systems = PMZ, PVAV
Built Systems= VAV, MZS, DDS

Comments
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HVAC Multi-Zone Control System # or Ltr

Are perimeter/interior controls the same?
(If yes, only complete Perimeter Zone Controls section.)

Perimeter Zone Controls

Terminal type
CO = cooaling-only, VAV
RH = reheat,
PF = parallel fan-powereds
SF = series fan-powereds
| = induction (non-powered)s
DD = dual duct or multizone damperss

Reheat Source:
NA = none;
E = Electric,
HW = Hot waters

Supplemental Heat Source:
NA = none;
EB = Electric baseboard;
HB = Hot water baseboards

Terminal minimum volume (% of peak)

Interior Zone Controls

Terminal type:
Use same codes listed above

Reheat Source:
Use same codes listed above

Terminal minimum volume (% of peak)

Built-up Heating Equipment

Equipment Type:
F = Furnace;
STMB = Steam Boiler; BASE = Baseboard Heatings
HHP = Hydronic Heat Pump, HWB = Hot Water Boilers
OT1 = Otherg

Fud Type:
E = Electricitys N = Natural Gas, F=Fue Oil; L =LPGy
W = W00d5

Equipment manufacturer

Model number

Estimated year of installation

Number of Units

Backup or Second Fuel Type

Output (Capacity kBtu/hr/unit)

Efficiency: (% or COPfor HHP)

(HSPF for HHP)

Backup

Serving Distribution Systems #

Page__
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Built-up Cooling Equipment 1
Equipment Type:
CENT = Centrifugal; RECP = Reciprocating,
SABS = Absorption steams SCRW = Screw Compressors
HHP = Hydronic Heat Pumps
GABS = Absorption, direct fired gass
EC = Evaporétive Cooler; OT1 = Otherg
Fuel Type: E=Elect; N=Natura Gas, F =Fuel Qils
L =LPGs CH = Chilled Waters
Number of Units
Compressor: Volts
Amps
Phase
kW=(V" A" v Phase” 0.85)/1000
Equipment Manufacturer
Model number
Estimated year of installation
Capacity tons/unit)
Efficiency: kW/ton or EER for HHP)
or COP
VSD Compressor ? Y N
Serving Distribution Systems #
Circulation Pumps Built-up) #__
Use Type: CW = Chilled Water; HW = Hot Water,
CHW = Chilled/Hot Waters
CN = Condensers
Number of units
Pump power (hp)
Motor Type: O=0OneSpeed; T =Two Speed; V =Variables
Backup equipment? Y N
Serves heating equipment #
Serves cooling equipment #
Heat Rej ection Built-up) #__
Type:  AC = Air Condenser; EC = Evaporative Condenser,
ACP = Air Cond w/pre-coolers  CT = Cooling Towers
Number of units
Fan power  (hp)
Fan Control: O=0OneSpeed; T =TwoSpeed, V =Variables
Serves cooling equipment#
Backup Equipment? Y N

Exhaust Fans #

Number of units

Fan power (HP/unit)

Fan capacity ( CFM / unit)

ServesArealD #

Water Heating Equipment
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W:WOOds S= Solars

Fuel Type: E=Electricity; N=Natura Gas, F = Fuel Oil3

L =LPGs
H = Heat Recovery; O = Other8

Water Heating Equipment Type:
IWH = Individual Water Heater,

PS = Purchased Steam Heat Exchangers
PHW = Purchased Hot Waters

SHB = Space Heating Boiler;

| =Instantaneous (Tankless),
HP = Heat Pump Water Heaters
PB = Process Boilers

B = Boiler Water Heating Onlys

If water is heated by a Process boiler - Enter Boiler #

If water is heated by a Space Heating Boiler - Enter Boiler #

Number of units

Heating Capacity (kBtu/hr or KW)

Tank Capacity (Gallons)

I's the hot water tank insul ated?

Are hot water pipes insulated?

Recirculation pump power (hp) - Enter zero for no pump

Average hot water temperature (F)

Age of equipment?

Outdoor Lighting

Use Type: F = Facade,
S = Securitys
P = Parkings

L = Landscape,

X= EXits

D = Advertisings

Control Type
O = On/Off-Switchy
PC = Photo Cédlls

TC = Timeclockz
EM S = Energy-Mangt-System,

Lamp Type:
F = Fluorescent Tubey
UT = FHuorescent U-tube;,
CF = Compact Fluoresents
OF = Other Flourescenty
| = Incandescents
N = Neong
EL = LED;
MV = Mercury Vaporg
MH = Metal Halidey

H = High Pressure Sodium Vaporio
L = Low Pressure Sodium Vapori;

For Fluorescent Tubes: Tube 22 4 6

Dia T8 T9 T10 T12

g

Watts per Lamp

Number of Lamps per Fixture

Ballast Type: S= Standard;
H = High Efficiency,

E = Electronics

Number of Ballasts per Fixture

Hours per Week

Total Number of Fixtures

Field Notes: (Counts)

Comments
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Lighting

Indoor Lighting 1 2 3 4 5 6 7

Use Type:
A=Area; T=Task, D=Advertisings X=Exits

Mounting: CR):gteﬁewSmS:Suspmdedz RSO|RsSsO|RSO|RSO|RsSO|RSO|RSO
= er3

Reflector Yes or No Y N Y N Y N Y N Y N Y N Y N

Vented to return air? Yes or No Y N Y N Y N Y N Y N Y N Y N

Control Type:
O = On/Off-Switchy
TC = Time-Clockz
DM = Dimmers
OS = Occupancy-Sensora
DL = Daylighting controlss
EM S = Energy-Management-Systems

Lamp Type
F = Fluorescent Tube;
UT = Fluorescent U-tube,
CF = Compact Fluoresents
OF = Other Flourescents
| = Incandescents
N = Neong
EL = LEDy
MV = Mercury Vaporg
MH = Metal Halidey
H = High Pressure Sodium Vaporio
L = Low Pressure Sodium Vaporiy

For Fluorescent Tubes; Tube 2° 4 6 8

Dia T8 T9 T10 T12

Watts per Lamp
Number of Lamps per Fixture
Ballast Type: S= Standard; s s s s s S S

H = High Efficiency,
E = Electronics

Number of Ballasts per Fixture

Hours per Week

Total Number of Fixtures

ArealD #

Field Notes: (Counts)
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Office Equipment

Item [ EQuipment Equipment Avg hrs Total # Area
# ID Name kW per week of units ID
1 OF1 PC wi/color monitor, 140
2 OF2 PC w/monochrome monitor, 115
3 OF3 Laptop Computers 40
4 OF4 Monitor - color (MF terminal) 4 60
5 OF5 Monitor - mono (MF terminal) 5 30
6
7
8 OF6  |Printer - Ink Jetg 85
9 OF7 Printer - Laser, 140
10 OF8  |Printer - Dot matrixg 30
11
12
13 OF9  [Typewriter, 120
14 OF10  [FAX machineso 90
15 OF11 Point-of-sale terminals;, 100
16 OF12  |Cash Registers;, 100
17 OF16 |Adding Machineis 10
18 OF17  |Answering Machiney, 15
19 OF18  [Hole Punch;s 600
20 OF19 [Shreddersq 600
21
22
23
24 OF13  [Small Copiery; 850
25 OF14  |Medium Copierig 1425
26 OF15 |Large Copierg 2400
27
28 OF50  |Computer - Mainframe,q
29 OF51 Printer - Mainframe,,

30 OF52 Workstation,,
31 OF53 [Telephone System,s
32 OF54  [Blueprint Machine,,
33 OT55 |Other (describe) 55
34 0OT56
35 OT57
36 0OT58
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Miscellaneous Equipment

Item| Equip Equipment Fuel I(/V% Avghrs | Total # of Area
ID Description Type Btuh per week units ID

OlO|N|O|O|B|W|IN|F|H

[En
o

[N
[N

[EnY
N

Ay
w

[y
n

Ay
a1

[En
(e2}

Ay
~

[
(o9}

Ay
©

N
o

Note: [For site connected load check sheet] Use 0.3kW for equipment with unknown capacities

ID | Building Equipment ID | Electronics ID | Shop

B1 [ Air Hand Dryers; E1 | Broadcasting Equipment,s S1 | Electric Craness

B2 | Alarm System, E2 | Radio (plug-in) 26 S2 | Electric Transportss

B3 | Automatic Doors E3 | Stereo Systemyy S3 | Electric Vehiclesass

B4 | Battery Chargers E4 | Televisionys S4 | Forklifts7

B5 | Clock \ Wall Clocks E5 | Video Recorder (VCR) 29 S5 | Forklift Chargerass

B6 | Janitorial EQuipments S6 | Hand Truckag

B7 | Vacuum Cleaner; S7 | Portable Shop Toolssg

B9 | Video Camera (security)s Service/Retail S8 | Shop Equipments;

B8 | Water Coolers (Drinking) o R1 | ATM Machinesp S9 | Soldering Gun or Irons,

R2 | Change Machines; S10| Welderss
Medical/Hospital R3 | Conveyor (check-out) 3»

M1 | Autoclaveig R4 | Film Processingss Laundry

M2 | Bathii R5 [ Photo Equipmentss L1 | Clothes Dryer, Ressa

M3 | Cat Scani; R6 | Pinball or Video Gamess L2 | Clothes Washer, Resss

M4 | Centrifugeis R7 | Vending Machine L3 [ Comm Dryersg
(Refrigerated) 3¢

M5 | Chromatograph, analyzeri4 R8 | Hair Dryerssy L4 | Comm Washers;

M6 [ Cytometer, blood analyzeris R9 | Exercise Equipmentsg L5 [ Dry Cleaning Unitsg

M7 | Dentist Chairig R10 [ Gas Pumpsg L6 | Sewing Machinesg

M8 | EKG Machineyy R11| Industrial Compactorag

M9 | Hot Plate;s R12| Vending Machine Space Comfort
(Non-Refrigerated) 41

M10| Incubatorig R13| Purified Water Vending C1 | Air Cleanergo
Machines,

M11| Laboratory Incubatoryo C2 | Ceiling or Portable Fang:

M12| Laboratory Oveny; C3 | Dehumidifiers;

M13| Laboratory, other equip. 22 Other C4 | Humidifierss

M14]| Sterilizerss OT | Specify Under Equip. Namess C5 | Portable Heatergs

M15 X—Ray24
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Cooking / Food Service Equipment: ArealD #
Item | Code Equipment Name Fuel kW Avg hrs Total # of
kBtuh per Week Units

1
2 OV |Oven;
3 ST |Stove,
4 GR |Griddle;
5
6
7
8 CB |Charbroilers
9 FR |Fryers
10 IB [Infrared Broilers
11 SM |Steamer;
12 FW |Food Warmersg
13 SP  |Soup Potsg
14
15
16
17 CM |Coffee Makerip
18 MW  |Microwavei1
19 FB |Flash Bake Oveni»
20
21
22 DW [Dishwashers
23 GD [Garbage Disposalis
24 TS |Toasteris
25 TC |Trash Compacteris
26 IC |lce Cream Dispenseri;
27 SD |Drink Dispenser (Refrigerated)is
28 OT |Other (describe)ig
29
30
31

Refrigerator/Freezers

Item [Code Equipment Name kW Total # of

Units

1 1D |Single-doory
2 2D |Two-door;
3 3D |Three-doors
4 OT |[Other (describe)a
5 UC |Under counters
6 CH [Chests
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Self-Contained Commer cial Refrigeration Equipment

Item Equip Length | #of Glass | Amps@ | *Amps @ Total # Area
Code feet Doors 120V 208V of units ID #

F*

O[N] |0 |WIN |-

=
o

[EE
[N

=
N

[iny
w

=
N

15

*Note: Amps listed should not include defrost heater amperage.

Self-Contained Refrigeration Equipment Codes

Typical Equip
Store Type Code Description
Super market: GD, Glass door beverage cases (e.g. vendor supplied) from 2 to 4 doors.
ou, Open upright display cases (pizza, juice, etc.) usually in 4,5,6 ft increments
ICs Island cases (cheese, sometines produce or juice), from 8 to 16 ft long.

SC, Service cases (bakery, sometimes deli) from 4 to 8 ft.

CDs Closed door storage cases (bakery), one to three doors.

Convenience UGe Upright glass door cooler cases and freezer cases, from 1 to 3 doors

Stores: CF; Coffin type glass top freezer cases (usually ice cream), typicaly 6 or 8 ft.
IMg I ce vending machines and storage boxes.

All Types: OT, Other: self-contained refrigeration not listed above.

Comments
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Remote Refrigeration Equipment

Display Cases

Ice Cream &
Frozen Juices

Frozen
Food, Meat, &
Bakery Cases

Fresh Meat &
Upright Open Deli-
Meat Cases

Dairy, Produce,
Beverage, & Glass
Front Cases

Case Temperatures, °F

-35

-25

+10

+20

Single-deck cases
Length, linea ft.

Multi-deck cases
Length, lineal ft.

Double-Wide Island type cases
Length, linea ft.

Glass door type cases
# of doors

All casetypes. Defrog control type
E =Electricc G=HotGas, T =Timed-offs
N = Noney

Walk-Insand Preparation Areas

Freezers (0to-10 °F)

Coolers (30to 40 °F)

Prep Areas (50-55 °F)

Floor Area, ft?

Defrost control type:
E = Electric; G =HotGas, T =Timed-offs
N = Noney

Strip curtains? Y N N Y N
Compr essors -35t0-25 +10to +20 Prep Areas
System type:

C =Conventional; T =Twins (2 equal size),

M = Multiplexs O = Other,
Number of units
Manufacturer code:

S=Copeland Std.;, D = Copeland Discus,

C = Calyles O = Othery
Total horsepower
Variable speed compressors? Y N N Y N
Heat recovery type:

N = Noney SH = Space heating,

WH = Water heatings R = Reheats

O= Othefs
Subcooling Y N N Y N
Floating Head Pressure Control ? Y N N Y N

# #

Condenser type:
AC = Air-cooled;
ACP = Air-cooled w/ precooler,
EC = Evaporétive cooleds
WC = Water-cooled,

Total fan horsepower (all types)

Pump motor hp (evap / liquid cooled only)
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Motor Engines

# of
Units

Size
(hp)

Drive
Type

M otor
Service

High

Efficiency

L oad
Type

>
3

Average

Age Type

Control

Area
1D #

Avg hrs
per week

Y N

<
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Motor Equipment Codes

Motor Service:

Drive Type:

Load Type:

Control Type:

: Pump, S Separationy

. Fan, V: Vertica Transportg
: Blowers
: Material Handling,

: Machine Toolg

® 4 2 m m T

: Grinding/millinge

AC,
DCS : DCw/ SCR,

DCM : DCw/ MGS;
EG : Nat gasdriven,

FG : Fossil driveng

C : Constant;
V : Vaiable,

| Intermittents

S :
. Throttled,

: Mechanical VSD;
. Electronic VSD,
: Constant Volumes

o mxz -

On/Off Switch,
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Air Compressors

Item Comp Contrl Appl Drive # of Size HiEff ASD? Avg I—?c?uerrs Area
# Type Type Type Type Units (Hp) | Motor? Age per/Wk 1D #
1 Y N[Y N
2 Y N[Y N
3 Y N[Y N
4 Y N[Y N
5 Y N[Y N
6 Y N[Y N
7 Y N[Y N
8 Y N[Y N
9 Y N[Y N
10 Y N[Y N
11 Y N[Y N
12 Y N[Y N
13 Y N[Y N
14 Y N[Y N
15 Y N[Y N
16 Y N[Y N
17 Y N[Y N
18 Y N[Y N
19 Y N[Y N
20 Y N[Y N
Air Compressor Codes
Application
Compressor Type Control Type Types Drive Type
RTD: Reciprocating (Two-state, Double-acting), S-Start/Stop; C-Cleaning; E-Energy Efficient AC,
RST: Reciprocating (Single-stage, Double-acting), L -Load/Unload, T-Drivestools, S-Standard Efficient AC,
RTS: Reciprocating (Two-stage, Single-acting)s M -Multi-steps O-Others D-DC;
RSS: Reciprocating (Single-stage, Single-acting), V-V SD Throttling, G-Engine,
ST: Rotary Screw (Two-stage)s P-Turn/Poppet Valvess T-Steam Turbines
C: Centrifugalg T-Throttlings O-Otherg
O: Other; O-Other;
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Process Equipment:

Fuel Typel | Fud Type2
Average % of % of |Avghrs

Egp| Proc Product Produced Boiler | #of | Capacity Annual Annual per Area
No. | Type # units | kBtu/h | Type Btu Type Btu week 1D #

1 % %

2 % %

3 % %

4 % %

5 % %

6 % %

7 % %

8 % %

9 % %

10 % %

Process Boilers

For the water/steam boilers used at this facility, identify the type and number of boilers, the per unit capacity of
the boilers, the units that the capacity is recorded in, the primary fuel used, and the percentage of the
water/steam that is used for: process, domestic hot water, and space heating.

Boiler #1

Boiler #2

Boiler #3

Boiler #4

Boiler #5

Boiler Type:
W - Hot water; S- Steam,

Efficiency (%)

Quantity

Capacity

Units (kW / kBtu)

Primary Fud Type:

E = Electricitys N = Naturd Gas,
L =LPGs C = Coal/Cokes
D = Diesely G = Gasolineg

F = Fuel Oils
W = Waste Oilg
o= O‘[ha’gi

Secondary Fuel Type

% of Boiler Output to Each

End Use:

Note: If % total not = 100%,
explain why in comments.

Process

Space Hesating

Service Hot Water

Area|D # (Enter 99 if Outside Any Area)

Comments
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Process Equipment Codes

Heat Processing: Pulping: Drying/Curing/Baking:
Direct Fired GasHeating ~ DFGH; Batch Digesters DIGST33 Ovens OVENDCBg3
Direct Fired Oil Heating DFOH; Stock Refiners STKREFz1 Microwave MICRODCBg4
Blanchers BLNCH3 Paper Preparation: Infrared IRes
Microwave MICROHP,;  |Pulpers PULP35 Electric Resistance ELRESss
Sterilizers STERs Refiners REFNR3s Steam from Process Boiler STMe7
Pasteurizers PASTg Stock Mixers STKMXR37 Ultraviolet UVes
Induction Heating INDCTHTG; |Separation and Distillation: Kiln KILNeg
Induction Melting INDCTMLTg |Thermal Distillation Column THRMDCg |Radio Frequency RFDCB7o
Radio Frequency RFHPy Freeze Concentration FRZCON39 Electron Beam EBDCB71
Indirect Resistance INDIRES;o Vacuum Condensation VACCON4 |Refrigeration/Freezing:
Direct Resistance DIRRES;1 Membrane Separation MEMSEPs;  |Forced Air Cooling FORAIR7,
Encased Resistance ENCRES;» Pressure Swing Absorption PSA Blast Freezing BLSTFRZ73
Plasma Processing PLSMHPy3 Vacuum Concentration VACCNTR43 |Hydrocooling HYDRCL74
Electric Arc Furnace ELARCFRN14 |UltraFiltration ULTRAFLT4, |Belt Freezing BLTFRZ7s
lon Nitriding IONNIT;5 Reverse Osmosis REVOSss Plate Freezing PLTFRZ7
Laser Hardening LASER16 Evaporators EVAPs Vacuum Cooling VACCL7#;
Cupola CUPOLA17 Solid-Liquid Extraction: Immersion Freezing IMMFRZ7g
Dehydration: Single Stage Extractors SSEX T4z Mixing and Emulsification:
Convection Dryer CONVDR1g [Multi-Stage, Static Bed Extractors MLTEXTas Pressure Homogenizers PRSHOM 79
Infrared Dryer IRDR19 Continuous Moving-Bed CONBED4g Ultrasonic Emulsificatino Devices ULTRAEMDg
Extractors
Electric Resistance Drying ELRESDHz, |Plastic Molding: Fiber Preparation:
Microwave Dryer MICRODHz; |Injection Molding INJMLDso Dye Tanks DYEgs
Material Preparation: Extrusion Molding EXTMLDs;  |Crystallization:
Arc Welding ARCWLD,, |Blow Molding BLWMLDs, |[Qil Winterization OILWNTRs;
Laser Cutting LASERCT,; |Rotational Molding ROTMLDs;  |Freeze Concentration FRZCONCsgs
Water Jet Cutting WTRJIET 24 Compression Molding COMPMLDs4 |IceCrystalization ICECRY Sgs
Electron Beam Welding EBWMP,5 Thermoforming THRMFRMss |Lactose Crystallization LACCRY Sgs
Laser Welding LASERWL D26 | Process Cooling: Fat Crystallization FATCRY Sgs
Plasma Cutting PLSMMP,7 Reciprocating Chillers RECIPsg Screening and Separ ation:
Filtration: Centrifugal Chillers CENTs; Froth Floatation Baths FRTHg7
Pressure Filters PRESFLT2s |Direct Expansion Compressors ~ DXCOMPsg  |Exploration and Drilling:
Vacuum Filters VACFLTRyy |Washing and Drying: Engine Driven Boring Equipment ENGBORgs
Finishing: Rotary Kilns ROTKLNsg Pumping:
Ovens OVENF3o Cascade Dryer CASCDRgo Engine Driven Pumps ENGPM Pgg
Electroplating ELPLTa1 Fluidized Bed Dryer FBDs1 Compressing:
Hot Dip Galvanizing HDGs, Suspension Dryer SUSPDRe; Combustion Turbine Compressor ~ COMTURg
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On-Site Survey Notes & Comments
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Operation, Occupancy and HVAC
Secondary Schedules

Operation Schedule (define atypical week)

Day Types (up to 3 types) Applicable Days BusinessHours
Sandard Day MTWTFSSH from_ to
Non-Sandard Day MTWTFSSH from_ to
Closed MTWTFSSH

Occupancy Schedule

Maximum number of occupantsinonehour? | (Max Occup)
% of Stop/ % of Stop/ % of Stop/ % of Stop/ % of
Day Start Max Start Max Start Max Start Max Start Max
Type Hour | Occup | Hour | Occup | Hour | Occup | Hour | Occup | Hour | Occup
Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
Cooling Temperature Schedule
Stop/ Stop/ Stop/ Stop/
Day Start Temp Start Temp Start Temp Start Temp Start Temp
Type Hour °F Hour °F Hour °F Hour °F Hour °F
Std 00
Non-Std 00
Closed 00
Heating Temperature Schedule
Stop/ Stop/ Stop/ Stop/
Day Start Temp Start Temp Start Temp Start Temp Start Temp
Type Hour °F Hour °F Hour °F Hour °F Hour °F
Std 00
Non-Std 00
Closed 00
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Equipment Secondary Schedules
Complete these schedules if thereis seasonal variation in equipment usage.

% of | Stop/ | % of | Stop/ | Y of | Stop/ | % of | Stop/ | % of
Day Start | Equip | Start | Equip | Start | Equip | Start | Equip | Start | Equip
Type Hour On Hour On Hour On Hour On Hour On

Indoor Lighting Schedule

Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %

Outdoor Lighting Schedule

Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %

Office Equipment

Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %

Miscellaneous Equipment Schedule

Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %

Cooking Schedule

Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %

Process Equipment Schedule

Std 00 % % % % %
Non-Std 00 % % % % %
Closed 00 % % % % %
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SAVINGS THROUGH DESIGN PROGRAM

PARTICIPANT DECISION-MAKER SURVEY

San Diego Gas & Electric Company 1996

8/28/96
Survey ID Number
Site Number (RP#) OR [ Covers multiple sites/corporate Decision Maker
Contact Person
Title
Address O Check if same as on Contact Sheet (ask for confirmation)
(City, State, Zip Code)
Telephone Number

Date of Interview

Disposition of Call




Hello, my nameis . I’'m calling on behalf of San Diego Gas & Electric
Company.

May | please speak to ? (Decision Maker. The decision-maker was
identified in the on-site recruiting process or through inspection of participant records)

Interviewer: If Decision Maker is not available, schedule a callback.

Callback: (Date)
(Time)

If Decision Maker is available:

Hello, my nameis . I’'m calling on behalf of San Diego Gas & Electric
Company. SDG&E isinterested in working with commercial building owners and
developers to improve the energy efficiency of new buildings and renovations. Because you
participated in SDG& E’s Savings Through Design Program, we are very interested in
receiving feedback about the program from you. We recently conducted an on-site survey of
your (name of project) project at (address), which
participated in the program, and would like to follow up on that survey by asking you a few
guestions relating to energy efficiency.

The questions | will be asking you relate to the decisions that were made to participate in the
Savings Through Design Program and to purchase and install the energy efficient equipment.
Are you the best person to talk to?

O Yes. Continue

O No. Isthere someone else we can contact? (Read)
Name
Position
Phone #

Thank you very much for your time. (Read)

This survey will take about five to ten minutes. |s now agood time?
O Yes. Continue
O No.Reschedule




How many new construction and renovation projects have you been involved with in
the past three years?

Number of Projects. | |
Total Square Footage:| |

Was the (name of project) project:

OoOooOooOoao

To be fully occupied by the site owner (owner-occupied)

To be leased by the owner (own, do not occupy)

To be partially occupied by owner and partially leased (partially owner occupied)
Built for resale (Spec. built)

Other (please explain)

Please rank the following factors according to their importance in affecting your plans
for constructing new buildings or renovating existing buildings. (1 indicates the most
important, etc.)

OoOooOooOoao

First cost or construction cost

Energy efficiency

Tenant comfort

Design/attractiveness

Other (please specify )

Which financial methods do you typically use to evaluate energy efficiency
improvements for your projects? (If more than one answer is given, rank the answers
based on order, e.g., “ 1" for highest priority.)

OooooOooao

Simple payback (Go to Question 4a)

Internal rate of return (Go to Question 4b)

Life cycle cost (Go to Question 4c)

First cost (Go to Question 5)

Other (please explain) (Go to Question 5)
Don't know (Go to Question 5)




What payback period in years do you normally require in order to consider an energy
investment cost effective? years (Go to Question 5)

What rate of return do you normally require in order to consider an energy investment
cost effective? % (Go to Question 5)

What discount rate do you use in determining the life-cycle cost of various equipment
options? % (Go to Question 5)

Areyou familiar with the Title 24 energy efficiency standards and their requirements?

O Yes Goto Question6
O No GotoQuestion8
If No, who is the person responsible for making sure your project meets these
requirements?
Contact: Phone #:
Title:

Would you say the newly constructed or renovated commercial buildings you’' ve been
involved with in the past three years...

O Areusually designed and built to just meet the Title 24 energy efficiency
standards

O Aresometimes designed to achieve greater energy efficiency than Title 24

O Areusually designed to achieve greater energy efficiency than Title 24

O Don't know

There are two methods for complying with Title 24 standards: the Prescriptive
method and the Performance method. What percent of your projects have used the
Performance method for complying with Title 24 standards? (write answer below)

O % of projects that used Performance method
O Doesn’'t know and can’t estimate the %
O Unfamiliar with the Prescriptive/Performance terminol ogy

How did you learn of SDG&E’s Savings Through Design Program?

Approached directly by SDG& E
SDG& E information brochure
Other owners or developers
Design team

Title 24 consultant
Other (please explain)

OooooOooao




Which of the following was the most important in influencing you to install energy
efficient equipment in your building?

O Program rebate
O SDG&FE's advice/recommendations
O Past experience with energy efficient equipment
O Information from non-SDG& E source. Who?
O Equipment literature or advertisements
O Designer
O Vendor
O Other:

10. Our records show that you received rebates for (READ those that are relevant)

10a

10b.

Energy efficient lighting equipment

High efficiency cooling equipment

Energy efficient motors and drives

Other (Specify )

(For participants who received rebates for efficient lighting) If SDG& E’ s rebate had
not been available for the efficient lighting you installed, how likely isit that you
would have installed lighting equipment more efficient than required to satisfy Title
24?

Definitely would have installed
Probably would have installed
Probably would not have installed
Definitely would not have installed
Don’'t know

ooooao

(For participants who received rebates for high efficiency air conditioning
equipment) If SDG& E’s rebate had not been available for the high-efficiency cooling
equipment you installed, how likely isit that you would have installed cooling
equipment more efficient than required to satisfy code?

Definitely would have installed
Probably would have installed
Probably would not have installed
Definitely would not have installed
Don’'t know

OoOooOooao




10c.

10d.

11.

(For participants who received rebates for high efficiency motors/drives) If SDG&E’s
rebate had not been available for the high-efficiency motors or drives you installed,
how likely isit that you would have installed efficient motors or drives)

OoOooOooOoao

Definitely would have installed
Probably would have installed
Probably would not have installed
Definitely would not have installed
Don’'t know

(For participants who received rebates for other equipment) If SDG& E’ s rebates had
not been available for the (other equipment specified in Question 10.) you installed,
how likely isit that you would have installed this equipment?

O
O
O
O
O

Definitely would haveinstalled
Probably would have installed
Probably would not have installed
Definitely would not have installed
Don’'t know

Do you have any other comments that you' d like me to relay to SDG& E about energy
efficiency in new commercial buildings or about their programs?

Thanksfor your help! Your ideaswill be used to improve
SDG& E programsfor new commercial buildings.




Nonparticipants




SAVINGS THROUGH DESIGN PROGRAM

NONPARTICIPANT DECISION-MAKER SURVEY

San Diego Gas & Electric Company 1996

8/28/96
Survey ID Number
Site Number (RN#) OR [ Covers multiple sites/corporate Decision Maker
Contact Person
Title
Address O Check if same as on Contact Sheet (ask for confirmation)
(City, State, Zip Code)
Telephone Number

Date of Interview

Disposition of Call




Hello, my nameis . I'm calling on behalf of San Diego Gas & Electric
Company.

May | please speak to ? (Contact person. This person should be the
decision maker for the project. This should be the owner of the building, the business owner,
etc. The contact person should be able to answer gquestions concerning the physical features
of the building and the decisions that went into installing equipment into the building.)

Interviewer: If contact person is not available, schedule a callback.

Callback: (Date)
(Time)

If contact person is available:

Hello, my nameis . I’'m calling on behalf of San Diego Gas & Electric
Company. SDG&E isinterested in working with commercial building owners and
developers to improve the energy efficiency of new buildings and renovation projects. We
recently conducted an on-site survey of your (name of project) project at
(address), and would like to follow up on that survey by asking you afew
guestions relating to energy efficiency. Areyou the best person to talk to?

O Yes. Continue

O No. Isthere someone else we can contact? (Read)
Name
Position
Phone #

Thank you very much for your time. (Read)

This survey will take about 5 to 10 minutes. Is now a good time?
O Yes Continue
O No.Reschedule

1. How many new construction and renovation projects have you been involved with in
the past three years?

Number of Buildings:! | | !
1
—1

Total Square Footage: | _ T




4a.

4b.

4c.

Was the (name of project) project:

O To befully occupied by owner (owner-occupied)

O To beleased by owner (own, do not occupy)

O To be partially occupied by owner/partialy leased (partially owner occupied)
O Built for resale (Spec. built)

O Other (please explain)

Please rank the following factors according to their importance in affecting your plans
for constructing new buildings or renovating existing buildings. (1 indicates the most
important, etc.)

O First cost or construction cost

O Energy efficiency

O Tenant comfort

O Design/attractiveness

O Other (please specify )

Which financial methods do you typically use to evaluate energy efficiency
improvements for your projects?

Simple payback (Go to Question 4a)

Internal rate of return (Go to Question 4b)

Life cycle cost (Go to Question 4c)

First Cost (Go to Question 5)

Other (please explain) (Go to Question 5)
Don’'t know (Go to Question 5)

OoOo0o0ooOooag

What payback period in years do you normally require in order to consider an energy
investment cost effective? years (Go to Question 5)

What rate of return do you normally require in order to consider an energy investment
cost effective? % (Go to Question 5)

What discount rate do you use in determining the life-cycle cost of various equipment
options? % (Go to Question 5)




10.

Areyou familiar with the Title 24 energy efficiency standards and their requirements?

O Yes Goto Question6
O No GotoQuestion 8
If No, who is the person responsible for making sure your project meets these
requirements?
Contact: Phone #:
Title:

Would you say the newly constructed or renovated commercial buildings you’' ve been
involved with in the past three years...

O Areusually designed and built to just meet the Title 24 energy efficiency
standards

O Aresometimes designed to achieve greater energy efficiency than Title 24

O Areusually designed to achieve greater energy efficiency than Title 24

O Don't know

There are two methods for complying with Title 24 standards: the Prescriptive
method and the Performance method. What percent of your projects have used the
Performance method for complying with Title 24 standards? (write answer below)

O % of projects that used Performance method
O Doesn’'t know and can’t estimate the %
O Unfamiliar with the Prescriptive/Performance terminology

Areyou familiar with the New Construction Program that SDG& E has been offering
over the past two years? This program offersincentives for the installation of energy
efficiency measures beyond the requirements of Title 24.

O Yes Go to Question 9
O No Go to Question 13

Have you participated in SDG& E’'s Commercia New Construction Program at any of
the sites with which you’ ve been involved over the past three years?

O Yes Go to Question 10
O No Go to Question 11

To what extent did you participate?

O Completed the program and received an incentive check

O Entered the program but decided not to participate

O Applied for the program but was directed to another program
Name of program




O Applied for the program but was rejected




11.

12.

How did you learn of SDG& E's Commercial New Construction Program?

Approached directly by SDG& E
SDG& E information brochure
Other owners or developers
Design team

Title 24 consultant
Other (please explain)

OooooOooao

How would you rate SDG& E’ s requirements to qualify a project for the Title 24 Plus
incentive program?

O Vey easy
O Somewhat easy

O Somewhat difficult
O Very difficult




13. How much would the availability of rebate payments from SDG& E affect the
selection of energy-using equipment for your new construction and renovation
projects?

For lighting equipment:

O Significantly
O Somewhat
O Vey little
O Not at all

For air conditioning equipment:

O Significantly
O Somewhat
O Vey little
O Not at all

For motors and drives:

O Significantly
O Somewhat
O Vey little
O Not at all

For other equipment

O Significantly
O Somewhat
O Vey little
O Not at all




14. Do you have any other comments that you'd like me to relay to SDG& E about energy
efficiency in new commercial buildings or about their programs?

Thanksfor your help! Your ideaswill be used to improve
SDG& E programsfor new commercial buildings.
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Introduction and Overview

1.1 Introduction

SitePro isatool for developing energy load shapes for residential or commercial customers.
Within SitePro, there are three modules: () the Residential Simulation Module, (b) the
Commercial Simulation Module, and (c) the BillShaper module. The two simulation
modules are represented in Figure 1-1. The main components illustrated for these modules
are asfollows.

m Prototype Library. The SitePro system includes libraries that contain
characteristics data for prototypical residential and commercial customers. These
prototypes have been carefully developed to reflect specific building types,
vintages, heating and cooling equipment, and energy-use patterns for each
geographic areathat is represented. Users select a prototype from the library as a
starting point for their analysis.

m  Customer Characteristics. Users may modify selected prototype
characteristics, including operating schedul es, demographics, equipment types,
appliance saturation levels, building size, and shell characteristics.

m  Weather Data. SitePro comeswith alibrary of TMY (typical meteorological
year which isaproxy for “normal” weather) weather files for the major weather
stations across the U.S. The weather library has been supplemented with actual
weather data for specific years and RER'’ s proprietary normal weather data.

s Energy Simulation. A full energy smulation is conducted for heating, cooling,
and ventilation (HVAC) using DOE2. Non-HVAC uses are simulated using end-
use specific algorithms. Separate calculation logic is utilized for the residential
appliances and commercial equipment.

m  SitePro Project. Based on datafrom the prototype databases, Users can create
project databases. Each project database contains alist of sites, the site
characteristics, as modified by the user, and the ssmulation results.

m  Reports. Load shape results may be exported to a variety of formats, including
Microsoft Access databases, Excel spreadsheets, and LDA/LDZ formats.
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Figure 1-1: SitePro Residential and Commercial Modules
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The BillShaper Module combines billing determinant data for individual sites or campuses
with load shapes from the prototype libraries to create 8,760 profiles that are consistent with
both sets of information. It can be thought of as away to calibrate shapesto bills or as away
to turn billing data into load shapes. As shown in the following Figure 1-2, the main
components of the module are as follows:

m  Prototype Libraries. Inthe BillShaper module, the prototype libraries serve as
asource of initial load shape estimates. Each site in a BillShaper project must be
assigned a shape from one of the libraries.

m  Groupings and Group Weights. Individual sitesin aBillShaper project can
be assigned to one of several user-defined groups. A weight can aso be assigned,
and the site shapes are multiplied by these weights and added to get an estimate of
the group shape. Groups can be used to aggregate customer sitesinto a group total
or to aggregate buildings in a campus into a campus total.

m Site Level Billing Data. Billing data can be entered for each sitein a
BillShaper project. Datathat can be entered includes monthly energy, maximum
demand, and billing dates. For quick analysis, avalue can be entered for average
monthly energy, and this value will be applied across months for which billing
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dataare missing. If no billing data or average values are entered, the hourly data
from the prototype library are used directly.

m  Group Level Billing Data. Billing data can also be entered for group totals. In
this case, the group shape, which is aweighted sum of the site shapes, is adjusted
to be consistent with the billing information.

m  Reports. Unlike SitePro simulations, which provide data at the end-use level,
BillShaper produces an 8,760 load shape asitsfinal result. Both site-level and
group-level hourly shapes are stored in the Bill Shaper project, and these results are
available for graphical review and printing.

Figure 1-2: BillShaper Module
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The remainder of this section provides a discussion of system requirements and system
architecture. Thisisfollowed by three sections, applying to the Residential Module (SP-R),
the Commercial Module (SP-C), and the BillShaper module, respectively.
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Installation

2.1 System Requirements

SitePro isaclient-server application. It allows remote users (the clients) to access the
databases and simulation engine, which reside on server machines. The system requirements
for the client (user) are asfollows.

Operating System: Windows NT 4.0
Free disk space: 10 MB

Dynamic Link Libraries (DLL): Microsoft Foundation Classes shared library,
version 4.2 or later. The DLLs are provided with the SitePro installation.

The system requirements for the server are:

Operating System: Windows NT 4.0

Free Disk Space: Minimum installation depends on the databases that are
installed, and can be as large as 400 MB to store the prototype and |oad-shape
libraries.

Memory: A minimum of 32 MB RAM

Data Access Objects (DAO): Jet Engine driversversion 3.50 or later. The DAO
drivers are provided with the SitePro installation.

Dynamic Link Libraries (DLL): Microsoft Foundation Classes shared library,
version 4.2 or later. The DLLs are provided with the SitePro installation.
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2.2 Installation Instructions

The SitePro software comes on a CD with an installation program. There are three elements
to beinstalled: the Server, the DAO objects, and the Client (user) software. The Server and
DAO objects should be installed on the server by the system administrator, while the client
software isinstalled on the users PCs. (It isalso possible for the client and the server to
reside on the same PC. Please refer to “Readme.htm.” file on the distribution CD)

To install SitePro on the server, the system administrator does the following:

Close al applications except Explorer.

m Inthe DAO\diskl directory, double-click the Setup.exe program to install the DAO
files. Follow the instructions presented by the DAO setup program.

m Inthe Server\diskl directory, double-click the Setup.exe program to install the
SitePro Server. Follow the instructions presented by the Setup Program.

-~ You will be prompted for a port number. The default port number should be
used unless there is areason to change it. The same port number will be used
in each client installation.

Re-boot the machine.

To install SitePro on a client machine, do the following:

m  Close all applications except Explorer.

m  Inthe Client\Disk1 directory on the CD, double-click the Setup.exe program to run
theinstall program.

m  Follow the step-by-step instructions presented by the Setup program.

- When prompted for the address and port number, enter the name of the
machine that is running the server. If the client is running on the same PC as
the server (which may be the situation with the beta version), enter the word
“localhost” in server name field.

- Thedefault port number should be used unless there is areason to changeit.
The port number must match the port number used in the server installation.
Check with your network administrator for the appropriate port number.

= Re-boot the machine.
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Using SitePro

To use SitePro effectively, it isimportant to understand the general system design aswell as
the system architecture. The design and the logic behind key actions are common to the
three modules and, as aresult are discussed in this overview section. Specifics details of the
three options are discussed in Section 4 (Residential), Section 5 (Commercial), and Section 6
(BillShaper).

3.1 The Toolbar

The SitePro Toolbar, which is shown below, seven buttons related to navigation and file
management, two drop-down boxes for results selection, and two buttons to move forward
and backward through monthly results. Each button is discussed briefly below.
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rrerrer ot et

Ve, S, Y, N N7 &
S22 Y S0 5% ce%

File New. Thisbutton resultsin creation of anew project file. When pressed, adialogis
presented to select the project type (residential, commercial, or Bill Shaper). Subsequently
the user is asked for afile name for the project file. Upon completing this dialog and
pressing OK, a blank project of the selected type is presented.

File Open. Thisbutton resultsin astandard file open dialog. The type of project that is
opened depends on thefile that is selected (.spr for Residential, .spc for commercial, and .bsp
for Bill Shaper.
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Browse for Site. When viewing a portfolio, this button is used to add a new site based on
datafrom the Prototype Library. Pressing this button leadsto a dialog that allows the user to
examine the available libraries and select a site.

View Project. Each SitePro project involvesalist of sites. Thisis called the Site Portfolio.
When the View Project button is pressed, the window that contains the active portfoliois
brought to the top view. From thisview, the user selects sites to edit site data or to view site
results.

View Data. When asiteis selected, pressing the View Data button will active a tabbed
dialog that contains the input data for that site.

Execute Simulation. For residential and commercial projects, when a siteis selected,
pressing the Execute button will force asimulation for that site. If the data have not changed
since the last simulation, the user is asked if they want to ressmulate anyway. In BillShaper,
calculations are performed for al sites and groups in the portfolio, regardiess of the site or
group that is selected at that time.

View Results. Pressing this button resultsin the display of the results for the site that is
selected.

Select Result Graph. Thiscombo box provides alist of graphsthat are available for
review. Thelist contains six graphing options for simulations and three options for
BillShaper projects. The options range from an annual summary page, to afull presentation
of 8,760 shapes for electricity and daily usage for natural gas.

Select Fuel. Thiscombo box providesalist of fuels, with electricity and natural gas asthe
two options.

Backward and Forward. The backward and forward buttons are active when the hourly
and daily graphs arein view. In this case, three months are displayed at atime, and these
buttons alow moving up and down in the list of months.
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3.2 The Menu

Thetop level menu is shown above with the picture of the toolbar. The menu items and sub
items are shown below. For each menu item, the shortcut key (Alt sequence) and description
are provided. The functionality behind most of these menu itemsis discussed in the
remaining parts of this chapter.

Menu Menu Item Shortcut |Description
File New... Alt FN |Create a new SitePro Project
Open... Alt FO |Open an existing SitePro Project
Close Alt FC |Close the active SitePro Project
Compact on Close Alt FM |Compact SitePro Project File
Export Alt FX |Export 8760 from Results View
Print Alt FP | Print the active report from Results View
PrintAll Alt FA |Print all reports for the active site
MRU List Alt F# |Open a project from the MRU list
Exit Alt FX |Exit SitePro
Edit Browse Alt EB |Browse Server databases to select a Prototype
Delete Delete a site from the SitePro Project
View Toolbar Alt VT |Show or Hide the Toolbar
Status Bar Alt VS |Show or Hide the Status Bar
Tools Calibrate to Bills Alt TC |Calibrate to bills during simulation (Commercial only)
Save EU Details Alt TS |Save End-use 8,760 results
EU Detail Options... Alt TE |Dialog to select end-uses and fuels to save
Auto Print Alt TP |Set automatic printing as part of simulation
Auto Print Options... Alt TO |Dialog to select reports to be printed
Window |Cascade Alt WC |Cascade open windows
Tile Horizontally Alt WH |Tile open windows horizontally
Tile Vertically Alt WV |Tile open windows vertically
Help About SitePro Alt HA |Display About dialog
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3.3 SitePro Project Files

Each SitePro module creates atype of project file that has a unique layout, depending on
whether the data are for residential simulations, commercial simulations, or Bill Shaper runs.
The extensions for these three types of files are:

m .gprfor residential projects
m .gpcfor commercial projects
m .bsp for BillShaper projects

Each project fileis built on the concept of alist of sitesthat are included in the project. This
is called the Project Portfolio.

Project files are stored on the user’ s machine. Despite the extensions of these files, they are
database files stored in Microsoft Access format (.mdb), and they can be viewed and edited
through the Accessinterface, like any .mdb file.

Although they may contain data that was obtained from databases on the server, the project
files are self-contained, once these data have been obtained. Since the project files are
database files, thereis no “File Save” action. When you change the datafor asite in the
project list, this change is committed to the database when the action is completed.

Opening and Creating Project Files. To open an existing project file, use the
File>Open command or press the standard shortcut button for this action on the program
toolbar. Select the project file that you want to work with and press OK.

To create anew project file, use the File>New command or press the standard shortcut
button for this action on the program toolbar. In either case, this action will bring up a
selection dialog, asking which type of project you wish to create — residential, commercial, or
BillShaper. Select the desired type, provide a name for the project file, and press OK.

Project Files and Library Files. Theresidential and commercial prototype libraries have
significantly different layouts. For example, the residential database has fields for household
demographics and appliance holdings, while the commercia database has fields for operating
hours and commercial equipment holdings. The project files for each sector have the same
layout as the corresponding prototype library. Asaresult, it isnot possibleto put a
commercia siteinto aresidential project and it is not possible to put aresidential siteinto a
commercia project.

Since BillShaper projects do not contain customer characteristics data, it is possible to mix
residential and commercia sitesin these projects. All that is required from the prototype
libraries is hourly load data, and these tables are in the same format in both types of library
files.
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3.4 Browse

Once aportfolio is started, new cases are added using the Browse-for-Shape feature. This
action allows the user to search prototype libraries using a standard tree control, likeis used
in file management systems. The control initially displaysalist of librariesthat are
registered on the server. When the library folder is expanded, alist of segmentsis presented.
When a segment is selected, the details box on the right hand side of the control provides a
listing of al casesin the segment. An example of the file selection dialog is shown below.

Figure 3-1: Example of Browse for Site
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To fully understand the Browse action, it is useful to think of SitePro as atwo-tiered system,
involving a client machine and a database server machine. SitePro iswritten using COM
(Component Object Model) technology, and thereisreally athird layer (the business layer),
but it is not useful to visualize this layer to understand the Browse action.
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When the Browse action is implemented, the client program on the user’ s machine connects
to the server. The server provides data about the segments and cases contained in the
database. The user then moves through this information to locate the desired site. When the
site is selected, the client program initiates a three-step process. In step 1, the client program
submits arequest to the server for the data for that site. In step 2, the server processes that
request and responds by delivering the requested data to the client program. Findly, the
client program installs the delivered data into the project database.

Figure 3-2: Depiction of System Architecture for Browsing
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The results of a browse action depend on the module and the type of browse that is invoked.
Browse actions can occur in one of three places.

Browse for Site. Intheresidential and commercial simulation modules, anew siteis
installed in a project by retrieving a site from one of the Prototype databases. In this case, the
browse action brings up alist of sites for purposes of selection. Asshown in Figure 3-2, the
browse dialog has atree control on the left-hand side of the screen and individual sites within
afolder are listed in the right-hand side. Once a siteis selected, the site characteristics data
from the selected record are copied and sent to the client machine to be saved in the project
file.
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Browse for Weather. In both the residential and commercial simulation modules, it is
possible to simulate a selected site with any of the available weather files. The weather
library contains alarge number of hourly wesather files, including TMY files, datafor actual
years, and series that have been constructed to contain normal patterns, including normal
seasonal high temperatures and normal seasonal low temperatures.

The weather library is organized by state. By selecting a state in the left-hand panel, the list
of stations that are available appearsin the right hand panel. When a specific fileis selected
from the list of files, the link to the appropriate file is sent to the client machine and is stored
in the project file. The actual weather data are not transmitted to the client machine at any
time. Thelink to the data provides access to the appropriate file whenever asmulation is
desired.

Figure 3-3: Example of Browse for Weather Dialog
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Browse for Link. Inthe BillShaper program, there is a portfolio of customer sites, but
there are no characteristics data (other than customer hills) in the project file. However, for
each sitein the project file, thereis alink to aload shape in one of the library databases. The
link provides access to the load shape data, and these links are used whenever the execute
button is pressed. The browse dialog is the same as the one shown above in Figure 3-2.

3.5 Editing Data

When a siteis selected, the View Data button is activated. When this button is pressed, a
tabbed dialog is displayed showing the data for the site. The contents of this dialog vary
across the modules. For aresidential project, the dialog will contain data about the
household, appliances, and the home. For acommercia project, the dialog will contain data
about the building and its operation. And for a Bill Shaper project, the dialog will contain
billing data, as well asaway to link to library shapes. More details are provided in Sections
4,5, and 6.

3.6 Executing Simulations

In the residential and commercial modules, simulations are executed for individual sites or
for groups of sites that are selected for batch execution. The architecture used for executing
simulations is shown below in Figure 3-4. Asindicated, the following steps are executed.

1. Get Site Data. Inthisfirst step, datafor the site are copied from the project file.
These data include site characteristics, including information required to link to
technology data and weather files that reside on the database server.

2. Submit Site Data to Calculation Server. The site datathat are copied in
Step 1 are sent to the calculation server. (The calculation code may be installed on
the client machine or on the database server, depending on the configuration used
at time of installation.). On the calculation server, atemporary directory is created
and files related to the ssmulation are kept in this location.

3. Get Weather and Technical Data from Data Server. The simulation
engine requires hourly weather data and technology data that are kept in library
fileson the data server. Based on information in the site data, the appropriate files
and data are retrieved.

4. Execute Simulation and Return Results. Once all necessary data have been
assembled, the smulation is executed. When concluded, the calculation server
sends the simulation results to the client machine, and closes and deletes all
temporary files and directories.

5. Install Results in Project. When the client receives the completed simulation
results, they are installed in the appropriate data tables in the project file.
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Figure 3-4: Depiction of Architecture for Executing Simulations
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If multiple sites are selected when the Execute Simulation button is pressed, then these
actions are repeated sequentially for the selected sites.

Thelogic for execution of a BillShaper project is dlightly different. First, al sites and groups
are processed, regardless of what item is selected in the interface. Second, Bill Shaper
projects do not involve execution of DOE-2. Asaresult, the calculation logic is much
simpler and no physical ssmulations are performed.

3.7 Exporting Whole Building Loads

The simulation results are stored in a set of tablesin the project file. Although these files
have extensions specific to each module (.spr, .spc, and .bsp), each project fileisin Microsoft
Accessformat. These files can be opened in access and any of the results can be printed,
exported to text files, or saved as Excel files.

The files can also be exported from SitePro to text filesin LDAW format (.Ida), 102 day
format (.102) or Pricem format (.pcm) This export appliesto the 8,760 hourly electric loads
only. To export these data:

Select the case and press the Results button on the Toolbar
Select the Daily graph

From the menu select File>Export.

Select the format from the “ Save file as type” control.
Enter the file name, and Press OK.
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The formats are described briefly below.

m  LDAW Format (.Ida). Thisformat savesan 8,760 hour load as two records per
day. Thefirst record contains datafor the first 12 hours and the second record
contains data for the second 12 hours.

m 102 Day Format (.102). Thisformat contains 8 records for each month,
including atypica Monday, Tuesday, Wednesday, Thursday, Friday, Saturday,
Sunday, and Peak Day. The peak days are constructed from the three weekdays
with the highest loads. The last 6 days are the standard holidays for utility rates,
New Years, Memorial Day, Independence Day, Labor Day, Thanksgiving, and
Christmas.

m Pricem Format (.pcm). Thisformat contains 30 records for each month. The
first 24 records for each month contain data for the average weekday load in each
hour. Holidays are excluded from the averaging process. The last 6 records for
each month contain average loads for weekends and holidays in 4 hour blocks.

Figure 3-5: Exporting an 8,760 to a File in LDA Format
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3.8 Saving End-Use Detailed Results

In addition to the whole-building results, it is possible to save 8,760 results for individual end
uses. Thisisdone by selecting Tools—> Save End-Use Detail. When this optionison, all
8,760 values for the end-use loads that have been selected are appended to an Access
database that has the same name as the residential or commercial project file with a.mdb
extension added. The database contains one record for each day of data, and each record aso
identifies contains fields for the Sitel D, End-Use, Fuel, and Date.

Each time asimulation is run with the save option activated, the resulting data are appended
to this database. This database is created in the same directory as the project fileif it does
not exist at the time of the run.

To identify the end-uses and fuels to save, select Tools>EU Detail Options. This action will
bring up a dialog with a series of check boxes for electric end uses and for gas end uses.
Select the desired options. Press the Save As Default button to make this the default
selection. Press OK to install the options for the current session.
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3.9 Automatically Printing Reports

In production mode, a user will sometimes want to process a batch of cases and receive
printed output as aresult of the batch runs. To automatically print reports when a single case
or aset of cases are simulated, select Tools> AutoPrint.

To identify the specific reports that you wish to obtain, select Tools> AutoPrint Options.
Thiswill result in adialog that provides alist of reports for each fuel. Select the desired
options. Press the Save As Default button to make this the default selection. Press OK to
install the options for the current session.
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Residential Simulation Module

This section describes the steps for executing the residential simulation component of
SitePro. A genera discussion of features common to all modulesis presented in Section 3.
This section focuses on features that are specific to the residential module.

4.1 Execute SitePro

When SitePro is started, it will automatically connect to the database server and present the
main program screen. Once the main program screen is shown, the user may create a new
project by selecting File>New from the menu or by pressing the “New” button on the
toolbar. Asshown in Figure 4-1, thiswill bring up a selection dialog with alist of the project
types. Select the Residential option. A “Save As’ dialog will then be provided. Enter a
directory and file name. Thiswill result in creation of an empty project database.

Figure 4-1: Creating a New Residential Project
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To open an existing project, select File> Open from the menu or press the “Open” button on
the SitePro toolbar. Thiswill result in a standard file open dialog. To select aresidential
file, search for fileswith a .spr extension.

4.2 Adding Sites to the Project File

When a new project is started, it is empty, and there are no sitesin the project database. An
existing project typically will contain some number of sites. In either case, the Browse
feature is used to add sites from the prototype library on the database server. For residential
projects, the browsing action, which isillustrated in Figure 4-2, proceeds as follows.

Figure 4-2: Browsing to Add a Site to a Project
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Select a Prototype Library. From the project view, click on the “Browse” button. A tree
control will be provided indicating all prototype libraries that are registered and available to
the user. Select the residentia library of interest by double clicking on the library name or by
expanding the segment list for that library.
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Select a Segment. After selecting alibrary, alist of segmentsin the library will appear in
the right hand panel or below the library label, as shown in Figure 4-2. The aspect of the
database that is used for segmentation is configurable by the system administrator. Inthe
example shown, segmentation is by state, and the filter is set to show all sites whose state
codeis GA.

Select a Site. By selecting a segment, afiltered list of sitesin the prototype library is
presented. Select a prototype site by clicking on the site and pressing “OK.” To make the
selection process easier, key prototype characteristics are provided. For the residential
segment these characteristics include the following:

Site name or |abel

Site weather and weather year

Housing Segment (single family, small multi-family, or large multi-family)
Heating Equipment and Cooling Equipment

Housing Vintage (new or old)

Housing Size (square feet)

It is possible to sort the filtered list of sites by clicking on any of the column headers. A
single click sortsin ascending order. A second click sortsin descending order. Column
widths can be adjusted by clicking on the sides of the column headings and dragging them.

Once asiteis selected, SitePro will return the user to the Project View, which shows the list
of sitesthat have been included in the project portfolio. These sites areincluded in the
project database, and each site is marked as one of the following:

m  Needs Simulation
m UpToDate

Thisfield comes from the prototype libraries as Up To Date, indicating that the load shapes
in that are copied to the project file are consistent with the characteristics data that are copied
to the project file. Upon any change to the site data, the copy in the project file is market as
Needs Simulation. An example of aproject filein Project View is provided in Figure 4-3.
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Figure 4-3: Example of Project View
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4.3 Review, Modify, and Save Site Characteristics

Once asiteisincluded in the project, its characteristics can be viewed or modified. To view
or modify the characteristics, highlight the site, and press the “View Data’ button on the
SitePro toolbar, or double click on the site in the project portfolio. Either action resultsin
creation of atabbed dialog containing four tabs. Examples of these tabs are shown in Figure
4-4 through Figure 4-6. Changes are saved when the user closes the window or executes a
simulation. The characteristics window may be closed using the “X” in the upper right hand
corner of the window.

General Information Tab. The genera information tab (Figure 4-4) presents the
following information for the selected site. While the site may have default information
based on the specifications in the prototype library, the user may revise the majority of the
key characteristics as needed to represent a modified site.
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Label and Description are the name and description fields for the site.

Year isthe calendar year that will be used in the simulation. The hourly
simulation results will be placed on a calendar that represents the timing of
weekends and holidays for that site.

Weather isthe weather file that is used in the simulation. The weather station can
be changed by using the browse feature. This accesses the database server to
provide alist of available files for each state.

HVAC System identifies the primary heating and ventilation system at the site. A
total of 34 HVAC system configurations are available.

Characteristics include economic and demographic characteristics such as house
size (square feet), number of floors, and the annual gross income of the household.

m Household Profile contains the number of people in the household of various
age categories. Household profile information is used by SitePro to estimate

energy use and to assign alifestyle segment.

Figure 4-4: View Data — General Info
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End-Use Tab. The end use tab shown in Figure 4-5, presents specific technology
information for a selected set of appliances (note that the HV AC system selection is made on
the General Info tab. The user specifies the share of specific appliances and an optional
multiplier.

Modeled UEC. For HVAC uses, the first column presents the UEC values that are
developed from conditional demand equations. Modeled UECs for the HVAC system
are not directly utilized in the construction of energy load shapes. They are provided
asreference values.

DOE-2 UEC represents UEC values calculated by the DOE-2 building simulation
model. DOE-2 UECs are directly utilized in the construction of energy load shapes.

DOE-2 Multiplier alows for amanual adjustment of the DOE-2 simulated UEC for
the HVAC systems. Typically users will impose multipliers for UECs simulated by
the DOE-2 model since household behavior (i.e., vacations, business travel, and etc.)
resultsin different energy use outcomes than those derived from engineering based
programs. The DOE-2 multiplier allows SitePro users to calibrate building simulation
results (DOE-2 model results) to actual usage and then evaluate the impact of
changing house size, thermal shell characteristics, and equipment characteristics,
given these calibration multipliers.

Share. The share column for non-HV AC equipment represents (1) the number of
appliances in a specific household, or (2) the percentage mix of different appliances
typesif adiversified or average profileis used.

Modeled UEC for non-HVAC appliances appears in the second column. Again, this
value refers to unit energy consumption or the amount of energy that a specific
appliance uses in one year, and the values are computed from conditional demand
equations. Electric UECs are entered in kWh, and natural gas UECs are entered in
kBtu.

Final UEC showsthe final UEC value. For HVAC uses, thisisthe DOE-2 value
multiplied by the DOE-2 multiplier. For non-HVAC uses, thisisthe UEC value
multiplied by the UEC multiplier.

The following appliances are included in the end use tab:

HVAC system (heating and cooling, as well as electric and fossil fuels)
Water Heating by fuel

Refrigerator by type of unit

Freezer by type of unit

Clothes Washer and Clothes Dryer by fuel

Cooking Equipment by fuel
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m  Miscellaneous, including dishwasher, microwave, TV, pool, spa, and other

s Lighting.

When appropriate, SitePro provides entries for electric, natural gas, and an “ other” category
to cover fossi| fuels such as fuel oil and propane.

Figure 4-5: View Data — End-Use Tab
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Shell Tab. The shell tab shown in Figure 4-6. It allows the user to view and edit thermal
characteristics of structure aswell as HVAC system efficiency. Foundation and roof
characteristics are expressed as percentages of the total. For a specific site, these would be
100% for one characteristic and 0% for the others. For a mixed prototype, percentages
represent the mix in asegment. Window areais expressed as the ratio of total square footage
of window areato total square footage of floor area. Insulation levels are specified as R-
values. The other unique features are defined below:

ACH: Air changes per hour (normally between 1.5 and .3)

Aspect: Ratio of house width to length.

Wall Type: (1) isaframe cavity and (2) is masonry

Window U-Value: Average U-value (inverse R-values) for al windows

Window SC: Average shading coefficient (typically between 1.0 and 0.4)

Heating Efficiency: An efficiency measure that is specific to the equipment type —
HSPF for heat pumps and AFUE for fossil fuel furnaces)

m  Cooling Efficiency: (expressed as either EER or SEER)

Figure 4-6: View Data — Shell Tab
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4.4 Execute Energy Simulation

Once the site data in a project portfolio have been obtained and edited, the user may execute
the energy ssmulation step of SitePro. The simulation may be executed from the project view
or from the data view for asite. From the project view, highlight the desired site in the
project and select the “Simulate” button. After the simulation is complete, results may be
viewed by pressing the “Results’ button. To execute a simulation from the data view, smply
press the “ Simulate” button and when the simulation ends, the results will appear on the
screen.

From the project view, multiple sites may be simulated in a batch mode process. Thisis
done by selecting multiple sites using the Shift key to select multiple sites, followed by
pressing the “Simulate” button.

Upon execution, SitePro performs afull hourly energy ssimulation using DOE-2 and
proprietary non-HVAC agorithms. The basic simulation logic is summarized below.

m  SitePro estimates UECs for all equipment and appliances based on conditional
demand equations embedded in a VBScript file. Thisfile can be edited by the
system administrator to change the calculation logic.

s Non-HVAC hourly load shapes are selected from a database based on a lifestyle
segment designation. These shapes are multiplied by the annual UEC values to
develop hourly load estimates.

m  The prototype library provides all the datarequired to smulate HVAC usesin
DOE-2. Selected information may be modified by the user as described in Step 3
above.

m  Weather data, aswell asinterna heat gains, are required by DOE-2. SitePro
automatically calculates internal gains based on the non-HVAC appliance and
energy-use profile of the specific site.

m  Thesimulation deliversload shapes for 8,760 hours for each end use.
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4.5 Review and Print Results

To view resultsfor asitein aproject, highlight the site and select the “ Results’ button. |If
data have been changed since the site was last simulated, the user will be asked whether to
perform asimulation. To see revised results with the edited data, select “Yes.” Thiswill
result in asimulation of the site. To see the most recent simulation results that do not
incorporate subsequent edits, select “No.” In this case asimulation will not be executed and
the old results will be displayed.

When results are viewed, the Energy Summary for Electricity appears, as shown in Figure 4-
8. While viewing the results, the two pull-down menus on the Toolbar provide access to the
following graphs for electricity and natural gas.

m  Summary provides a condensed view of four sets of results. This one page
summary provides a good overview of the end-use consumption, load shapes, and
monthly usage patterns.

s Energy Summary illustrates shares, annual intensity values, peak values and,
and percent of total salesfor each end use and the whole site.

s Monthly Use presents monthly energy use and maximum hourly demand for
each month of the year.

16-Day Total presents whole-site load shapes for 16 day types.

16-Day End Use presents end-use load shapes for 16 day types.

8,760 Hour presents whole-site hourly loads, three months at atime. The double
arrows allow the user to view additional months.

The full set of results are shown in Figures 4-7 through 4-20. Results for multiple sites can
be viewed side-by-side by selecting each site on the project view and pressing the Results
View button. Graphsfor each site will be in their own window, and windows can be sized
and tiled as desired.
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Figure 4-7: Results View — Summary Electric
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Figure 4-8: Results View — Energy Summary
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Figure 4-9: Results View — Monthly Use
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Figure 4-10: Results View — 16-Day Total
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Figure 4-11: Results View — 16-Day End Use

A SitePro - [UGProject.spr:2]

File Edit “iew Toolz ‘Window Help

0| =| & | = e =]

j IEIectric j <<<| >>>|

Feady

16 Day End Use
Summary
. Energy Summa[}l Weather: AHlantz, G4 Noma!
2:Prototype 3 -- SFCAC/GF/New
yp Maonthly Use vear: 1998
16-day End Use for Efectric 16 Day Total Date : 082998
e Wirter Thoic Zay e Wirter A Wirter it ooy o Wit ot Oy
et 224,
. M
T ¢ & w1 & 3 n
e Sprtng Traic Eay
et
120 - ! :\_‘
—
T ¢ # m 41 & @ A
e Sunr THNCH Doy
ee
124
IR EE R RAE RArARE RAN'] IR AL ARL RAE RRTARE RAN']
e it Tt oay e it e
ee 222
e y ﬁ
IR EE R RAE RArARE RAN'] IR AL ARL RAE RRTARE RAN']
O MeczlEwon B Reirige@ton O oternd. E  ugkr Heatg O  Ligkthg H coml W Heat

[ NoM [

Figure 4-12: Results View Daily Shapes
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Figure 4-13: Results View — Natural Gas Summary
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Figure 4-14. Results View — Natural Gas Energy Summary
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Figure 4-15: Results View — Natural Gas Monthly Use
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Figure 4-16: Results View — Natural Gas 16-Day Total

r'T! SitePro - [UGProject.spr:2]
File Edit Yiew Toolz 'window Help

O | = | 7] | ||F(x)=|@| 16 Day Tatal j IGas j KK | >))|
Summa[}l Weather: AHlanrta, GA A Y
eIFTer, g, 0T S
2:Prototype 3 -- SFICAC/GF/New  [Ererey Surmayy 24 omal
16-diagy Total for Natral Fas rﬁﬁﬁ! Dzbe: 082933
- Wty TRV Cery — Wrder 1DB _Pa.'r' End Use Wrber it Dy — Wirter Colcoary
dea. e = et e
= N s T e
e e s J\\—m e
a4 . Fl [ 1 . Fl H 1 . F) [} 1 - Fl H 1 - Fl [} 1 . Fl H e 1 . Fl [} 1 . F H
e Sprg Thalca Cry " S esherst e Satramit ooy e Eat Colchy
10 15 10 st
e e P e
e *”/\\M s e e 8 /\/
e Sy Tl ery " Eureer Weeherc! " Forwertit Cay s Screr oSy
1t st 1 st
e e " e
e e e e
m it Thi oy e At Weehsn! " i ik ey e A ColcACRy
10 1t 10 ™
e e P e
- ,__,/\"\_\_____’_,____ e ™ ke N
e T e,
i I3 Fi [ H 4 E] H H I3 F] [} 1 - E] H H - Fi [} 1 I3 E] H e H 4 E] [} 1 I3 - H
Ready [[noM [

Residential Smulation Module

4-15



StePro Version 1.0 User’s Guide

Figure 4-17: Review Results — Natural Gas 16-Day End Use
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Figure 4-18: Results View — Natural Gas Daily Use

A+ SitePro - [UGProject.spr:2]

File Edit ¥iew Toolz “Window Help _Iﬁllll
~ —
i | E'| & | | £69=| Ful | [oa =[G =l <<<| >>>|
Summary
. - Energy Summary Wezther: AHantz, S5A Momad!
2:Prototype 3 -- SFICAC/GFINew Momihly Lise Voar- 1995
365 Day for Matwwal Gas 16 Day Tatal Date : 08/29/98
£ Diaw End Lse

o :

am

m

am

B T2 Ta T Ts 7671 e Ta Tm i iz @ ' 6 ' n 5 v '@ 2 "2 = 2 s s 27 & = =3

Februa

— Y

&m

m

m

B T T3 T T "6 Tt Ts Ta T T T2 s e e a2 A s xn B

March

am

om

im

g Ty LT [ I TrTriry
PP T2 T T T Te T T T T T2 @2 @ a5 % g & e m A

Ready NLM 4

Residential Smulation Module

4-16



StePro Version 1.0 User’s Guide

4.6 Export Results

All load shape results are stored in tables in the project file. For residential projects, the
project file extension is .spr. Thesefilesare in Microsoft Access format, so they can be
viewed, analyzed, and used through the Access interface. In addition, whole-building hourly
load shapes may be exported to an LDAW format (.Ida), 102 Day format (.102), and Pricem
format (.pcm). To do this, select File>Export from the 8,760-hour graph. The result will be
asshown in Figure 4-19. Select the file type for the export action, enter afile name and press

OK.

Figure 4-19: Exporting 8,760 to File in LDA Format
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4.7 Saving End-Use Hourly Loads

In addition to the whole-building results, it is possible to save 8,760 results for individual end
uses. Thisisdone by selecting Tools—> Save End-Use Detail. When this optionison, all
8,760 values for the end-use loads that have been selected are appended to an Access
database that has the same name as the residential project file with a.mdb extension added.

To identify the end-uses and fuels to save, select Tools>EU Detail Options. This action will
bring up a dialog with a series of check boxes for electric end uses and for gas end uses.
Select the desired options. Press the Save As Default button to make this the default
selection. Press OK to install the options for the current session.

4.8 Print Results

Results can be printed one page at atime or in batch. To print asingle page, select the
desired chart and select File>Print. To print the entire set of charts for a site, view results
for the desired site and select File>Print All. Finally, to have results printed automatically
whenever asiteis simulated, select Tools>AutoPrint. To set the results that should be
included in the automatic printing use the Tools—> AutoPrint Options.
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5

Commercial Simulation Module

This section describes the steps for executing the commercia simulation component of
SitePro. A genera discussion of features common to all modulesis presented in Section 3.
This section focuses on features that are specific to the commercial module.

5.1 Execute SitePro

When SitePro is started, it will automatically connect to the database server and present the
main program screen. Once the main program screen is shown, the user may create a new
project by selecting File>New from the menu or by pressing the “New” button on the
SitePro toolbar. Asshown in Figure 5-1, thiswill bring up a selection dialog that provides a

Figure 5-1: Creating a New Commercial Project
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list of the three types of projects. Select the Commercial option. A “Save As’ dialog will
then be provided. Enter adirectory and file name. Thiswill result in creation of an empty
project database.

To open an existing project, select File>Open from the menu or press the “Open” button on
the SitePro toolbar. Thiswill result in a standard file open dialog. To select acommercial
file, search for files with a .spc extension.

5.2 Adding Sites to the Project File

When a new project is started, it is empty, and there are no sitesin the project database. An
existing project typically will contain some number of sites. In either case, the Browse
feature is used to add sites from the prototype library on the database server. For commercial
projects, the browsing action, which isillustrated in Figure 5-2, proceeds as follows.

Figure 5-2: Select a Prototype Library
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Select a Prototype Library. From the project view, click on the “Browse” button. A tree
control will be provided indicating all prototype libraries that are registered and available to
the user. Select the library of interest by double clicking on the library name or by expanding
the segment list for that library.

Select a Segment. After making alibrary selection, alist of segmentsin the library will
appear in the right hand panel or below the library label, as shown in Figure 5-3. The aspect
of the database that is used for segmentation is configurable by the system administrator. In
the example shown, building type segmentation is used, and the large office segment
(OFFLR) is selected.

Figure 5-3: Selecting a Site
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Select a Site. By selecting a segment, afiltered list of sitesin the prototype library is
presented. The user should choose a prototype site for inclusion in the user project by
clicking on the site and selecting “OK.” To make the selection process easier, key prototype
characteristics are provided. For the commercia segment these characteristics include the
following:
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Site name or label

Site weather and weather year

Segment (building type in the example libraries)
Heating Equipment and Cooling Equipment
Building Vintage

Building Size

It is possible to sort the filtered list of sites by clicking on any of the column headers. A
single click sortsin ascending order. A second click sortsin descending order. Column
widths can be adjusted by clicking on the sides of the column headings and dragging them.

Once asiteis selected, SitePro will return to Project View, which shows the list of sites that
have been included in the project portfolio. These sites are included in the project database,
and each site is marked as either Needs Simulation or Up To Date.

Figure 5-4: Example of Project View
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Thisfield comes from the prototype libraries as Up To Date, indicating that the load shapes
in that are copied to the project file are consistent with the characteristics data that are copied
to the project file.
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5.3 Review, Modify and Save Site Characteristics

Once asiteisincluded in the project, its characteristics can be viewed or modified. To view
or modify the characteristics, highlight the site and press the “View Data’ button on the
SitePro toolbar, or double click on the site in the project portfolio. Either action resultsin
creation of atabbed dialog containing four tabs. Examples of these tabs are shown in Figure
5-5 through Figure 5-7. Changes are saved when the user closes the window or executes a
simulation. The characteristics window may be closed using the “ X" in the upper right hand
corner of the window.

General Information Tab. The general information tab (Figure 5-5) presents the
following information for the selected site. While the site may have default information
based on the specifications in the prototype library, the user may revise the majority of the
key characteristics as needed to represent amodified site.

Figure 5-5: View Data — General Information Tab
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Source isafield intended to document the original source of the prototype
Label and Description are the name and description fields for the site

Size of Building isthe building size in square feet

Number of Floors isthe number of floors used to represent the building
Weekly Operating Hours isacomputed field summarizing building operation

Year isthe caendar year that will be used in the ssmulation. The hourly
simulation results will be placed on a calendar that represents the timing of
weekends and holidays for that site.

Weather isthe weather file that is used in the simulation. The weather station can
be changed by using the browse feature. This accesses the database server to
provide alist of available files for each state.

HVAC System identifies the primary heating and ventilation at the site. The user
can change systems within the single zone family, according to options allowed in
the drop-down list. Complex systems can not be changed.

Percent Site Cooled indicates the fraction of the floor space in the prototype
that is cooled. Thisfield can not be edited.

Percent Site Heated indicates the fraction of the floor space in the prototype
that is heated. Thisfield can not be edited.

Seasonal Operation indicates the calendar periods for which the secondary
operating profile should be applied. For example, to have the secondary schedule
apply from June 15 to September 1, enter 6, 15, 9, and 1 in the four fields. Upto
three intervals for application of the secondary schedule can be identified.

End-Use Tab. The end usetab shown in Figure 5-6, presents end use energy results for
electricity and natural gas end uses. The data appear in six columns. Thefirst three columns
show simulated values, which are based on the modified characteristics data and weather
data. The next two columns provide end-use override variables. The final column shows the
final intensity after application of the override variables. Thefields are:

Intensity. Thisfield shows the engineering estimate of the annual energy
intensity, expressed in kWh per square foot for electric uses and in kBtu per square
foot for natural gas.

Peak. Thisfield showsthe largest ssmulated hourly value for an end use. The
hour of the peak value is determined separately from the end-use load shape. The
value isin Watts per square foot for electricity and Btu per square foot for natural
gas.

Load Factor. Theload factor isthe average hourly load divided by the peak
value for each end use.
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m Intensity Override. Theintensity overrideisamultiplier. For example, if this

valueis 1.2, the loads for the specified end use will be marked upward 20% in each
hour. If aload factor adjustment is specified, it is applied first, and the intensity

override is applied subsequently.
m Load Factor Override. Thisload factor override is applied before the intensity

override. Itisappliedin away that the peak value is maintained and energy values
are adjusted upward or downward proportionally to their distance from the peak

value, which increases or decreases the annual intensity. Downward adjustments
are capped at zero, and if thislimit is encountered, the desired load factor will not

be redlized.

m  Adjusted Intensity. The adjusted intensity represents the end-use intensity after
the intensity and load factor overrides have been applied.

Figure 5-6: View Data — End-Use Tab
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Schedule Tab. The scheduletab isshown in Figure 5-7. Thistab alowsthe user to
modify the start and stop times for each day of the week, as well as thermostat settings and
schedules for heating and cooling. Features of thistab are as follows:

Open and Close Hours. Thesefields control the time a building opens and
closes for each day of the week. If the closed-all-day option is checked, the values
are dimmed, and the hour settings for the closed day are used in the simulation.
These values are used to adjust the “ starter shapes’ in the technology databases for
non-HVAC uses.

Closed All Day Checkbox. By checking thisbox for aday of the week, the
thermostat settings for the closed are assigned to that day.

Heating Temperatures. These valuesindicate thermostat settings for heating
equipment during the specified hour range. Values are entered in degrees F, and a
value of 50 or lower indicates that the system is off.

Cooling Temperatures. These valuesindicate thermostat settings for cooling
equipment during the specified hour range. Vaues are entered in degrees F, and a

value of 95 or higher indicates that the system is off.

Figure 5-7: View Data — Schedule Tab

& SitePro - UGProjCom.spc [_ (O] |
Eile Edit View Took Window Help
D | @ | & | EPE|rer || | o | <= 55
ﬁ'UEPmiEnm.spc:Z _ O] XI
rY
— Primary =
Cloged Heating Temps, *F Cooling Temps, °F
Open Cloged Al Day Open Cloged Open  Clozed
Sunday | i | 24 W | e | 8 | 8| &
b oriday I g I 19 ' I 70 I ES I 72 I a5
Tuesday | B | s | | & [ 72| &
wednesday I & I 13 I I 70 I E5 I 72 I 85
Tihumesky | E | 1w | | s [ 72| &
Friday | B | v | | e [ 72| &
Saturday | 7 | v | | e [ 72| &
Holiday | a | 4 W | e | & | & | &
Clozed I ES I 85
— Secondary
*% Change in
Closed  Heating Temps, °F - Cooling Temps, °F Operatian
Open Clozed AllDiay  Open Clozed Open  Clozed Open Clozed
Sunday ol 2 £ [Tl s [ 2 s [ 1o [ m |
Ready [ [HUM 4

Commercial Smulation Module



StePro Version 1.0 User’s Guide

Below the primary schedules is a set of secondary schedules. These inputs have the same
format, but two extrafields are added. The additional fields are labeled “% Change in
Operation.” Separate entries are provided for open hours and closed hours.

m  Thevauefor open hoursis applied to the peak value of the starter shape in the
technology database for non-HVAC uses. By entering avalue of 60, the peak
value will be reduced to 60% of itsinitial value.

m  Thevauefor closed hours appliesto the base value in the end-use shape. By
entering avalue of 40, the base value is reduced to 40% of itsinitia value.

These shape modifications to the base and peak values are applied to recalibrate the starter
shape. Then the starter shape is further modified to agree with the operating hour settings for
the secondary schedules.

Holiday Tab. The holiday tab (depicted in Figure 5-8) allows the user to specify which of a
list of 20 standard holidays apply to the site. In addition alist of up to 20 additional dates
can be supplied.

The schedule data are stored separately for each site in the project, allowing full flexibility
across types of commercial activity. The actual dates on which the standard holidays occur is
controlled by a calendar table that islocated in the technology datafile.
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Figure 5-8: Holiday Schedules
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5.4 Execute Energy Simulation

Once the site data in a project portfolio have been obtained and edited, the user may execute
the energy ssimulation step of SitePro. The simulation may be executed from the project view
or from the data view for asite. From the project view, highlight the desired site (as shown
in Figure 5-9) in the project and select the “ Simulate” button. After the smulation is
complete, results may be viewed by pressing the “Results” button. To execute asimulation
from the data view, simply press the “ Simulate” button and when the simulation ends, the
results will appear on the screen.

From the project view, multiple sites may be simulated in a batch mode process. Thisis
done by selecting multiple sites using the Shift key and pressing the “ Simulate” button.

Figure 5-9: Execute Simulation
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SitePro performs afull hourly energy simulation using DOE-2 and proprietary non-HVAC
algorithms. The basic ssmulation logic is summarized below.

m  SitePro estimates hourly loads for all non-HVAC equipment. These simulations
are based on the characteristics data and technology inventory datain the project
file database and end-use load shapes in the technology database on the database
server.

m  Along with estimates of internal gains from the non-HVAC simulations, the
project file provides al the site data required to simulate HVAC energy usein
DOE-2.

m  Weather datafor these smulationsis obtained from the weather directory on the
database server.

m  Thesimulation deliversload shapes for 8,760 hours for each end use.

5.5 Review and Print Results

To view results from the user project, highlight a site and select the “Results’ button. If data
have been changed since the site was last simulated, the user will be prompted about whether
to perform asimulation. To see revised results with the edited data, select “Yes.” Thiswill
result in asimulation of the site. To see the most recent simulation results that do not
incorporate subsequent edits, select “No.” In this case asimulation will not be executed and
the old results will be displayed.

When results are viewed, the Energy Summary for Electricity appears, as shown in Figure
5-11. While viewing the results, the two pull-down menus on the Toolbar provide accessto
the following graphs for electricity and natural gas.

s Energy Summary illustrates shares, annual intensity values, peak values and,
and percent of total salesfor each end use and the whole site.

Monthly Use presents monthly energy use and maximum hourly demand for
each month of the year.

16-Day Total presents whole-site load shapes for 16 day types.

16-Day End Use presents end-use load shapes for 16 day types.

8,760 Hour presents whole-site hourly loads, three months at atime. The double
arrows allow the user to view additional months.

Review results graphs areillustrated in Figure 5-11 through Figure 5-21.

Results for multiple sites can be viewed side-by-side by selecting each site on the project
view and pressing the Results View button. Graphs for each site will be in their own
window, and windows can be sized and tiled as desired.
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Figure 5-10: Results View -- Summary
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Figure 5-11: Results View — Energy Summary
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Figure 5-12: Results View — Monthly Use
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Figure 5-13: Results View — 16-Day Total
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Figure 5-14: Results View — 16-Day End Use
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Figure 5-15: Results View — Daily
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Figure 5-16: Results View — Natural Gas Summary
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Figure 5-17: Results View — Natural Gas Energy Summary
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Figure 5-18: Results View — Natural Gas Monthly Use
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Figure 5-19: Results View — Natural Gas 16-Day Total

r’} SitePro - [UGProjCom.zpc:2]

Weather: AHlamta, GA Noma!

SmiEkd ear: 1998
Blilhg Daw Date: 05295

o

[ oM

File Edit Wiew Toolz Window Help

[ | = | @ | ||F(x)=|| 16 Day Total ﬂlGas j <<<| >>)l
Sumrnary

. i Energy Summary Weather: Alanta, 5A Nomal
13:Nursing Home, Large (Gas Heat) | =it -t e S——
16-day Total for Natural Gas Dgte: 03298
e Weter Tppic oy i Wirter 1DB ||:) ay End Use Winter bt Doy o Weter Colct Oy

ai

5 m e M e M - m
188, Sptrg Tro Oy ™ g Mot ™ St b Cery ™ Spatrg ColchCery
" e e e

T ¢ & k1 ¢ & n T ¢ & w1 & ¥ H T ¢ & W 1 ¢ # H T ¢ & W 1 ¢ ¥ W
1ee o THOCH Oy m Sear Weeherch 1oe Scrmeribt oy o Surumer ColCOmy

e e . e

e e e e

T 35 % 1§ 3w T s R T 3w IR ARE AL DA R BAE DA T 3 R T E 5w
16 L 16s- Lo o 18- A O Oy Tt A Codcd Doy

e e ! st

m e, e, i

Feady

[ oM

Commercial Smulation Module

5-18



StePro Version 1.0 User’s Guide

Figure 5-20: Results View — Natural Gas 16-Day End Use
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Figure 5-21: Results View — Natural Gas Daily Use
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5.6 Export Results

All load shape results are stored in tables in the project file. For commercia projects, thefile
extension is.spc. Thesefiles are in Microsoft Access format, so they can be viewed,
analyzed, and used through the Access interface. In addition, hourly load shapes may be
exported to an LDA/LDZ file. To do this, select File>Export from the 8,760-hour graph.
The result will be as shown in Figure 5-22.

Figure 5-22: Exporting 8,760 to File in LDA Format
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5.7 Print Results

Results can be printed one page at atime or in batch. To print asingle page, select the
desired chart and select File>Print. To print the entire set of charts for a site, select
File=>Print All.
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Listing of SITEPRO Annual Results

Not available electronically.



Appendix G

Descriptive Statistics for Variables Used In
Realization Rate Model

Not available electronically.



Appendix H

Descriptive Statistics for Variables Used In
Efficiency Choice Models

Not available electronically.
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Information Relating to 1994 Program Year

Not available electronically.

Retroactive Waiver for Program Year 1994
Narrative on Retroactive Waiver for Program Year 1994

Tables E-2 and E-3 for Program Year 1994
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Tables E-2 and E-3 for Program Year 1995

Not available electronically.
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Table 6 for Program Year 1995




SAN DIEGO GAS &

M&E PROTOCOLS TABLE 6 - RESULTS USED TO SUPPORT PY94 SECOND EARNING:!
FIRST YEAR LOAD IMPACT EVALUATION, |

Designated Unit of Measurement: LOAD IMPACTS PER PARTICIP/

= Optional
LOWER BOUND
1. Average Participant Group and Average Comaprison Group PART GRP COMP GRP PART GRP
A. Pre-install usage: Pre-install kW na na|
Pre-install kWh na na
Base kW na na
Base kWh na na
Base kW/ designated unit of measurement na na|
Base kWh/ designated unit of measurement na na|
B. Impact year usage: Impact Yr kW na nal
Impact Yr kWh na na|
Impact Yr kW/designated unit na na|
Impact Yr kWh/designated unit na na
2. Average Net and Gross End Use Load Impacts AVG GROSS |AVG NET AVG GROSS
A.i. Load Impacts - kW 8,469 4,977 7,804
A.ii. Load Impacts - kWh 47,686,000 28,200,000 43,943,000
B. i. Load Impacts/designated unit - kW 29.716 17.459 27.383
B. ii. Load Impacts/designated unit - kWh 167,321 98,948 154,186
C. i. a. % change in usage - Part Grp - kW
C.i. b. % change in usage - Part Grp - kWh
C. ii. a. % change in usage - Comp Grp - kW
C. ii. b. % change in usage - Comp Grp - kWh
D. Realization Rate: D.A.i. Load Impacts - kW, realization rate 1.1072 0.7535 1.0202
D.A. ii. Load Impacts - kWh, realization rate 1.5175 1.0315 1.3984
D.B. i. Load Impacts/designated unit - kW, real rate 1.1072 0.7535 1.0202
D.B. ii. Load Impacts/designated unit - kWh, real rate 1.5175 1.0315 1.3984
3. Net-to-Gross Ratios RATIO RATIO
A. i. Average Load Impacts - kW 0.588 0.289
A. ii. Average Load Impacts - kWh 0.591 0.2908
B. i. Avg Load Impacts/designated unit of measurement -
kW 0.588 0.289
B. ii. Avg Load Impacts/designated unit of measurement -
kWh 0.591 0.2908
C. i. Avg Load Impacts based on % chg in usage in Impact
year relative to Base usage in Impact year - kW
C. ii. Avg Load Impacts based on % chg in usage in Impact
year relative to Base usage in Impact year - kWh
4. Designated Unit Intermediate Data PART GRP COMP GRP PART GRP
A. Pre-install average value na na| na
B. Post-install average value na na na
6. Measure Count Data NUMBER
A. Number of measures installed by participants in Part
Group Attached
B. Number of measures installed by all program participants
in the 12 months of the program year Attached
C. Number of measures installed by Comp Group na
7. Market Segment Data SIC or CZ PERCENT
Distribution by 3 digit SIC - Commercial/Industrial See Attached
Distribution by Weather Zone Miramar 151
San Diego 101

J\ROB\CADMAC\table6.xIs 12/10/2002



% ELECTRIC

S CLAIM FOR AGRICULTURAL ENERGY MANAGEMENT SERVICES PROGRAM
NOVEMBER 1995, STUDY ID NO. 944
ANT FROM ALL PRACTICES AND MEASURES COMBINED.

5. A. 90% CONFIDENCE LEVEL

5. B. 80% CONFIDENCE LEVEL

UPPER BOUND |LOWER BOUND [UPPER BOUND |[LOWER BOUND [UPPER BOUND |LOWER BOUND [UPPER BOUND
PART GRP COMP GRP COMP GRP PART GRP PART GRP COMP GRP COMP GRP
AVG GROSS AVG NET AVG NET AVG GROSS AVG GROSS AVG NET AVG NET
9,134 2,499 7,505 7,952 8,986 3,001 6,928
51,429,000 13,874,000 42,526,000 44,772,000 50,600,000 17,005,000 39,254,000
32.049 8.590 26.328 27.9 31.532 10.528 24.303
180,456 48,682 149,214 157,098 177,544 59,666 137,736
1.1941 0.3783 1.1362 1.0395 1.1748 0.4544 1.0489
1.6366 0.5075 1.5555 1.4248 1.6102 0.622 1.4358
1.1941 0.3783 1.1362 1.0395 1.1748 0.4544 1.0489
1.6366 0.5075 1.5555 1.4248 1.6102 0.622 1.4358
RATIO RATIO RATIO
0.886 0.354 0.818
0.891 0.356 0.823
0.886 0.354 0.818
0.891 0.356 0.823
PART GRP COMP GRP COMP GRP PART GRP PART GRP COMP GRP COMP GRP
na na na na na na na
na na na na na na na
J\ROB\CADMAC\table6.xIs

12/10/2002
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Table 7 for Program Year 1995




Table 7: Data Quality and Processing Documentation for 1995 Nonresidential
New Construction Program First Year Load Impact Evaluation
March 1997
Study ID No. 971

7.A  Overview Information

1. 1995 Nonresidential New Construction Program, Study ID number 971.

2. Theprogram year is 1995. The Nonresidential New Construction is designed to induce
builders to increase energy efficiency in construction beyond the levels required by Titles 20
and 24. The program offers informational and training workshops for builders, and provides
incentives for the installation of demand-side management (DSM) measures. See Section 1.2
for a detailed program description.

3. Theprogram istargeted primarily at interior lighting and HVAC end uses, although some
measures affecting other end uses were incentivized in 1995. A variety of DSM measures are
covered by the program, including high-efficiency lighting, high-efficiency cooling, VSDsfor
ventilation and pumping systems, and high efficiency motors.

4. The redlization rate approach, a specific type of mixed engineering/statistical method, was
used in thisevaluation. This model relies on engineering estimates devel oped under two
scenarios for both participants and nonparticipants:. the reference scenario (e.g., minimal
compliance with building and appliance energy efficiency standards); and an as-built scenario
(with al program and non-program measures in place). Engineering estimates were
developed using RER’ s SitePro software system. SitePro utilizes DOE-2 to model HVAC
loads and well-tested engineering algorithms for estimating non-HVAC loads. The
development of engineering estimates is detailed in Section 4. The realization rate model
produces a set of adjustment coefficients (or adjustment functions) that translate SitePro
engineering estimates into estimates consistent with observed energy usage and savings.
These coefficients reflect the proportion of the engineering-based savings estimates actually
realized in the form of reduced site usage. See Section 5 for a summary of the realization rate
model specification.

5. Inthisanalysis participants are defined as customers who participated in the 1995
Nonresidential New Construction Program. Nonparticipants are considered to be all sites
undergoing new construction, major remodels or tenant improvements in 1995 that did not
participate in the program.
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6. Thefinal analysis database consisted of the following numbers of sites:

Engineering Analysis: Made use of on-site survey data on 410 sites (252 participants and
158 nonparticipants). Estimates were developed on an hourly basis, then aggregated to
amonthly level.

Realization Rate Analysis. Made use of engineering estimates and billing data on 204
participating and 145 nonparticipating sites with billing data matched to the surveyed
site. Thirteen monthly observations were used for each site, but one observation was
lost in the course of the autocorrelation correction.

Net-to-Gross Analysis: Made use of annual efficiency indices and cross-sectional data on
209 participating sites and 96 nonparticipating sites.

Refer to Section 2 for adetailed summary of participant and nonparticipant analysis
samples.

7.B  Database Management

1. Theevaluation of the Nonresidential New Construction Program required several types of
data. The integrated database for the evaluation is comprised of five components: (1) on-site
survey datafor participating and nonparticipating sites, (2) DoEe-2 building simulations, (3)
hourly weather data by CEC weather zone, (4) daily weather data by SDG& E weather zone,
(5) consumption records, and (6) tel ephone survey data of participating and nonparticipating
builders and developers. Figure 7.1 illustrates the relationship among these data el ements.

2. The RER project team collected the on-site survey data, conducted the Dog-2 simulations, and
conducted the telephone survey of participating and nonparticipating builders and devel opers.
Hourly weather data by CEC weather zone and the daily weather data were provided by
SDG&E. Section 3 describes the collection of on-site data, weather data, billing dataand
decision-maker survey data. Section 4 describes the development of engineering estimates.

3. The program database consisted of 285 distinct sites. Of these, 253 sites were ultimately
subjected to the on-site survey. One of these sites was discarded from the analysis, leaving
252 participant sites to be covered by the engineering analysis. However, billing data
matching the surveyed sites were available for 204 of these sites, so only these sites were
covered by the realization rate analysis. The lack of appropriate billing data stemmed from
the fact that some sites were covered by meters also covering
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significantly more area (e.g., campus settings with large master meters). Decision-maker
surveys were completed for 209 of the participating sites, and were available for the net-to-
gross analysis. The nonparticipant frame for the on-site survey consisted of 527 sites for
which building permits had been issued in 1994 or 1995. Of these, 115 were duplicate sites
and 203 had not had new construction or major remodels or tenant improvements. This left
209 qualified sites. Of these, 51 refused to participate in the on-site survey. On-site surveys
were completed for the remaining 158 nonparticipant sites. All of these sites were covered by
the engineering analysis. Billing data matching the surveyed sites were available for 145 of
these nonparticipating sites. Again, the unavailability of billing data traced to master
metering. Decision-maker surveys were completed for 96 of the nonparticipant sites, thus
allowing these sites to be included in the net-to-gross analysis.

4. Specia emphasis was placed on the accurate identification of meters at the surveyed sites.
Reconciliation of site areas and metered areas took place at five points during the project.

m  First, accounts were aggregated to customer locations in the sample-design phase.

m  Second, surveyors verified the account matching during the on-site visit. Changesin
account numbers were recorded on the survey form.

m  Third, for the sites for which the surveyors had complete billing information, they
computed energy intensities while at the site. Intensitiesthat are out of the
“reasonable’ range were investigated with the customer contact. Potential problem
sites, or ones for which intensities could not be computed, were flagged for follow-up
by the RER analysis team.

m  Fourth, the billing information was reviewed by RER staff. Again, the intensities were
reviewed and problems were flagged for follow-up with the SDG& E Project Manager.

m  Finally, when the simulations were performed, the results were compared with the
billing data. If the simulation and billing data differed substantially, and there appeared
to be no problems with the survey data, these cases were reviewed further.

5. Not applicable.
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7.C  Sampling

1. A census of both participants and nonparticipants was attempted. Of the 285 distinct
participating sites, on-site surveys were completed for 253. The associated participant on-site
survey response rate was 91%. The nonparticipant frame contained 209 qualified sites, 158 of
which received on-site surveys. The nonparticipant on-site survey response was 76%.

2. Appendix A of the report contains a copy of the on-site survey instrument. Appendix B of the
report contains copies of the participant and nonparticipant decision-maker survey
instruments. Response rates for these surveys are presented above in item 1. Given the high
response rates, non-response bias was not considered a major problem.

3. Appendix C contains a sample inventory report for the on-site survey. Appendix D presents
frequencies for the decision-maker surveys. Appendix E provides a SitePro User Guide.
Appendix F provides alisting of the SitePro results. Appendix G presents descriptive
statistics for the variables used in the realization rate analysis. Appendix H presents
descriptive statistics for the variables used in the net-to-gross analysis. Additional descriptive
statistics for participants and nonparticipants are presented throughout the Report.

7.D Data Screening and Analysis

1. Inthisproject, we did not attempt to screen out outliers per se, but large residuals were
reviewed to identify data anomalies. In afew cases, consumption readings seemed to reflect
partial occupancy of the site; these reading were omitted from the realization rate analysis. No
observations were omitted from the efficiency (net-to-gross) analysis. There were no missing
datafrom the on-site survey or from the decision-maker survey. Missing billing data caused
some sitesto be | eft out of the realization rate analysis, as explained above under 7B.3.
Wesather adjustment variables were included in the realization rate model. Setting these
variables equal to 0 essentially weather-normalized the realization rates and the estimates of
realized savings.

2. Not applicable. The analyses of gross and net savings relied on differences across sites, rather
than changes in consumption.

3. See Section 7B.3.

4. Regression statistics for the realization rate analysis are presented in Table 5-1 and the results
of the estimated efficiency equations are presented in Tables 6-3 through 6-5.
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5. Redlization rate analysisis presented in Section 5, with the rationale for the model
specification detailed in Sections 5-2 and 5-3. The net-to-gross analysisis presented in
Section 6. Therationale for the efficiency model specificationsis presented in Section 6.4.
Note the following:

a. Therealization rate model contains engineering estimates devel oped at the individual
sitelevel. These estimates take into account the factors that affect end-use consumption
levels. The efficiency modelsinclude a variety of both site characteristics and decision-
making factors.

b. Therealization rate model includes engineering estimates that reflect changesin
consumption over time. In addition, it includes actual weather, which will also affect

usage.
c. Self-selection biasis addressed in the efficiency analysis. Two means of mitigating

self-selection are used: the double Train/Goldberg Mills Ratio approach and the
Hartman instrumental variables approach. See Section 6.4.

d. No important factors were knowingly omitted from the analysis.

e. Theefficiency models presented in Section 6 are designed to estimate the net impacts of
the program on efficiency levels.

6. Thisanaysisdid not address the issue of measurement error, except in the sense that the
realization rate analysis reconciled engineering estimates of usage to actual billed
consumption.

7. Autocorrelation, which isthe correlation of the error term over time for individual sites, was
found to be present in the realization rate analysis. This problem was mitigated with
generalized least squares, astandard remedy. All realization rate models presented in the
study correct for the presence of autocorrelation.

8. Heteroskedasticity was aso found to present in the realization rate analysis. The error
variance was found to be positively related to scale of the sites, as represented by square
footage. Generalized least squares was used to mitigate the problem.

9. Theissue of collinearity was addressed in this analysis through careful specification of
interaction terms and through omission of some variables found to be highly collinear with
others. Moreover, individual savings terms were aggregated with prior weightsin some
specificationsin order to mitigate collinearity across program variables
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10. Influential data points were identified by plotting regressors against residuals. No
observations were omitted from the realization rate analysis, except as indicated above under
7D.1. No observations were omitted from the efficiency analysis on the basis of outlier
analysis.

11. In the realization rate analysis, there were no missing data for regressors. For some sites,
however, billing data associated with the specific surveyed areawere unavailable. These
cases were assigned missing consumption readings. They were thus not used to estimate
realization rate model coefficients. Due to the lack of decision-maker survey information for
some sites, these sites were omitted from the efficiency (net-to-gross) analysis.

12. Standard errors on estimated parameters are presented in results tables. Table 5-1 presents the
t-statistics for each estimated parameter in the realization rate analysis. Confidence intervals
for gross savings were based on Version 1. The standard error for combined savings was
developed by combing the savings termsinto a single composite variable, then estimating its
overall standard error. Confidence intervalsfor net savings are based on the standard errors
presented in Tables 6-3 through 6-5. Insofar as net-to-gross ratios are estimated by end-use,
relative confidence intervals were constructed for three end-use groups and the weighted to
develop asingle relative confidence interval for whole building net savings.

7.E  Datalnterpretation And Application

1. Net Program impacts are calculated from the results of the realization rate analysis and the
net-to-gross analysis (Option A).

2. Sections 5 and 6 detail the rationale for the realization rate model and the net-to gross
analysis, respectively. More specifically, Section 5.2 summarizes the general rationale for the
realization rate model, and Section 4.3 discusses specific realization rate model used in this
study. Gross savings were defined as the estimated end-use realization rates times the
corresponding engineering estimate of savings. This calculation was done for surveyed
participants, then expanded to the total program on the basis of SDG& E’ s program estimates
of savings for surveyed and non-surveyed sites. Section 6.3 discusses the application of the
simple difference of differences approach to obtain end use estimates of net-to-gross ratios.
The overall net-to-gross ratio was defined as the ratio of weighted average net savingsto
weighted average gross savings for the participants covered by this analysis.






